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Safety

Meets the requirements of BS EN60950 (Safety Requirements of Information Technology Equipment).

Designed to be powered from an external power source which complies with the Low Voltage Directive (73/23/EEC).

Designed for indoor use in the temperature range 5° to 40°C, 20% to 80% RH (non-condensing).

WARNING: Do not wet the product when cleaning.
WARNING: This product contains a lithium battery. Do not recharge, open, heat or dispose of in fire. Dispose of according to local regulations.

WARNING: It is important to allow enough ventilation in any surrounding enclosure so that the operating temperature range is not exceeded. Any enclosure should incorporate a fan to assist in thermal dissipation.

WARNING
The use of Hard Disk Cartridges other than those supplied by Brigade Electronics will invalidate the warranty of the X200 recorder, and will constitute a breach of the X200 operating software copyright.

The purchase of USB Kit T503/505-USB includes the necessary licence for use of PCLink Suite software on one PC, including free of charge updates.  Brigade Electronics does not authorise the unlicensed usage of PCLink Suite software.
Environmental

Temperature

The X200 may be operated in ambient temperatures from 5°C to 40°C.  This specification applies in still air, with the X200 mounted horizontally and ambient temperature measured 15cms above the centre of X200.

If the X200 is to be mounted in an enclosure is important that the internal temperature inside the enclosure does not exceed the specification above and any new enclosure design should be tested.  A simple but effective test is to place a thermocouple inside the enclosure and one outside and measure the operating temperature difference.  This difference must be deducted from the X200 40°C maximum.

Example

Temperature outside enclosure

25°C

Temperature inside enclosure

35°C
Difference



10°C

Maximum inside enclosure

40°C
(X200 max)

Maximum outside enclosure

30°C
(40°C-10°C)

In the above example the 40°C max spec has been de-rated to 30°C due to the effect of the enclosure.

Forced Ventilation Within Enclosures

It is advisable to include a fan integral to any enclosure design.  The goal of the fan is to remove air heated by the X200 and replace it by air at the outside temperature.  The temperature difference shown in the above example of 10°C can be reduced to a few degrees using a small fan.  Two small fans are typically better than one due to failsafe.  Fans do need checking periodically and can draw in large amounts of dirt and dust, this should be removed periodically.  To reduce dirt ingress a fan may typically be run slower than rated by reducing the voltage from that specified.  This can typically be done with a single resistor in series with the fan.  Alternatively air filters may be used but these impede airflow and require careful system design. The X200 does not incorporate a fan but instead uses an internal switch-mode power supply to reduce power consumption (and therefore heat).

Fans offer two immediate benefits:

1
Changing the air inside the case makes the air temperature inside the case within a few degrees to that outside.

2
If the airflow is channelled around the top surface of the X200 so that air is drawn particularly over the two sides and the top, further thermal improvement is gained and an X200 specification of 5°C to 45°C may be used.  (The difference between the surface X200 case temperature and ambient temperature is typically 5°C and this is the extra maximum benefit).

Low Temperatures

Insulating the X200 (e.g. inside an enclosure) and leaving it powered up (but not necessarily recording) will allow it to be used at sub zero temperatures.  To offer the best performance in low and high temperature environmental conditions, an insulated case can be used with a fan, which is thermostatically controlled to switch on when the temperature rises above 10°C.  The fan speed can be increased or decreased based on a thermal feedback circuit (analogue thermostat).

Shock and Vibration
Due to the nature of hard disk drives it is essential that the X200 is isolated from vibration and shock as much as possible.

Consideration should be paid to the mounting position so that the levels of shock and vibration that may be encountered are minimized.

In situations where some exposure to shock and vibration are unavoidable it is strongly advised that the T406 Anti-Vibration System is used.  This system is specifically designed to isolate the X200 from structure borne shock and vibration.  Further details and fitting instructions can be found in the Anti-Vibration Kit section of this manual.

EMC

The X200 complies with the relevant EEC, Automotive ‘E’ Mark and Specification 5 (Emergency Vehicles) EMC standards for this type of product.

Conformity

X200 EMC Conformity (CE Mark)

Meets the European Council Directive 89/336/EEC (EMC Directive) relating to EMC Emissions - EN61000-6-3(2001) and EMC Immunity – EN61000-6-1(2001).

X200 EMC Conformity (E Mark)

Meets the Type Approval requirements of European Commission Directive 95/54/EC.
X200 PITO Specification 5

Has met the requirements of automotive conformance regarding use in Emergency Vehicles.

Recycling

When the product has reached its end of life and requires disposal, recycling instructions are available upon request.
EC Declaration of Conformity   (CE)
We
Timespace Technology Ltd.


Blackstone Rd

Huntingdon

PE29 6TT


United Kingdom

declare that the
X200 Digital Video Recorder
Meets the intent of the European Council Directive 89/336/EEC referred to as the Electromagnetic Compatibility (EMC) Directive.  The product conforms to the following standards which have been listed in the Official Journal of the European Union.
EMC

Emissions: EN61000-6-3(2001) EMC Generic Emission Standard for residential, commercial and light industrial.  Referring to:

a) EN55022(1998) Conducted, Class B

b) EN55022(1998) Radiated, Class A

Immunity: EN61000-6-1(2001) EMC Generic Immunity Standard for residential, commercial and light industrial.  Referring to:


a) EN55024(1998) Information Technology Equipment – Immunity Characteristics


b) IEC 61000-4-6(2003) RF Field


c) EN60801-2(1993) Electrostatic Discharge

d) IEC 61000-4-4 (2004) Fast Transient
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...............................................................................

Dr ROBERT HEYLEN

TECHNICAL  DIRECTOR

27th July 2004
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VCA Headquarters 
1 The Eastgate Office Centre Eastgate Road Bristol, BS5 6XX United Kingdom 

Switchboard:  +44 (0) 117 951 5151 Main Fax:  +44 (0) 117 952 4103 Email: enquiries@vca.gov.uk       Web:          www.vca.gov.uk 

THE UNITED KINGDOM VEHICLE APPROVAL AUTHORITY 

COMMUNICATION CONCERNING THE TYPE APPROVAL OF THE COUNCIL DIRECTIVE OF 20 JUNE 1972 ON THE APPROXIMATION OF THE LAWS OF THE MEMBER STATES RELATING TO A TYPE OF COMPONENT WITH REGARD TO RADIO INTERFERENCE SUPPRESSION (72/245/EEC) AS LAST AMENDED BY 2006/28/EC. 

Type Approval No: e11*72/245*2006/28*2888*01 

EC type-approval mark to be affixed on ESA: 032888 

Reason for Extension: To cover: Upgrade directive to 2006/28/EC 

 SECTION I 
0.1 
Make (trade name of manufacturer): Timespace Technology 

0.2 
Type: X200 Digital Video Recorder Family has two versions: X200-16 16 camera version and X200-04 4 camera version:  

0.3 
Means of identification of type, if marked on the component:: Self-adhesive label 

0.3.1 
Location of that marking: On centre of underside of product 

0.5 
Name and address of manufacturer: 

Timespace Technology Ltd Blackstone Road Huntingdon Cambridgeshire PE29 6TT United Kingdom 

Name and address of authorised representative, if any: Not applicable 

0.7 
In the case of components and separate technical units, location and method of affixing of the EC type-approval mark: Self-adhesive label on centre of underside of product 

EAJ196520 

An executive agency of the Department for Transport June 2008 Issue 1 
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72/245/EEC as last amended 

Address(es) of assembly plant(s): 
As 0.5 above 

SECTION II 
1. 
Additional information (where applicable): Not applicable 

2. 
Technical service responsible for carrying out the tests: MIRA 

3. Date of test report: 
} As before (4 July 2004) and 10 February 2009 

} } 

4. 
Number of test report: } As before (1006329) and Technical Report Letter dated 10 February 2009 

5. 
Remarks (if any): See appendix 

6. 
Place: BRISTOL 

7. 
Date: 16 March 2009 

8. 
Signature: 
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A. W. STENNING Head of Technical and Quality Group 

9. 
The index to the information package lodged with the approval authority, which may be obtained on request, is attached. 
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EAJ196520 An executive agency of the Department for Transport June 2008 Issue 1 

72/245/EEC as last amended 

APPENDIX 
to EC Type Approval Certificate No: e11*72/245*2006/28*2888*01 

concerning the type approval of an electric/electronic sub-assembly with regard to Directive 72/245/EEC as last amended 

1. 
Additional information 

1.1 
Electrical system rated voltage: 12V negative ground 

1.2 
This ESA can be used on any vehicle type with the following restrictions: 12V negative ground 

1.2.1 
Installation conditions, if any: As per manufacturer’s instruction 

1.3 
This ESA can only be used on the following vehicle types: Not applicable 

1.3.1 
Installation conditions, if any: Not applicable 

1.4 
The specific test method(s) used and the frequency ranges covered to determine immunity were (please specify precise method used from Annex 1X):  Not applicable 

1.5 
Laboratory accredited to ISO 17025 and recognised by the Approval Authority (for the purpose of this Directive) responsible for carrying out the test: MIRA Nuneaton 

5. 
Remarks: None 

(1) 
Delete as applicable 
(2) 
If the means of identification of type contains characters not relevant to describe the vehicle, component or separate technical unit types covered by this information document/type​approval certificate, such characters shall be represented in the documentation by the symbol `?' (e.g. ABC??123??). 
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EAJ196520 An executive agency of the Department for Transport June 2008 Issue 1 
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ATOMOTIVE AND EGUSWENT SECTION il

CERTIFICATE OF CONFORMANCE

CetificateNo. - 4275E Date 16 Apr 2010

Submittedby Manufactured by
Timespace Technology Ltd Timespace Technology Ltd
Blackstone Road Blackstone Road
Huntingdon Huntingdon
PE29 6TT PE29 6TT

This is to certify, that a representative example of

Make - Timespace Technology Ltd
Model- Digital Video Recorder X200
veur- 2010

Identfcation N (V.LN./Serial) Nurber

fias met the requirements of ‘Automotive Conformance

Specfication ........... Issue . A0EDCLass o FULL..... pass®
L TETRA band passed witin spprorite fea anges
in respect of Electromagnetic comparifiliy performance.
(¥sce reverse of certificate for won-conformance)
v e e o
This certificate does not indicate compliance with the Automotive
EMC Directive or its amendments
Issued by Barend Strydom

Automothe and Equipment Section
NFIA

gf 16 Apr 2010
Signed
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Certificate of Registration
This is to certify that

Timespace Technology Ltd
Company Registration No — 03340958

IS a registered member of the

Transform WEEE Compliance Scheme

under the
Waste Electrical and Electronic Equipment Regulations 2006

from 1 January 2010 to 31 December 2010

Producer Registration Number: WEE/CA0066TW

Signed on behalf of Transform:
Sandeep Attwal, Head of Compliance

Transform is approved as a Producer Compliance Scheme by the Environment Agency
PCS Registration Number: WEE/MP3238PG/SCH

Transform, Biffa Waste Serviceé Limited, Coronation Road, High Wycombe, Bucks HP12 3TZ
Telephone: 01494-556565
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System Overview
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The X200 is a digital video/audio surveillance recorder for use in covert, portable and mobile applications. 

Recordings are made on a removable Hard Disk Cartridge inserted in the X200. After the Hard Disk Cartridge has been removed, the recordings can be accessed by connecting the cartridge to a PC, using the USB Interface Kit, (which includes PCLink200, a proprietary reading and archiving software package).

The use of Hard Disk Cartridges other than those supplied by Brigade Electronics will invalidate the warranty of the X200 recorder, and will constitute a breach of the X200 operating software copyright.
The X201 Reviewer is used to program the menu settings on X200, to check camera views and to review recordings on the installed X200 Hard Disk Cartridge.  Recording will continue during this reviewing process.

The 24-hour clock is used for all times and settings.

WARNING: The X200 Recorder must always be mounted so that there is a free flow of air around it. If it is mounted in an enclosure, it is essential that adequate ventilation is provided, and it is recommended that a fan is incorporated in the enclosure design.

WARNING: If the X200 Recorder is mounted in a vehicle, or otherwise subject to vibration, suitable damping must be built into the mounting.

WARNING: Hard Disk Cartridges are sensitive to shock, vibration and humidity and must be used within operating temperature range as detailed in the X200 specification. 
WARNING: It is highly recommended that recording is stopped before power is removed from the X200 to avoid loss of data. It is also recommended to stop recording before the cartridge is removed.
WARNING: Cartridges should be safely removed from Windows operating system environment prior to removing power/usb cable. Data loss or corruption may occur if this is not followed.

Diagrammatic Explanation of Use
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X200 Recording Time Calculation

The following table allows the calculation of recording time in hours and other parameters.  Fill out 5 of the 6 entries A to F to calculate the missing entry. 

Number of cameras




A_______________
Number of images/sec for each camera


B_______________
Amount of motion (%)


Enter 100
Full Update Recording



Enter 80
High Motion Cond. Refresh


Enter 60
Bus Market Cond. Refresh


Enter 40
Med Motion Cond. Refresh


Enter 20
Low Motion Cond. Refresh
C_______________
Disk size in GBytes




D_______________
Amount of time in Hours




E_______________
Resolution (kBytes)


Enter 30
VV. High


Enter 25
V. High


Enter 20
High


Enter 15
Medium


Enter 10
Low



F_______________
Calculations without audio recording
Amount of time in hours



E = (27777 x D) / (A x B x C x F)

Disk size if you know the time 


D = A x B x C x E x F / 27777
How much % motion



C = (27777 x D) / (A x B x E xF)

Number of images on disk


(100,000,000 x D) / (C x F)

___________________________________________________________________-

Audio Sampling Rate


Enter 8000        8 kHz


Enter 16000      16 kHz



G_______________
Audio Channels

Enter 1

Mono


Enter 2 

Stereo 



H_______________
Audio Sampling Rate


Enter 1

8 bits

Enter 2

16 bits



 I_______________
Calculations with audio recording
First calculate bytes per second

M = (A x B x C x F x 10) + (G x H x I)

Amount of time in hours


E = 277,777 x D / M
Disk size if you know the time 

D = E x M / 277,777
A Brigade Footage Calculation tool can be provided upon request by email support@tspace.co.uk
Recommended settings for ‘Audio Only’ recording are;

· Using the reviewer, navigate and change the following items;

· Normal Recording

· Camera 1 ( 0.1 ips

· Camera 2-4 ( No Recording

· Audio ON

· Audio Recording

· Channels ( Stereo

· Check the Input Range is ok for your specific application

· Other, File System

· File Length ( 1 Hour

· Advanced

· Record Settings

· Norm / Timer ( Full Update

Compatibility With X100 Hard Disk Cartridges

The use of Hard Disk Cartridges other than those supplied by Brigade Electronics will invalidate the warranty of the X200 recorder, and will constitute a breach of the X200 operating software copyright.
1)
All Cartridges from an X100 can be used in an X200, as long as X100 Operating 
Software V1.5.0 or later is installed.

2)
All Cartridges from an X200 can be used in an X100.

The X200 stores its operating system and menu settings internally in non-volatile flash memory whilst the X100 stores its operating system and menu settings on the Hard Disk Cartridge.  Therefore all new Hard Disk Cartridges are supplied with the latest version of the X100 operating software already installed so that the cartridges can be used in both the X200 and X100 without modification.  

Please note that as the X100 stores its menu settings on the cartridge as well as the operating software, using a new cartridge in the X100 will mean that all menu settings will revert to the factory default settings.

Older cartridges which have only previously been used with the X100 can be used with the X200 without modification as long as the X100 operating system stored on the cartridge is version 1.5 or later.  The menu settings on the X200 will not be affected by using the cartridge.

If the X100 operating system stored on the Cartridge is previous to version 1.5 then version 1.5 or later will need to be loaded onto the Cartridge before it can be used with the X200.

It is possible to record both .oba* (X100 file) and .xba (X200 file) on the same cartridge without any compatibility problems.  Please note however that the X100 will only list and play back .oba files and the X200 will only list and play back .xba files.

Where loop recording is selected, the X200 records over oldest files first, whether they are .oba or .xba files.  The X100 on the other hand will overwrite files in an indeterminate manner (based on their physical location on disk).  Consequently if disks are to be moved from an X200 system into an X100 system please ensure that all critical files have been archived onto a PC or write protected on disk.

Resetting the cartridge on the X200 and thus deleting all of the recording files on the disk (all .oba and .xba files will be deleted) will not affect the X100 operating software.

Cartridge Compatibility and Labeling

X100 recorders with V1.60 System Software are compatible with cartridges up to and including 160Gb. 

To distinguish new 160Gb cartridges from existing cartridges, new T401-160 cartridges will be labeled ‘T401-160X’ or ‘T401-160S’. Existing 160Gb cartridges, labeled ‘T401-160’ are not compatible with X100 recorders, unless V1.60 System Software is loaded.

Compatibility

	Part Number


	Cartridge Label


	X100 Compatible V1.60


	X200 Compatible V1.8.3 or later


	Hard Disc Type

	T401-120
	T401-120

T401-120S 
	OK

OK
	OK

OK
	PATA

SATA

	T401-160
	T401-160

T401-160S

T401-160X 
	X

OK

OK
	OK

OK

OK
	PATA

SATA

PATA

	T401-250
	T401-250

T401-250S 
	X

X
	OK

OK
	PATA

SATA

	T401-320
	T401-320

T401-320S 
	X

X
	OK

OK
	PATA

SATA

	Part Number


	Cartridge Label


	X100 Compatible V1.60


	X200 Compatible V1.8.3 or later


	Hard Disc Type

	T401-500
	T401-500S
	X
	OK
	SATA

	T402-80
	T402-80

T402-80S
	OK

OK
	OK

OK
	PATA

SATA

	T403-64
	T402-64

T402-64S
	X

X
	OK

OK
	PATA

SATA


X200 Digital Recorder

Installation

The X200 can be used free-standing or it can be mounted on a wall or bulkhead. 

Power can be applied to X200 either via 12V DC jack socket or 12V screw terminals. NB: Do not use both power inputs simultaneously.

The Hard Disk Cartridge (supplied separately) with lock on the front in "Off" position should be inserted into receptacle in front panel of X200 and gently but firmly pushed into place, then lock switched to "On" position.

Mechanical Data

4 x threaded holes are available in the back panel of the X200 for mounting:


Vehicle installation

Regulated 12V power supply
Feed this 12V power supply to X200 unit and a the cameras.  Connect video output from cameras to X200 using coax cable. It is important to provide a low resistance ground path when powering the cameras to avoid video noise. 

Wiring
Run a ground and power cable pair from the X200 to each of the cameras and create a star ground point where all the ground cables meet somewhere very close to the ground of the X200.  Use the green power block or the 2.1mm DC jack(pin) socket to feed power into the X200.
T408 Vehicle Kit
For use in mobile installations subject to shock and vibration.  Please adhere to the following instructions for the installation of the Vehicle Kit.  Failure to do so may result in the Mounting System not working correctly.
Inventory of Parts
The Vehicle Kit consists of the following parts -

QTY

Description

4

Wire Rope Mounts

1

Stabiliser Coupling

8

M4 x 12mm Counter-Sunk Hex-Head Screws
In addition you will require a standard ‘L’ shaped hex key.  This is essential, as when all of the other screws have been tightened, there is no room for any other tool to tighten the front lower pair of screws.  
Mounting Hole Preparation 
Drill four mounting holes to attach the Wire Rope Mounts.  If you intend to use the M4 x 12mm screws into blind holes, then the holes will have to be drilled and tapped to accept an M4 screw, with a thread depth of no less than 8mm.

If mounting the Wire Rope Mounts through a metal plate, then longer screws may have to be used in order to allow a washer and nut to be attached on the other side of the plate.  The length of these screws will have to be chosen depending on the thickness of the plate and the height of the washer and nut.

Please note that any screw used for mounting the wire rope mounts to an enclosure surface must have an M4 thread and have a counter-sunk hex-head.

Mounting Hole Location
The mounting holes must be drilled on 126mm and 88mm centres.


Total Mounting Volume Required 

It is necessary to allow a minimum clearance of at least 15mm around the body of the X200 when mounted on the T408 Vehicle Kit.  This is to allow free movement of the X200 on the anti vibration mounts and to prevent collision with either the enclosure or peripheral systems due to vertical and lateral movement under extreme shock and vibration conditions.



Cable Installation

Please note that when installing cables to the rear of the X200 it is important not to arrange or clamp them in such a way as to impede the free movement of the rear anti-vibration mounts.  


Installation Procedure
It is advised that some form of thread-lock compound should be used on the screws securing the wire rope mounts to both the X200 and mounting surface.  This is in order to prevent loosening due to vibration. WARNING - Ensure only a small amount of adhesive is added to the screw points. Excessive amounts will leak onto the circuit board and damage components.
1) Attach the Wire Rope Mounts to the X200 with four of the countersunk M4 hex-head screws provided and L-shaped hex key.  When attaching the rear pair of mounts please ensure that the stabilizer is ‘sandwiched’ between the mounts and the X200 by aligning the stabilizer holes with the mounting holes in the X200.

Please note that the ‘open’ end of the C-shaped plastic stabiliser should be attached to the rear wire rope mounts and face backward.
2) Once all of the Wire Rope Mounts have been securely attached to the X200, use a pair of countersunk M4 hex-head screws to attach the bottom ‘feet’ of the front Wire Rope Mounts to the mounting surface/enclosure.

3) Secure the lower ‘feet’ of the rear Wire Rope Mounts to the mounting surface/enclosure using the remaining pair of countersunk M4 hex-head screws and a standard L-shaped hex key.  Ensure that the stabilizer is ‘sandwiched’ between the lower feet and the mounting surface/enclosure by screwing through the Wire Rope Mount feet, then the stabilizer and into the mounting surface/enclosure.

Orientation of Unit
The X200 should be mounted in the following horizontal orientation.  This is strongly advised for maximum vibration and shock isolation.


If it is not possible to mount the X200 in the horizontal orientation then the following vertical orientation may be used.  
It must be noted however that this vertical orientation is not as effective at isolating the X200 from vibration and shock as the horizontal orientation.
The position of the plastic stabiliser, screw types and assembly order remain the same for this mounting orientation.

The X200 must never be mounted by hanging it upside down from a horizontal surface when using this mounting system.
Connector Specifications and Diagrams

X200-16 Rear Panel
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Pin numbering of both 25 Way Male D type connectors on X200 (looking at rear panel).

Video 5 - 16 Connector 

Pin





Pin

1
Video GND In 5



14
Video In 5


2
Video GND In 6



15
Video In 6

3
Video GND In 7



16
Video In 7

4
Video GND In 8



17
Video In 8

5
Video GND In 9



18
Video In 9

6
Video GND In 10


19
Video In 10

7
Video GND In 11


20
Video In 11

8
Video GND In 12


21
Video In 12

9
Video GND In 13


22
Video In 13

10
Video GND In 14


23
Video In 14

11
Video GND In 15


24
Video In 15

12
Video GND In 16


25
Video In 16

13
Not Connected

Video 1 - 4, Out, Switcher, Audio Connector 

Pin





Pin

1
Video GND In 1



14
Video In 1


2
Video GND In 2



15
Video In 2

3
Video GND In 3



16
Video In 3

4
Video GND In 4



17
Video In 4

5
Video GND Main Out


18
Video Main Out

6
Video GND Switcher Out

19
Video Switcher Out

7
Audio GND Out 2 (right)


20
Audio Out 2 (right)

8
Audio GND Out 1 (left)


21
Audio Out 1 (left)

9
Audio GND In 1
(left)


22
Audio In 1 (left)

10
Audio GND In 2
(right)


23
Audio In 2 (right)

11
Video GND Main Out S-Video Y

24
Video Main Out S-Video Y

12
Video GND Main Out S-Video C

25
Video Main Out S-Video C

13
Not Connected

X200-16 Cable Harness Recommended Specification

A common cable harness can be used for both 25 Way D type connections on the X200-16

Connector
25 Way Female D type

Shell
Recommended max overall width 56mm (the two 25 way connectors are 57mm apart)

Cables

12 individual RG179 cables of suitable length.

Connections


Shield pin
Core Pin

Cable 1

1

14

Cable 2

2

15

Cable 3

3

16

……………..

Cable 12
12

25

Pin 13 not connected.

In order to meet the EMC standards with which the X200 is compliant it is important that shielded cables are exclusively used.  All of the signal grounds should be commoned inside the D-Type connector and connected to a metal back-shell in order that the cable run and D-Type connector are shielded.

X200-04 and X200-16 Input/Output Connector
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Connect power input to either + - terminals or to 2.1mm jack socket (requires 2.5 x 5.5 x 9.5mm DC example – www.uk.farnell.com part no. 224923)
Connect alarm inputs 1, 2, 3 and 4 to - terminal if closed, leave open circuit if open

Connect alarm output to Out terminal pair

Connect LED 1 between + and terminal LED 1, including a series resistor to limit current.

Connect LED 2 between + and terminal LED 2, including a series resistor to limit current.

Terminals LED 1 and LED 2 are high impedance (LAMP/LED off) or 0V (LAMP/LED on)

Input/Output connector – www.uk.farnell.com part no. 9632794.
LED outputs 1 and 2 can be menu assigned to duplicate any of the 4 front panel LEDs (power, record, service and fail).  

X200-04 and X200-16 Ethernet Connector
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Connect via a normal Ethernet cable (straight i.e. pins 1-1, 2-2, 3-3 etc.) to Ethernet hub, switch, router or wireless LAN adaptor.

Internal Connections:
1 Tx+, 2Tx-, 3 Rx+, 4 NC, 5 NC, 6 Rx-, 7 NC, 8 NC

X200-04 and X200-16 RS232 Connector
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The X200 has a 9 way male D-type connector (DB9) which can be used to support 1 or 2 RS232 peripherals.

Conventional Cable

Using a conventional cable (DB9 male to DB9 female straight through (1-1, 2-2, 3-3 etc.)) the X200 can be connected to a modem:

Pins on the X200






( X200 output

Pin




( X200 input


3
TD
Transmit Data

(
Serial Data (0 = 10V, 1 = -10V)

2
RD
Receive Data

(
Serial Data (0 = 10V, 1 = -10V)

7
RTS
Request to send
(
Handshaking (please send signal = 10V)

8
CTS
Clear to send

(
Handshaking (please send signal = 10V )

4
DTR
Data terminal ready
(
X200 outputs 5V (data terminal is ready)

6
DSR
Data set ready

(
Ignored by X200

1
DCD
Data carrier detect
(
Used to detect that modem is on air (=10V)

9
RI
Ring Indicator

(
Ignored by X200

5
GND
Ground

Proprietary Dual RS232 Connection

This supports the connection of two RS232 peripherals such as GSM modem and GPS (Global Positioning System).

RS232 port 1 (Modem)






( X200 output

Pin




( X200 input


3
TD
Transmit Data

(
Serial Data

2
RD
Receive Data

(
Serial Data

7
RTS
Request to send
(
Handshaking

8
CTS
Clear to send

(
Handshaking

1
DCD
Data carrier detect
(
Used to detect that modem is on air (10V)

5
GND
Ground

RS232 port 2 (other device)

4
5V
Power supply for GPS unit (500mA max)

6
Ignored
by X200

(


9
RD
Receive Data

(
Serial Data

5
GND
Ground

X200-04 Rear Panel
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1 BNC video output

4 BNC video inputs

Audio Connector

5 pin 180° female DIN connector (DIN 41524)
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Pin 

1
Audio input 1 (left)

4
Audio input 2 (right)

2
Audio GND

5
Audio output 2 (right)

3
Audio output 1 (left)

The audio signals are at line level

A 5 pin DIN to 4 way RCA phono harness can be readily purchased from a number of suppliers.  Suggested search via www.google.com for “5 pin din to rca phono audio”.

A locking connector could be used to secure the DIN in place. Recommend parts are;

Locking Nickel plated finish, Deltron part number 590-0500, Farnell part number 119-3833    

Locking Black finish, Deltron part number 591-0500, Farnell part number 119-3828
2.1mm jack socket (requires 2.5 x 5.5 x 9.5mm DC example – www.uk.farnell.com part no. 224923)
X200 Front Panel
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Record Button 
Turns Normal recording on and off.  Can be menu disabled.

LED Indicators

Record LED

Illuminated when the X200 unit is recording.
Service LED 

Illuminated when any of the service conditions are met.  Please refer to the Service and Fail LED section of this manual for further details.
Fail LED

Illuminated when any of the fail conditions are met.  Please refer to the Service and Fail LED section of this manual for further details.
Power LED

Illuminated constantly while power is supplied to the X200.
At Power On

All four LED’s will illuminate whilst the X200 initialises and will remain lit during system check (menu disabled) until the unit is operational.  Once operational only the Power LED will remain illuminated unless recording is taking place.

At System Reboot

If the Hard Disk Cartridge is switched off and then on (or replaced) or the Load System Upgrade has been performed the X200 will reboot.  In this case as per at power on all four LED’s will illuminate whilst the X200 initialises and will remain lit during system check (menu disabled) until the unit is operational.  Once operational only the Power LED will remain illuminated unless recording is taking place.

Reviewer Connector
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Connect X101 or X201 reviewer to X200 using this socket.  Signals for this connector are as follows:

1 
Video out

2
Video ground

3
Audio ground

4
RS232 Rx

5
RS232 Tx

6
Audio out (line level)

7
Power ground

8
12V

Service and Fail LED

The Service and Fail LED’s on the X200 front panel give a positive indication in certain circumstances where a system fault may have occurred.

If the Service LED is lit then the system will most likely be functional but may not be performing as intended.  The system should be checked and any remedial action taken as soon as possible.

If the Fail LED is lit then the system will not be functioning.  The Fail LED only lights when the X200 is unable to read or write to the installed Hard Disk Cartridge. If the Fail LED is illuminated then the Hard Disk Cartridge should be replaced immediately and the X200 system checked for any possible causes of the disk failure.

These conditions are listed in the service log which can be viewed in the statistics menu by selecting ‘View Service Log’.  The Service LED will remain lit and the problem which caused the Service LED to light will be listed in the log until the log is reset by selecting ‘Reset Service Log’.

SERV:11:CAM:DISCONNECTED CAMERA dd

· dd indicates the camera which is disconnected.

· This message indicates that the unit has failed to record 1000 consecutive images for the specified camera.

· The Service LED is illuminated when this event occurs.

· Suggested Remedy: 
Check and reconnect/replace the disconnected camera.
SERV:13:SYS:FPS WHEN RECORDING < ddd

· ddd indicates the requested frame rate.

· Whenever a recording file of greater than 60 seconds duration is closed the system checks the number of video frames it contains.  If it is less than half that specified in the recording parameters then this service condition is raised.

· The Service LED is illuminated when this event occurs.

· Suggested Remedy:


· Check for decoder failure messages at start up

· Ensure that Ethernet transfers are not taking place while recording.

· The disk may be responding slowly – try another disk

· For installations with only a few cameras this could be caused by a disconnected camera.
SERV:15:SYS:TIME ERROR ddd

· ddd indicates the time error in seconds.
· When the unit’s time is set via the network it is checked against the system’s current time.  If the error is greater than 10 seconds then this service condition is raised.

· The Service LED is illuminated when this event occurs.

· Suggested Remedy:
Before synchronising the system time check that it is set accurately to within 10 seconds.
SERV:17:SMS:MODEM SEND ERROR

· If a connected GSM modem fails to send a SMS (short message service) message then this service condition is raised.

· The Service LED is illuminated when this event occurs.

· Suggested Remedy:
Check the connected modem is working correctly.
SERV:35:EXT: xxxxxxxx

· xxxxxxxx  is the message received over the serial port.

· One of the remote commands accepted over the serial port is #LOG.  This allows users to insert their own messages in the service log.

· The Service LED is not illuminated for external service log entries.
FAIL:96:HDD:READ FAILURE ddddd

· If the unit attempts to read from the hard drive and is unable to do so then this fail condition is raised.
· The Fail LED is illuminated when this event occurs.

· Suggested Remedy:
The advanced menu page allows the user to specify a daily quota of disk errors.  Either increase the allowed failures or replace the disk.
FAIL:97:HDD:WRITE FAILURE ddddd

· If the unit attempts to write to the hard drive and is unable to do so then this fail condition is raised.

· The Fail LED is illuminated when this event occurs.

· Suggested Remedy:
The advanced menu page allows the user to specify a daily quota of disk errors.  Either increase the allowed failures or replace the disk. This error may also occur if a cartridge is removed whilst the X200 is recording. Ensure recording is stopped before removing the cartridge or power. 
SERV:63:USR:LOG RESET

· This is the only service message entry in the service log after a user reset has been performed.

· No LEDs are illuminated as a result of this service log entry.

The service log should only be reset once the cause of the problem has been verified and rectified.

Note – Fail 96 and 97 may appear as 32 and 33 in older X200 software.
Programming

The configuration of the X200 is by the menu system, this is accessed using the X201 Reviewer.  Please refer to the section on the X201 Reviewer for details of its use.

Connect Data Link Cable (supplied with X201 Reviewer) from socket marked "Reviewer" on X200 to socket marked “Recorder” on X201. This connection will provide power and video to X201 from X200.
To enter Menu System press any of the four MENU arrow buttons.  To exit the Menu System or to move back up a level press the MENU EXIT button.
The menu system can also be configured via RemoteLink PC software connected to the X200 via a GSM or serial interface.
Help Screens

Throughout the menu system, every item that the cursor points to has a Help screen. Place the cursor on the line requiring explanation and press the HELP key on the X201 front panel. Use any key to cycle through the screens for that line. 

Help screens are available for each menu heading and for all items contained within the menu.

The help system is very comprehensive and it is strongly recommended as a reference to both new and experienced users.

Software Updates

Occasionally software improvements are made to X200 and a new version of software is made available.  The software takes the form of a .xos file.  Follow these steps to install new software: 

1. Delete all recordings on the Hard Disk Cartridge using the reset menu.

2. Using the USB interface kit copy the new .xos file from the PC to the Hard Disk Cartridge. (example file name – X200.V1.8.4.xos)

3. Right click the .xos file on the Hard Disk Cartridge and select properties.

4. Left click to tick the ‘Read-only’ box at the bottom of the properties window and click OK.

5. Insert the Hard Disk Cartridge into the X200 and stop it recording if it is currently doing so.

6. Go to OTHER MENU > ADVANCED MENU in the X200 menu system.

7. LOAD SYSTEM UPGRADE – This loads a new version of the X200 operating system from the Hard Disk Cartridge.  

8. Check the software version in the statistics menu to verify the new version has been loaded.

Note - all settings on the X200 will be reset to defaults when a software update is performed. 

WARNING – X200 may become unusable if power to the unit is lost during a software upgrade.
· SAVE SYSTEM UPGRADE – This saves the X200 operating system and current menu settings to the Hard Disk Cartridge as a .xos file.

The Cartridge can then be used as a master to set up another X200 with the same software 

version and menu settings.  Use LOAD SYSTEM UPGRADE on the other X200 with the 

master Cartridge inserted.

Save User Settings

The X200 has a function to allow user defined settings to be default, even if the X200 is reset. 

Type 108723 using the numbers on the reviewer. A hidden menu will appear with 2 options;

1. Save to User Defaults - This will save any settings changed as default for that unit. If the Restore defaults option is used in the Advanced menu, all settings will go back to this and not the factory defaults.

2. Restore Factory Defaults – Restores factory defaults. Any user settings will be lost.

Language Selection

By default the X200 menu system is displayed in the English language.

If the user requires that the menu system is to be displayed in a language other than English, Brigade Electronics can provide a language template file which the user can translate and return to Brigade Electronics for incorporation into the X200 software.  This will allow all text displayed on the X201 Reviewer to be in the users preferred language. 

Any incorporated languages are selected in the Reset System Menu with the X200 having to be power cycled before the new language settings will take effect.
PAL/NTSC Switching

Introduction

From software version 1.2.0, the X200 offers the ability to switch between the different video standards; PAL and NTSC.

· PAL (Phase Alternating Line) is the standard used in most European countries with the exception of France.  The X200, when configured to use PAL, offers a maximum capture rate of 25 fields per second.

· NTSC (National Television Standards Committee) is the standard used in the United States of America. The X200, when configured to use NTSC, offers a maximum capture rate of 30 fields per second.

When configured to use one of these standards, the X200 must use it exclusively.  This means that cameras of different types cannot be mixed on the device’s inputs.  

Note that if the unit is configured for PAL and an attempt is made to play back NTSC recordings, the image will appear vertically ‘squashed’.  Similarly, if the unit is configured for NTSC and an attempt is made to playback PAL recordings, the image will be clipped.

Switching Video Standards

To switch between the required video standard, the user must configure the unit using the RECORDING SETTINGS menu.  This is shown below:

|   RECORDING SETTINGS   |
>OPTIMISE FOR CAMERAS:
MULTIPLE

 RECORDING MODE FOR:

   NORM / TIMER:  COND. REFRESH

   ALARM / SHOT:  FULL UPDATE

 VIDEO STANDARD:  
PAL

 COLOUR DISCRIMINATION:
AUTO

After moving the cursor down the Video Standard line, the left and right menu keys can be used to select between PAL and NTSC.  Once the appropriate selection has been made the unit must be power-cycled before it comes into effect.  During the power up sequence, the X200 will briefly display the software version installed along with the configured video standard.

File System

The X200 uses a proprietary file type with the file extension .xba

Images from multiple cameras along with audio, GPS and other data are stored in these files.  The images are compressed using MPEG2 data compression in either non-predictive (full update) mode or predictive (conditional refresh) mode.  For security and optimisation reasons .xba files can only be viewed on a PC using the proprietary PCLink200 software.

For most applications there are two types of normal recording available, loop and single pass.

Loop Recording

By selecting LOOP RECORD from the RECORDING MODE option in the file system menu.


        FILE      SYSTEM     


RECORDING MODE : >LOOP RECORD

This will set the X200 to automatically delete oldest recordings first when the Hard Disk Cartridge is full (with the exception of write-protected files).  The record position is stored and any playback will not affect the current record position (this is in contrast to a VHS tape).

Write-protection can be used to keep Alarm recordings but loop the background (Normal) recording. 

Single Pass Recording

By selecting SINGLE PASS from the RECORDING MODE option in the file system menu.


        FILE      SYSTEM     


RECORDING MODE : >SINGLE PASS

The X200 records until the Hard Disk Cartridge is full and then stops.  Recordings may be deleted in the RESET menu or loop recording enabled so that the oldest files will be overwritten first. 

Transferring Images to Video Tape

It is possible to transfer recorded footage from an X200 to a video recorder.

Connections

X200-04

The X200 composite video out BNC connector marked ‘Video Out’ on the rear panel of the X200-04 is connected to the video recorders BNC composite video input using a BNC-BNC lead.  If the video recorder does not have a BNC connector for video input then it is possible to use a suitable adaptor (for example BNC to RCA) as long as the video recorder input is of a composite video type.

X200-16

The ‘Video Main Out’ and ‘Video GND Main Out’ on the 25 way male D-type connector on the rear panel of the X200-16 are connected to the signal and GND connections of the composite video input of the video recorder with an appropriate lead.

Recording

Connect the X200 video out to the video recorders video input using a suitable lead.  Insert a suitable tape into the video recorder and rewind / fast forward until it is in the desired recording position.

Using an X201 reviewer select the file to be transferred from the X200 by using the files menu.  Scroll through the file list until the required file is found and then press the right menu button next to the file so that it appears on the screen of the X201 Reviewer.  

Once selected, the footage will automatically begin to play, press the stop button immediately to avoid missing the first part of the footage.  The footage may be rewound if necessary using the rewind control on the X201 (please refer to the chapter on the X201 Reviewer for specific details on playback controls).  If a different camera view is required then this can be selected by pressing the appropriate number key on the X201 Reviewer relating to the camera input number on the X200.

When ready press record on the video recorder and then press play on the X201 Reviewer to restart the footage from the X200.  The selected camera view from the file should now be seen playing on the X201.

When the file has been recorded press stop on the video recorder and on the X201 reviewer.

Video Compression

The X200 records images, audio, GPS and other data into 10 minute or 1 hour proprietary format files ending with the .xba file extension.  A trade-off between image quality and file size can be made by selecting from the five levels of video quality: low, medium, high, v. high and v.v.high.  The low setting uses greater compression than the high settings and consequently less disk space is used.

As image quality rises however so does the resultant file size so a decision will have to be made as to the level of image quality needed and the length of recording required to be stored on any given size of Hard Disk Cartridge.

Non-predictive compression (full update)

In the Advanced Menu the user can select between two compression styles.  The first, “Full Update Recording” means that a full image is stored every time.  Each image stands alone in its own right and uses no prediction from previous images – the recording type is termed non-predictive.  The advantage of full update recording is that each image is independent and free from any inter-image distortion.  The images can also be searched easily during playback.  The disadvantage is that no use is made of any similarity between successive images and the compression performance can be up to 5 times worse (but typically 3 times worse) than conditional refresh recording.

Predictive Compression (conditional refresh)

With conditional refresh recording the X200 stores a full image followed by a sequence of partial images for each camera.  When the file is searched, the full image (known as the keyframe) is used as a starting point for playback.  The X200 uses a powerful algorithm that detects motion and for each partial image, only updates areas of the image that require it.  Partial images may be 1/10th the size of the full images when there is little motion in a scene.  There is no cumulative error (which can occur in some MPEG implementations) and the difference between full update recording and conditional refresh recording is designed to be imperceptible.  The advantage of conditional refresh recording over full update recording is the compression performance is superior (typically 3 times).

The system defaults to using conditional refresh for normal and timer recording and full update for shot and alarm recording.
Audio

The X200 has two line-level audio input and output channels.  Connection to the X200 is via a 5 pin 180° female DIN connector (DIN 41524) on the rear panel of the X200 which is detailed in the Connector Specifications section of this manual.

The two input channels can be assigned to all cameras or a single camera in order to associate recorded sound with the appropriate cameras and images for a particular installation.

The audio channels can be played back individually or together when viewing footage in PCLink200 PC software.  They can also be disabled during playback.

The X201 Reviewer can also be used for audio playback through its built in speaker.  The audio signal is carried to the reviewer via the RJ45 reviewer cable, no other connections are necessary.   It must be noted that at present playback via the X201 is in mono via channel 1 only.  

The audio inputs on the X200 Recorder are line-level.  Therefore some microphones will require the use of a dedicated preamplifier in order to raise their very low levels of output to line-level.  The X200 is configurable so that the line-level input range can be set from 0.12 – 2.0Vrms.

For detailed information on configuring the audio settings in the X200 please refer to the Audio Recording Menu in the Menu System section of this manual.

2 Channel audio recording with 2 microphones and a pre-amplifier.







If the X200 is to be used for ‘Audio Only’ recording, please see recommended settings on the X200 Recording Time Calculation page.

PC Access Precautions

It is important to understand that the X200 file system is a subset of the PC FAT32 file system.  The PC will access the X200 disk cartridges with no problems but the X200 will not be able to read every FAT32 file system written by the PC.

Permitted on a PC

Reading the .xba files

Modifying the write-protect status of files

Performing disk utilities that read the disk (e.g. Scandisk) but do not modify disk

Not Permitted on a PC

All write accesses to the disk if it is to be reused in an X200.  These include:

Formatting the disk on PC (including any Disk Manager MBR checks/fixes)
Defragmenting the disk

Deleting files

Renaming files

Generating new files

Creating a recycle bin on the disk

PC Access Network Ports

PCLink200 uses UDP port 69 (standard TFTP port).

RemoteLink uses UDP port 5465.  

LANLink uses UDP port 69 (standard TFTP port).

Time Adjust uses TCP port 8463 (can be configured within the X200 menu system).

Security measures on the network such as encryption and MAC address filtering may need to be adjusted in order to achieve this. Also security applications such as Norton and Symantec on the PC may need to be configured to allow the PCLink Suite applications to operate correctly.

Any installed network or local PC firewalls may have to be instructed to allow the use of this port to prevent communication problems between the PC and the X200.

The Windows Vista firewall may block the X200 responses in PCLink and therefore show as “no reply”. To add a specific rule which fixes PCLink's ping reply problems in Vista:

Open the Windows Firewall with Advanced Security within Windows Vista.

1.
Click Inbound Rules on the left tree then and click New Rule in the Actions Pane on the right.

2.
Click Custom and click Next.

3.
Click All programs and click Next.

4.
For Protocol type, select ICMPv4.

5.
Click Customize button.

6.
Click Specific ICMP types, then for 'Type 0', 'code Any', click Add at the bottom. Click OK, and then click Next.

7.
Under Which local IP address does this rule match? and for Which remote IP address does this rule match click either Any IP address or These IP Addresses. If you click These IP addresses, specify the IP addresses and click Add, then click Next.

8.
Click Allow the connection, and then click Next.

9.
Under When does this rule apply?, click the active profile, any or all profiles (Domain, Private, Public) to which you want this rule to apply, and then click Next.

10.
For Name type a name for this rule and for Description an optional description. Click Finish.
Watermark

The X200 uses a fragile watermark.  Any modification to the image data will destroy the watermark.  The image data that makes up the image set is passed though a function that generates a "magic number" or hash code from the images.  The terms hash code and watermark are synonymous.  A hash code is created automatically by the X200 for each image set and is then highly encrypted and stored in the information block.  

The hash code can be de-encrypted and regenerated by passing the image data back though the function i.e. in a watermark checking program.  If the hash code obtained matches the hash code stored in the information block, the image data has not been altered or modified in any way.  The watermark is "destroyed" when the hash code stored in the information block and the hash code of the data do not match.

The watermark is always on on the X200 i.e. all recordings have the watermark embedded in real-time as the footage is laid to disk, it cannot be turned off. Within PCLink200, you can turn the display of the watermark on/off - Goto Tools>Preferences - there is a pull down menu for the position of the watermark on the screen, by default it is off within PCLink.
Technical Information

Hashing function:           MD5

Encryption function:      64 bit DES
Sequencing

In addition to every image being protected by the Watermark, each consecutive image and file have their own unique sequence numbers. This protects any images being removed from a file and protects any files being removed from a sequence of files.

Watermark / Sequencing report

Within PCLink200, a report can be produced against an image, file and/or sequence of files. 

PCLink will analyse the data against the encrypted hash and analyse the data’s sequence numbering. If any images have been modified, any images removed or any files removed, PCLink will identify them and report accordingly. 

Note – The new sequencing feature was introduced with version 1.8.3 of X200 software and V6.3 PCLink software.
GPS
The Global Positioning System (GPS) is a worldwide radio-navigation system formed from a constellation of 24 satellites (placed in orbit by the US Department of Defence; the first was launched in 1978) and their ground stations.  Using accurate timing information, a GPS receiver (GPSr) is able to calculate its position using triangulation.

Anyone with a GPSr can use the system to determine their position anywhere in the world with an accuracy of around 15 metres.

The accuracy is determined by the quality of the satellite signals and the number of them ‘in sight’.  The GPSr must be positioned so its antennae have a clear line of sight of the sky – obstructions such as foliage and reflected signals in built-up areas can reduce the accuracy.

NMEA-0183 Interface Standard

The National Marine Electronics Association (NMEA) develops and maintains a number of standards related to the marine electronics industry.

The NMEA-0183 Interface Standard defines electrical signal requirements, data transmission protocol and time, and specific sentence formats for a 4800-baud serial data bus. Each bus may have only one talker but many listeners.  The X200 Digital Video Recorder supports GPS receivers that are NMEA-0183 compliant.

GPS Mice

A number of GPS receivers on the market are commonly referred to as GPS Mice because they consist of a GPS engine (GPS receiver and embedded antenna) in a compact case with a single power/data cable.  Once powered up these devices send out the GPS data over the serial data connection using the NMEA-0183 protocol standard.

Since the X200 Digital Video Recorder provides +5V power out to the GPS mouse, only those which operate at this voltage and draw no more than 200mA should be used.   The X200 Digital Video Recorder has been tested with the following GPS receivers:

· Garmin GPS16 LVS & GPS18 LVC & GPS18x LVC
· RoyalTek Sapphire Serial GPSr

· Fortuna U2 Smart GPS
Note – When using the Garmin GPS18 LVC the X200 baud rate must be set to 192,00. 
Configuration

Connection

The GPS receiver is connected to the X200 Digital Video Recorder through the RS232 port.  The diagram below shows the 9 way D-type connector viewed from the back of the X200 and details those pins to be used for the serial data connection and the +5V supply to the GPS receiver.

Note that the +5V supply is only intended to provide power to a GPS receiver with a current consumption of no more than 200mA.
[image: image17.png]00000
POOO

RS 232
(9 pin male d-type)




	GPS Receiver Connections

	Pin
	Connection

	4
	+5V supply

	5
	0V

	9
	Data


X200 GPS Options

Configuration of the X200’s GPS options is done via the menu system accessed using a X201 reviewer.  The GPS menu option presents the user with a number of options allowing the embedding of GPS position and speed and the units to be used.

If no valid GPS signal is being received then the X200’s GPS menu page is similar to that shown below:

            |  GPS  |     
   EMBED GPS POSITION:   >YES
   EMBED GPS SPEED:       YES

   SPEED UNITS:           MPH
   SYNC CLOCK WITH GPS:   YES

   GPS BAUD RATE:         4800 bps
   GPS NOT CONNECTED

Or, if valid GPS data is being received, it is displayed towards the bottom of the screen:

            |  GPS  |     
   EMBED GPS POSITION:   >YES
   EMBED GPS SPEED:       YES

   SPEED UNITS:           MPH
   SYNC CLOCK WITH GPS:   YES

   GPS BAUD RATE:         4800 bps

   00011.8464W      5220.5986N

    18 MPH

This option determines whether the serial data from the GPS receiver will be recorded by the X200 Digital Video Recorder.  Note that if no GPS data is received by the X200 (because no functional GPS receiver is connected) then there will be no data recorded either.

If a GPS receiver is connected but satellite lock has been lost then it is still possible to record the data but it will not indicate position, speed, date or time and the actual content may vary according to the type of GPS receiver employed.
Embed GPS Position

Selecting YES to ‘EMBED GPS POSITION’ will cause the position information to be embedded in the recorded image.

Embed GPS Speed

Selecting YES to ‘EMBED GPS SPEED’ will cause the speed information to be embedded in the recorded image.

Note that speed and position information will only be embedded in the video image when the GPS signal is valid and the position can be calculated.
Speed Units

Select either KPH for kilometres per hour or MPH for miles per hour.

Sync Clock with GPS

The X200 Digital Video Recorder includes a clock which is used to timestamp recording files and overlay the date and time on recorded images.  Although accurate, the system can be configured to synchronize the clock with the date and time information received from the GPS receiver. 

Synchronization only occurs when the X200 is powered up and before it starts recording.  At this time the built-in clock may be corrected by a maximum of 20 seconds if a previous discrepancy has been detected between the internal time and the GPS receiver time.

Local Standard Time

The time received from the GPS receiver is always UTC (Coordinated Universal Time) which is the same as GMT (Greenwich Mean Time).  In order to correctly work out the error between the local standard time (used by the X200’s internal clock) and that received from the GPS receiver, the system must be set with the correct time zone offset.
GPS Baud Rate

Set the X200 data rate according to the GPS mouse you are using. Rates configurable include; 2400, 4800, 9600 and 19200, 38400 bps.

Note – It maybe necessary to change the baud rate on the GPS mouse and set it to a specific rate inline with the X200 setting. Reference the GPS mouse product instructions to configure the baud rate then power off/on the X200 (whilst connected to the GPS).
Troubleshooting

Satellite Signal Quality

In order to calculate its position, a GPS receiver must be receiving signals from at least 3 satellites and do to so it must have a clear view of the part of the sky in which they are located.  GPS receivers do not work indoors.

When first powered up the GPS receiver will search for satellite signals.  The signal includes information on the position of other satellites and all this information must be received before an accurate position calculation can be made.  It can take a minute or two before a valid position can be determined after the GPS has been powered up.

Even when a signal is being received from a sufficient number of satellites, a number of factors can result in the degradation of the accuracy of the calculated position.  These include:

· Atmospheric Delays.  The satellite signal slows as it passes through the ionosphere and troposphere.  A model built in to the GPS calculations compensates by an average delay to partially correct this error.

· Signal Multipath.  This occurs when the satellite signal is reflected before reaching the receiver.  The delays caused by the additional travel time can cause errors.

· Receiver Clock Errors.  The GPS receiver’s built-in clock is not as accurate as the atomic clock on the satellites and so slight timing errors can result.

· Orbital Errors. Cause by inaccuracies of the satellites’ reported position.

· Satellite Visibility.  The greater the number of satellites that the GPS receiver is able to receive a signal from, the better the accuracy of the calculated position.  Buildings, terrain or electrical interference can block the signals.

· Satellite Geometry. The GPS satellites are constantly moving, orbiting the earth at a height of around 11,000 miles.  Each making at least two complete orbits in any 24 hour period. Ideal satellite geometry occurs when the satellites are located at wide angles relative to each other – poor geometry, when the satellites are close together or in a line, results in poorer accuracy.
GPS Receiver

A simple test to ensure that a ‘GPS mouse’ is functioning is to connect it to a PC’s serial port and use an application such as Microsoft® HyperTerminal® which comes as part of the Microsoft® Windows® operating system.

HyperTerminal® is a terminal emulator application that can be used to connect to other devices using an RS232 serial port.  Other similar applications are available but in each case the serial port to which the GPS receiver is to be connected should be configured to use the following settings:

	Baud Rate (bits per second)
	4800

	Data Bits
	8

	Parity
	None

	Stop Bits
	1

	Flow Control
	None


The following display shows HyperTerminal® being configured with the GPS mouse connected to COM1:
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Even if the GPS receiver is receiving no satellite data (for example, if it is being tested inside) then when it is connected to the serial port and a suitable power supply, it should start sending NMEA-0183 sentences similar to those shown below:

$GPGSA,A,1,,,,,,,,,,,,,50.0,50.0,50.0*05

$GPRMC,021341.581,V,36000.0000,N,72000.0000,E,,,270102,,*2B

$GPGGA,021342.581,36000.0000,N,72000.0000,E,0,00,50.0,0.0,M,,M,,0000*4C

$GPGSA,A,1,,,,,,,,,,,,,50.0,50.0,50.0*05

$GPRMC,021342.581,V,36000.0000,N,72000.0000,E,,,270102,,*28

$GPGGA,021343.581,36000.0000,N,72000.0000,E,0,00,50.0,0.0,M,,M,,0000*4D

$GPGSA,A,1,,,,,,,,,,,,,50.0,50.0,50.0*05

$GPRMC,021343.581,V,36000.0000,N,72000.0000,E,,,270102,,*29

$GPGGA,021344.581,36000.0000,N,72000.0000,E,0,00,50.0,0.0,M,,M,,0000*4A

$GPGSA,A,1,,,,,,,,,,,,,50.0,50.0,50.0*05
The above sentences were recorded when no satellite signals were being received.  The first ‘0’ after the ‘E’ character in the GPGGA sentence indicates invalid fix and the first ‘V’ character in the GPRMC sentence indicates navigation warning.

If no serial data is received then the GPS receiver is not functioning correctly and so the first course of action should be to either investigate the problem or replace it.
Embedded Information

If the option to embed the GPS data within the video image is selected then the information is seen above the data and time information.  The example below shows both position and speed information embedded within the image:
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The top line of the embedded information shows the position as longitude followed by latitude in the following format:

DDDMM.MMMMH   ddmm.mmmmh
where the fields are:

	DDD
	The longitude degrees.

	MM.MMMM
	The longitude minutes (as a decimal)

	H
	The longitude hemisphere (‘W’ for west of the meridian, ‘E’ for east of the meridian)

	dd
	The latitude degrees

	mm.mmmm
	The latitude minutes (as a decimal)

	h
	The latitude hemisphere (‘N’ for north of the equator, ‘S’ for south of the equator)


In the above example, the current coordinates are 0° 11.8464’W, 52° 20.5986’N.  Expressed as degrees, minutes, seconds this is 0° 11’ 50.784”W, 52° 20’ 35.916”N
The line below the position shows the camera name (blank in the above example) followed by the speed displayed in the selected units.  The third and final line shows the camera number, the time and the date.
NMEA Sentences

The NMEA-0183 interface standard defines electrical signal requirements, data transmission protocol and time, and specific sentence formats for a 4800 baud serial data bus.  Those sentences that are relevant to GPS data and recorded by the X200 Digital Video Recorder are detailed below:
GPGGA - Global Positioning System Fix Data
This sentence includes the positioning fix information with additional information about the accuracy of the fix and the satellites used in its determination.

$GPGGA,123519,4807.038,N,01131.324,E,1,08,0.9,545.4,M,46.9,M, , *42

           123519        Fix taken at 12:35:19 UTC

           4807.038,N    Latitude 48 deg 07.038' N

           01131.324,E   Longitude 11 deg 31.324' E

           1             Fix quality: 0 = invalid

                                      1 = GPS fix

                                      2 = DGPS fix

           08            Number of satellites being tracked

           0.9           Horizontal dilution of position

           545.4,M       Altitude, Metres, above mean sea level

           46.9,M        Height of geoid (mean sea level) above WGS84

                         ellipsoid

           (empty field) time in seconds since last DGPS update

           (empty field) DGPS station ID number
           *42           Mandatory checksum
GPGSA - GPS DOP and active satellites
This sentence 
$GPGSA,A,3,04,05,,09,12,,,24,,,,,2.5,1.3,2.1*39
           A             Auto selection of 2D or 3D fix (M = manual)

           3             3D fix

           04,05...      PRNs of satellites used for fix (space for 12)

           2.5           PDOP (dilution of precision)

           1.3           Horizontal dilution of precision (HDOP)

           2.1           Vertical dilution of precision (VDOP)

             (DOP is an indication of the effect of satellite geometry on

             the accuracy of the fix.)

           *39           Mandatory checksum
GPRMC - Recommended minimum specific GPS/Transit data
This sentence includes the minimum recommended GPS data and includes the position (latitude and longitude), speed (in knots), date and time.
$GPRMC,225446,A,4916.45,N,12311.12,W,000.5,054.7,191194,020.3,E*68

           225446        Time of fix 22:54:46 UTC

           A             Navigation receiver warning A = OK, V = warning

           4916.45,N     Latitude 49 deg. 16.45 min North

           12311.12,W    Longitude 123 deg. 11.12 min West

           000.5         Speed over ground, Knots

           054.7         Course Made Good, True

           191194        Date of fix  19 November 1994

           020.3,E       Magnetic variation 20.3 deg East

           *68           Mandatory checksum
Glossary

	Almanac Data
	Contains information about the location of the GPS satellites and their orbital information at any time.

	Ephemeris Data
	Contains information about the status of the satellite, current date and time.

	GMT
	Greenwich Mean Time

	GPS
	Global Positioning System

	GPSr
	Global Positioning System Receiver

	NMEA
	National Marine Electronics Association

	UTC
	Coordinated Universal Time


The Menu System V1.8.4
The menu system is used to configure the X200 and gives control over recording resolution, camera sequencing, timer settings, alarm triggering and alarm triggered recording. There is also access to monitor options and password functions along with many other parameters.  

A menu can contain the following types of entry:

· Sub-menu heading - press the right arrow menu key and the sub-menu is entered.

· Function - press the right arrow menu key and the function is performed (e.g. Reset System).

· Selection - press the left and right menu keys to cycle through the choices.

· Numeric item - input numbers 0 to 9 on the keypad (e.g. entering a time) and use the left arrow button to go back and correct mistakes.

Any changes made to the menu system have immediate effect on the operation of the system.  The menu is stored on non-volatile Flash memory inside the X200.  To revert to the factory settings run a RESET MENU TO THE FACTORY DEFAULT STATE WITH: ENGLISH LANGUAGE function in the RESET SYSTEM menu.

Help Screens

Every menu and every item within the menu has a separate help screen.   Place the cursor against the chosen item and press the HELP key.  Where multiple pages of help are available, move from one to the next by pressing the HELP key.  Use the MENU EXIT key at any time to leave the help menu.

Menu Navigation

The menu system on the X200 can be accessed by using the X201 Reviewer. Connect the dedicated 8 way (Ethernet style) cable (supplied with X201) to the recorder and consult the instructions for X201 Reviewer.


[image: image20.jpg]MENU






Press any of the 4 menu buttons to enter the main menu.  Once in the menu system, their function is as follows:

Move arrow cursor up to the next item.

Move arrow cursor down to the next item.

If the arrow cursor is currently at a menu selection,

(e.g.  RESOLUTION: > HIGH), 
pressing the left button will cycle the value backwards, 


    (e.g. to  RESOLUTION: > MEDIUM), 



If the arrow cursor is currently at a menu selection 



(e.g.  RESOLUTION: > LOW), 

pressing the right button will cycle the value forwards,



(e.g. to  RESOLUTION: > MEDIUM).

If the arrow cursor is currently at a sub-menu title



(e.g.  > OTHER OPTIONS).



pressing the right button will enter this sub-menu.

The MENU EXIT key on the X201 Reviewer will exit the current menu and move up 1 level in the menu system when pressed.  If already at the top level of the menu pressing this key will exit the menu system completely and return to the video switcher.

If the left and right menu keys have no effect, then numerical entry using keys 0 to 9 is required.  
The SEARCH key on the X201 Reviewer accesses a menu allowing the user to go to a specific time and date in the recorded footage. Pressing this button will enter the PLAYBACK SEARCH screen as seen below. If the footage on a given camera cannot be found (it may not have been recorded), a "NO FOOTAGE FOR SELECTED CAMERA" message will be displayed.  


     PLAYBACK SEARCH

          
TIME :  

00 : 00


DATE :

00 / 00 / 00


PLAY FROM SET TIME DATE


PLAY OLDEST


PLAY NEWEST

TIME – Use the number keys to enter a time in 24hr format.
DATE – Use the number keys to enter a date in the format DD/MM/YY

· PLAY FROM SET TIME DATE – Plays the footage beginning from the time and date entered. If there is no footage at the time specified a jump is made to the nearest footage to the time given.

PLAY OLDEST – Plays the oldest available footage on the Hard Disk Cartridge.

PLAY NEWEST – Plays the most recent footage available on the Hard Disk Cartridge.

Main Menu


MAIN  MENU            

        

OTHER  
MENU               

        

NORMAL 
RECORDING          

        

TIMER  
RECORDING          

        

SHOT   
RECORDING



AUDIO 

RECORDING


MOTION 
DETECTION          

        

ALARM  
RECORDING          

        

ALARM  
INPUTS             

        

ALARM  
OUTPUT / LEDs            

        

VIDEO  
SWITCHER


VIDEO

SWITCHER 2
Sub-menus available from the MAIN MENU:

OTHER MENU – Leads to the other menu items.

NORMAL RECORDING – Default recording set-up activated by the record on/off button.

TIMER RECORDING – Recording set-up activated by the inbuilt weekly interval timer.

SHOT RECORDING – Shot Recording set-up activated by specified alarm inputs.

AUDIO RECORDING – Set-up for audio recording.

MOTION DETECTION – Set-up for motion detection activation of recording

ALARM RECORDING – Recording set-up activated by the alarm inputs.

ALARM INPUTS – Sets the open/closed conditions and actions for each of the 4 alarm inputs.

ALARM OUTPUTS – Sets the open/closed condition and triggers for the alarm output.  Sets the conditions for the external LED outputs.

VIDEO SWITCHER – Sets the dwell times for the main video out.

VIDEO SWITCHER 2 – Sets the dwell times for the switcher video out (X200-16 only).

Other Menu


OTHER  MENU            

        

FILES



PASSWORD



TIME AND DATE


CAMERA OPTIONS


FILE SYSTEM



LAN



GPS



STATISTICS



ADVANCED


REMOTE SETTINGS



G SENSOR


RESET

Sub-menus available from the OTHER MENU:

FILES – Allows listing and access to all recordings on the Hard Disk Cartridge.

PASSWORD – Settings for password protection and change password facility.

TIME AND DATE – Change the system time and date plus summertime correction.

CAMERA OPTIONS – Settings for camera text and focussing mode

FILE SYSTEM – File organisation and health check.

LAN – Set-up for LAN connection.

GPS – Set-up to confirm connection of GPS device and format of GPS data.

STATISTICS – General recoding and system statistics.

ADVANCED – Advanced options.

REMOTE SETTINGS – Determines the settings for GSM and RS232 control
G SENSOR – For future use.
RESET – Reset recordings and/or return menu to factory default settings.

Files Menu


     FILES            

     >FIRST   /   LAST PAGE

       PAGE 
1 OF 1

 W
00:20:00
01/01/04

 W A
00:10:00
01/01/04


00:00:00
01/01/04

The files menu lists the files that are recorded on the Hard Disk Cartridge and allows the user to write-protect or remove write-protection for any file and provides instant jump to any file.  The file listing is displayed on a number of pages with each page showing up to 10 files.

· FIRST / LAST PAGE

Use the left menu button to view the first page of the file listing.  Use the right menu button to view the last page of the file listing.

PAGE

Use the right menu button to advance to the next page of the file listing and the left menu button to move back to the previous page of the file listing.  The current page and the total number of pages will be shown by ‘x‘ OF ‘x‘.  For example 1 OF 10 would indicate that page 1 is being shown out of a total of ten pages.

File Listing

The file listing shows files most recent first.  Files marked with an ‘A’ indicate that it is an alarm recording and ‘W’ indicates that the file is write protected.  In the above menu example there are 2 normal recording files and 1 alarm event file which has been write protected.  All files are 10 minutes in duration. Also, “M” indicates a motion detection file.

Voluntary Write-Protection 

Any file can be write-protected to avoid it being erased on loop recording.  For example there may be some critical footage that needs to be kept but the user may want to continue recording on the same disk once he has protected this file.  To write protect any file move the arrow cursor next to it in the file listing and press the left menu button, “W” will then appear next to the file showing that it is protected.  Write-protection can be removed by pressing the left menu button again.  In the above example the file 00:20:00 has been voluntarily write-protected.  Pressing the left menu button again removes write-protection (the left menu button toggles the write protect status).  Write-protected files appear as write-protected (read only) on the PC.  You can change the write-protect status either on the PC or as explained on the X200.  Any files that are not write-protected on the X200 get overwritten (oldest first) during the process of recording.  

Jump to File

Press the right menu button to jump to the start of the file indicated by the arrow cursor.

Password Menu


PASSWORD            

           
PASSWORD REQUIRED FOR :


RECORD:

NO


MENU:


NO


SWITCHER:

NO


PLAY:


NO

  
>CHANGE PASSWORD  . . .

The password menu restricts user access to the four key parts of the system. Here is a summary of the menu selections available:

· RECORDING - If set to YES, the record button is password protected. 

· MENU - If set to YES, access to the menu system is password protected. 

· SWITCHER - If set to YES, the button to activate auto switcher mode is password protected. 

· PLAY - If set to YES, the controls to review recorded footage are password protected.

If the user tries to access a protected function, he is asked to type in the password.  The default password is 0000 when shipped.  On correct password entry (four digits e.g. 3524 or 8912) the password protection is temporarily disabled.  It is reinstated after 1 minute of no key presses.  Protection is also automatically reinstated when leaving the password menu.

· CHANGE PASSWORD - The supervisor who knows the password is requested to type in the old password, followed by the new one.  He is then requested to retype the new password.  If he has done this successfully the new password is made the current one and the password protection is activated. 

Hints

It is intended in a password protected system to at least protect the menu system.  This ensures that important operating settings cannot be tampered with.  Other protection may be required e.g. the record button may be disabled.  Some examples are given overleaf. 

Examples

	Selection
	Set to

	RECORDING
	YES
	YES
	NO

	MENU
	YES
	YES
	YES

	SWITCHER
	YES
	NO
	NO

	PLAY
	YES
	NO
	NO

	Result:
	Full protection - no functions available.
	Allow the user to review footage and look at live cameras only.
	Allow the user to carry out basic functions, but without access to any menus.


The password for the unit when the unit is shipped is 0000.  This may be changed as described previously.

In the event of complete password lockout contact your installer / distributor for a code for the X201 Reviewer.  The user can enter a code on the X201 Reviewer which will enable him to reset the unit and reset the password.

Note: playback password cannot be used in conjunction with RS232 playback (RS232 overrides/disables the playback password set on x200).
Time and Date Menu


        TIME AND DATE            

           
TIME:
          >
00 : 00 : 00


DATE:

01 / 01 / 04


MODE

DD/MM/YY


SET CLOCK TO THESE SETTINGS  . . 

LAN / WLAN TIME ADJUST:
YES

SUMMERTIME ADJUST:
UK


SUMMER / WINTER TIME:
WINTER

The time and date menu sets up the date, time and seasonal correction.

· TIME - Type a time using the numbered keys.  Invalid times are prohibited

· DATE - Type a date using the numbered keys. Invalid dates are prohibited

· MODE – Use the left and right menu buttons to toggle the format the date is displayed in between DD/MM/YY and MM/DD/YY.
· SET THE CLOCK TO THESE SETTINGS - Press the right menu button to set the time and date as entered above.

You must use leading zeros for the time and date where necessary, e.g. 09:45 and 04/07/98. 

The unit is shipped from the factory with date and time set to GMT (UCT).

· LAN / WLAN TIME ADJUST – If set to YES this allows the X200 to accept broadcasts over a LAN/WLAN to adjust its time.

· SUMMER TIME ADJUST - Set this to OFF if you do not want the unit to automatically correct for daylight saving time.  Select UK /  EUR / USA for the unit to automatically adjust for daylight saving time in the UK, Central Europe or USA.
UK - At 1:00 am on the last Sunday in March the clock is put forward 1 hour (summer time) At 2:00 am on the last Sunday in October the clock is put back 1 hour

EUR
 - At 2:00 am on the last Sunday in March the clock is put forward 1 hour (summer time) At 3:00 am on the last Sunday in October the clock is put back 1 hour

USA – At 2:00 am on the second Sunday in March the clock is put forward 1 hour (summer time).  On the first Sunday in November the clock is put back 1 hour.

Summer Time Adjust is automatically applied even if the unit is switched off during the time at which the clocks go forwards or backwards.  In the latter case correction is applied on power-up.  A message is displayed indicating to the user that the time has been modified.

The Current time period is shown as either SUMMER or WINTER at the bottom of the menu screen.
Camera Options Menu


    CAMERA    OPTIONS        

          CAM

          CAM


1    C210KHD DOOR
2    C210KHD FRNT


3    C210KHD REAR
4    C210KHD DRVR


5


6


7


8


9


10


11


12


13


14


15


16

    
DUPLICATE TEXT FROM CAM 1  .  .

          
TIMESTAMP POS:   > BOTTOM LOW

FOCUS MODE:      OFF
CAMERA TEXT ENTRY - Allows the user to create an optional text label of up to 12 characters per camera.

Use the up and down ‘MENU’ arrow keys to move to the previous or next camera.  Use the numbered keys on the X201 reviewer to cycle through the available characters for that key and the left & right ‘MENU’ arrow keys to move the highlighted cursor to the previous or next character respectively.  
The numbered keys have the following 4 characters attached to them, pressing the key repeatedly will cycle through the 4 available characters.  The fifth character on each key is a blank space; use this to delete any unwanted characters.
Key
Number/Characters

1
A B C 1 
(blank)

2
D E F 2 
(blank)

3
G H I  3 
(blank)

4
J K L  4

(blank)

5
M N O 5
(blank)

6
P Q R 6

(blank)

7
S T U 7 
(blank)

8
V W X 8
(blank)

9
Y Z 9 

(blank)

0
0 

(blank)

Keep pressing keys 0 to 9 until the desired character appears. For example pressing key '1' gives the 'A' character, pressing again, the 'B' character, again the 'C' character, again the '1' character and finally a blank character. The sequence repeats. The camera text will appear above the time stamp on each image. Like the time stamp it is embedded into each image and cannot be removed from the image.

DUPLICATE TEXT FROM CAM 1 – Copies the current text from camera 1 to all other cameras.  Move the arrow cursor next to this option and press either the left or right menu buttons to copy the text.  This avoids repeat typing of vehicle registration numbers or other common text.

TIMESTAMP POS: - The position of the timestamp can be moved to either bottom low/bottom-mid/bottom-high which are 3 positions below the main image or top-low/top-mid/top-high which are 3 positions above the main image.  Select NO TIMESTAMP if you do not wish to see a timestamp on the recorded images.
A typical time stamp is shown below with camera text:

Camera Text

JKN456Y DOOR

C1

12:00:00

27/07/01

Camera
  
Time        
         
 Date
            

Number




             


The camera number indicates which camera grabbed the image, and the time and date indicate when the image was grabbed. 

FOCUS MODE – When set to ON the X200 is able to provide an indication of camera focus for each of the connected cameras.  

In order to commence camera focusing first stop the X200 recording if it is already doing so.  When FOCUS MODE is set to ON the X200 will start recording image data in order to provide an indication of focus level, this data is not recorded to the Hard Disk Cartridge.  When the process is finished select OFF to stop the X200 recording data for camera focusing and recommence recording as required.

The indication of camera focus can be provided by either one of the LED outputs or a suitable buzzer/LED circuit connected to the X200 Alarm Output providing a positive confirmation when the Alarm Output is active.

In order for the X200 Alarm Output to activate a buzzer/LED for camera focusing It is necessary for the CAMERA FOCUSING option to be set to YES in the Alarm Output / LED’s menu if the alarm output is to be used.  If one of the LED outputs is to be used then either LED1 OUTPUT or LED2 OUTPUT will need to be set to FOCUS and a suitable circuit connected to the relevant LED output.

To focus a camera when in FOCUS MODE and with a suitable indicator circuit attached to the X200 Alarm Output or one of the LED outputs, first cover the lens of the camera in question for a couple of seconds.  A long indication will be given from the attached buzzer/LED to indicate that the camera has been selected.

Whilst adjusting the focus of the selected camera the presence of short buzzes/lights indicates that the focus is improving.   If the camera focus overshoots and begins to worsen the buzzes lights will stop.  To bring the camera back into focus move the focus in the opposite direction until a short duration indication is given again.  The optimum focus will be found between these two points.

In order to switch to another camera cover the camera lens of the camera in question for a couple of seconds until a long duration buzz/light is shown.  This camera is now selected and the focusing process can be completed as previously described.

File System Menu


        FILE      SYSTEM     


RECORDING MODE : >LOOP RECORD
FILE LENGTH :

10 MINUTES

FILENAME TEXT :

WRITE PROTECT ALARM REC :
NO

WRITE PROTECT  SHOT  REC :
NO

FILE SYSTEM CHECK MENU  .  .

The file system menu controls how files are laid onto the disk.

· RECORDING MODE- Sets either LOOP RECORD (oldest files will be overwritten first when Hard Disk Cartridge is full) or SINGLE PASS recording (recording will stop when Hard Disk Cartridge is full).

· FILE LENGTH – 10 MINUTES / 1 HOUR / UNLIMITED
This controls how often new files are created, set the file length as appropriate.  The 1 hour setting is useful if you are recording over a long period of time and it is desirable to have a smaller number of files to manage or archive.  The 10 minute setting gives more files but each is of a small size and this may help in searching for specific short duration events.  Unlimited will produce a file each time the X200 is powered-up and recording is started.  The X200 will continue to record a single file until it reaches 2GB, then a new file will be started. Note that UNLIMITED cannot be used with NTSC recording format.
· FILENAME TEXT – Enter up to 12 characters of text that will appear at the start of all files.  For mobile applications a vehicle registration number could be used.  The X200 serial number could also be used.
This improves the audit trail.  Please note that the filename and serial number are buried 

into each file for audit trail purposes and can be verified.
· WRITE PROTECT ALARM REC – Select whether alarm recording files are write protected.  If alarm recording files are write protected they will not be deleted on loop recording (LOOP RECORD setting).

To remove write-protection either use the files menu and the left menu button (toggle ‘W’ 

status) or delete all recordings via the reset menu.
· WRITE PROTECT SHOT REC – Select whether shot recordings are write protected.  This is the same as per the WRITE PROTECT ALARM REC function but only affects shot recording files.
FILE SYSTEM CHECK MENU – Accesses the file system check menu.
File System Check


    FILE  SYSTEM CHECK     

  ON POWER SWITCH ON :

CHECK AND CORRECT

CREATE SYSTEM LOG
     PERFORM CHECK ONLY NOW

     PERFORM CHECK AND CORRECT NOW

This menu sets the default file checking and correcting action on switch on and can be used to check and/or correct files manually at any time.

NO CHECK / CHECK ONLY / CHECK AND CORRECT – Gives the option to check the file system at power on and optionally correct any errors.  This is the recommended option as the X200 will check and correct both the file system and FAT of the Hard Disk Cartridge on start-up.

CREATE SYSTEM LOG / DO NOT CREATE SYSTEM LOG – Determines whether a system log file is created and copied to the Hard Disk Cartridge when the X200 is powered-up.  This file can be used by Brigade Electronics as a diagnostic file to check system performance.  It is highly recommended that the default option of CREATE SYSTEM LOG is used.

PERFORM CHECK ONLY NOW – Pressing the right menu button will perform a file system check.

PERFORM CHECK AND CORRECT NOW – Pressing the right menu button will perform a file system check and fix any errors that are found.

LAN Menu


        
     LAN   


LAN STATUS :
  DISCONNECTED
IP ADDRESS : 
       >
10.
0.
0 . 200
SUBNET MASK :
255 . 255 . 255 .        0

GATEWAY :

10.
0.
0 . 255

   PING TEST   .  .  .

RECORD DURING TRANSFER:      NO
LAN IDLE TIMEOUT:

1 MIN

TIME ADJUST PORT:

8463

MAC :

    0 0 : 0 F : B 4 : 0 0 : 0 0 : 0 0

· LAN STATUS – Indicates whether the X200 is currently connected to a LAN enabled device.

IP ADDRESS – For devices communicating on a network, messages must identify the source and destination with an address.  The IP (internet protocol) address is a 32-bit number that uniquely identifies a device connected to the network and is usually represented in a dotted decimal form.


e.g.  10.0.0.28

Use the right and left menu arrow keys to move across the input fields and the number keys to input the address.

SUBNET MASK – The subnet mask is used to determine what subnet an IP address belongs to. An IP address has two components, the network address and the host address.  Subnetting enables a network administrator to further divide the host part of the address into two or more subnets. In this case, a part of the host address is reserved to identify the particular subnet. 

The subnet mask is the network address plus the bits reserved for identifying the subnetwork. (By convention, the bits for the network address are all set to 1.)  As a mask, it can be used to identify the subnet to which an IP address belongs by performing a bitwise AND operation the mask and the IP address. The result is the subnetwork address. 

Use the right and left menu arrow keys to move across the input fields and the number keys to input the address.

GATEWAY – This is the address of the ‘gateway’ in a network that a computer will use to access another network if a gateway is not specified for use.  In a network using subnets, it is the address of the router that forwards data traffic to a destination outside of the subnet of the transmitting device. 

Use the right and left menu arrow keys to move across the input fields and the number keys to input the address.

PING TEST ... – Selecting this option by pressing the right menu button will bring up the ‘ping test’ menu which is shown below. 

      

PING TEST                  

   PING ADDRESS:   10.  0.  0.  1

   >DO PING TEST
REPLY RECEIVED

   BYTES SENT:               
3988

   BYTES RECEIVED:     
5304

Enter the destination IP address of the unit you want to test communication with on the ping address line by using the left and right menu buttons to move across the fields and the number keys and then select DO PING TEST ....  If the destination receives the ping message and replies within 10 seconds then REPLY RECEIVED is displayed; otherwise ‘NO REPLY’ is displayed.

The BYTES SENT and BYTES RECEIVED fields update in real-time to show how many bytes are being transferred to and from the X200 and can provide further indication of data transfer.

RECORD DURING TRANSFER – If set to NO then the X200 will stop recording whilst LAN file transfer is taking place.  If set to YES then the X200 will continue to record whilst LAN file transfer is taking place, but this will have a negative impact on the transfer speed.
LAN IDLE TIMEOUT – If the alarm output is being used to indicate LAN activity then the LAN idle timeout will set the amount of time until the alarm output deactivates after no LAN activity.

TIME ADJUST PORT – The port number used by LANLink in order to check and synchronise the X200 internal clock to the LANLink reference.
MAC – All network devices include a unique media access control (MAC) address used to identify it on a network.  The address is a 48 bit number, usually represented as 6 bytes – each byte written in hexadecimal notation.
All Brigade Electronics devices have a MAC address which begins 00 0F B4 followed by another three bytes.

e.g.  00 0F B4 00 0A 48
The X200 LAN menu option allows the user to display its MAC address which may be useful in configuring access control with wireless networks.
GPS Menu


                 GPS   


EMBED GPS POSITION : 
NO


EMBED GPS SPEED :

NO


SPEED UNITS :

MPH


SYNC  CLOCK WITH GPS :
NO


GPS BAUD RATE:

4800 bps

GPS NOT CONNECTED

Embed GPS Position – Selecting YES will cause the position information to be embedded in the recorded image.

Embed GPS Speed – Selecting YES will cause the speed information to be embedded in the recorded image.

Speed Units – Select either KPH for kilometres per hour or MPH for miles per hour.

Sync Clock with GPS – The X200 Digital Recorder includes a clock which is used to timestamp recording files and overlay the date and time on recorded images.  Although accurate, the system can be configured to synchronize the clock with the date and time information received from the GPS receiver.  

Synchronization only occurs when the X200 is powered up and before it starts recording.  At this time the built-in clock may be corrected by a maximum of 20 seconds if a previous discrepancy has been detected between the internal time and the GPS receiver time.

Selecting YES will synchronize the X200 clock on power up.  The time received from the GPS receiver is always UTC (Coordinated Universal Time) which is the same as GMT (Greenwich Mean Time).

The current status of the attached GPS device (mouse) is show at the bottom of the screen which indicates whether it is connected and able to lock to the GPS satellites.

GPS Baud Rate - Set the X200 data rate according to the GPS mouse you are using. Rates configurable include; 2400, 4800, 9600 and 19200, 38400 bps.

Statistics Menu


           STATISTICS   


            OPERATING SYSTEM:     1.7.0
160.0

SIZE IN GIGABYTES

50%

USED

20%

WRITE PROTECTED

342

FILES

01 / 10 / 07
START DATE

21 / 10 / 07
END DATE

21.0

DAYS RECORDING

     VIEW SERVICE LOG

     FAIL QUOTA/DAY:
10/DAY
The statistics page gives the operating system version number, disk size, percentage used and percentage write protected. 

Recording statistics are updated every minute and are intended to be used for monitoring a camera system and to provide an indication of the capacity of the X200 in different recording environments. 

The total number of files along with the start date, end date and total amount of days recording are shown.

The Service log cant be viewed from here and holds specific information about service events. It can also be reset from within the view service log sub menu.

Set how many fail messages that must occur for any given day before the FAIL LED is lit.

Advanced Menu


           ADVANCED
          >
USE RECORD STATE AT POWER OFF

ENABLE X200 RECORD BUTTON:  YES
LOAD SYSTEM UPGRADE  .  .

SAVE SYSTEM UPGRADE  .  .


LIVE VIEW:
OFF

HEALTH PAGE DISPLAY:
OFF

SPLASH SCREEN:
OFF

RECORDING SETTINGS

MODEM LOOPBACK TEST
H/W VER: 16AE 
SERIAL NUMBER: 42

The advanced menu provides control over more sophisticated X200 functions.

The default setting USE RECORD STATE AT POWER OFF means that if the unit was recording when it was switched off it will record when it is switched back on.  Also if the unit wasn’t recording when it was switched off it won’t be recording when it is switched on.  This setting is generally convenient for covert use where recording is switched on and off by pressing the record button and the unit continues the way it left off. Also convenient if you want the X200 to continue recording after a power cut.
The DO NOT RECORD AT POWER UP setting is useful if manual adjustments need to be made to the menu settings every time the unit is switched on prior to recording.  Note that the unit will not do normal recording after a loss of power e.g. in a power cut so this setting should be used with caution.

The RECORD AT POWER UP setting should be used if the unit is always to do normal recording on power up.  This is important in vehicle applications where the user may have inadvertently switched the unit off in a non-recording state (e.g. he has just been playing back some footage and he switched off recording to make this easier).  With this setting however the unit is left at switch off, it will record the next time it is powered up.

ENABLE X200 RECORD BUTTON – If set to YES the ‘Record’ button on the front of the X200 will switch Normal Recording on and off.  If set to NO this button is disabled.

LOAD SYSTEM UPGRADE – This loads a new version of the X200 operating system from the Hard Disk Cartridge.  See “Software Updates” page for detailed instructions.
SAVE SYSTEM UPGRADE – This saves the X200 operating system and current menu settings to the Hard Disk Cartridge as a .xos file. The Cartridge can then be used as a master to set up another X200 with the same software version and menu settings.  Use LOAD SYSTEM UPGRADE on the other X200 with the master Cartridge inserted.
LIVE VIEW – When set to ALWAYS the X200 video outputs will show the live views from connected cameras as determined by the Video Switcher Menus even if a Hard Disk Cartridge is not installed.  If set to OFF the video outputs will not show the live camera views and the Main Output will show an error message stating the no Hard Disk Cartridge has been installed in the recorder.
HEALTH PAGE DISPLAY – Set the length of time for which the health page is displayed at startup. This includes information such as - Last recording time, Current Time, Working Cameras, System Status.
Example HEALTH PAGE DISPLAY
SYSTEM HEALTH PAGE
             FRONT PANEL LED STATUS

LAST RECORDING
             10:05:21        15/05/09

CURRENT TIME

11:25:15        15/05/09
WORKING CAMERAS
             01  02  03  04

SYSTEM STATUS 

                          FINE
SPLASH SCREEN – Enable’s use of a .BMP file to be displayed, for example an Operator/Company logo. Can be set to 5, 10, 20, 30, 60 seconds, or Until Exit (which requires user interaction to clear). 

A tool can be provided on request to create the Splash Screen image in the correct format, from an input source. The input source should not be more than 1.5mb and should be a simple image with plain colours, approx 720x576. An example images is show below;

[image: image21.png]Timespace Technology

X200 SPLASH SCREEN TEST




Once in the correct format (using the Brigade conversion tool), the image is placed on the X200 cartridge, named; Splash.ext. Once configured in the menu, the Splash Screen will be read from the disk and displayed.

RECORDING SETTINGS – Accesses a sub-menu allowing control over recording mode, video standard and multiple/single camera optimisation.

MODEM LOOPBACK TEST - The modem loopback test checks that the internal X200 hardware is functioning correctly so that it can be successfully used with an external modem.  A special female 9-way D socket is required with pins 2 & 3 connected together and pins 1, 7 & 8 connected together.  This is connected to the male RS232 socket on the rear panel of the X200 before conducting the modem loopback test.  The RS232 connector is detailed in the Connector Specifications section of the X200 manual. To start the test press the right menu button.  If PASS is shown on the menu screen next to the MODEM LOOPBACK TEST then the internal hardware is functioning correctly. The hardware version (H/W VER) and serial number of the X200 are also shown at the bottom of the menu screen for reference.
Recording Settings Menu


 RECORDING SETTINGS

         
RECORDING MODE FOR:


    NORM / TIMER:
COND. REFRESH


    ALARM / SHOT:
FULL UPDATE


VIDEO STANDARD:

PAL

COLOUR DISCRIMINATION:
AUTO

The Recording Settings sub-menu allows the user to choose between single/multiple camera optimisation, recording modes and video standards. 
RECORDING MODE FOR:

NORM / TIMER : 

ALARM / SHOT :

COND. REFRESH / FULL UPDATE – The recording mode is selectable for normal and 

timer recording and also for alarm and shot recording.

Specify FULL UPDATE to record full image information or CONDITIONAL REFRESH to record only the parts of the image that have changed.

In most cases conditional refresh will be the preferred option as the file size on disk is 

reduced from that required for full update.

VIDEO STANDARD

PAL / NTSC – After moving the cursor down the Video Standard line, the user can use the cursor keys to select between PAL and NTSC.  Once the appropriate selection has been made the unit must be power-cycled before it comes into effect.  During the power up sequence, the X200 will briefly display the software version installed along with the configured video standard.


Please refer to the PAL / NTSC Switching section of this manual for further information about using the X200 in PAL and NTSC configurations.

· COLOUR DISCRIMINATION – The default setting of AUTO should normally be used.  The YES and NO settings may be used in particular cases if images from colour/B&W switching cameras need to have false colour images rejected.

Remote Settings Menu


                              REMOTE SETTINGS

         >
SEND SMS

NEVER


USING


MSG1    

EDIT MESSAGES

             IMAGE OVER GSM:


       PHONE NUMBER 1


       PHONE NUMBER 2


       SERVICE LOG:       YES



RS232:    GSM CONTROL


VIEW STATUS


SEND SMS NOW

SEND SMS: NEVER / MONTHLY / WEEKLY / DAILY / POWER UP –  Determines how of then the X200 will send the user defined SMS text message.  It is possible to select once per month, week, day or every time the X200 is power-cycled.

USING - Selects which SMS message will be sent as determined in the SEND SMS option.

EDIT MESSAGES - Enters the SMS MESSAGES sub-menu allowing the user to enter in up to 6 different SMS text messages.
IMAGE OVER GSM – Feature for transmitting an image from Camera1 to a PC (running ImageLink) using a GSM modem. Enter the mobile number to send Images over GSM (setup as an Alarm Input). A secondary number can be entered if the primary is engaged. A retry mechanism will dial number1, number2, number1, number2, with approximately 40 seconds between each retry. Number1 & Number2 can be the same number if required. By default if the transmission fails, the Service light will be illuminated and a Service log entry made (this can be turned off). See Alarm Input and LED output pages for detail. ImageLink PC application is included with PCLink Suite. See PCLink section for more details.
RS232 - When set to GSM CONTROL the RS232 serial port on the rear of the X200 can be connected to a suitable GSM modem and used in conjunction with RemoteLink PC software in order to remotely control the X200 recorder.  For further information on this please consult the GSM subsection of the Remote Operation section of this manual.  

The X200 recorder is also able to be externally controlled via the RS232 interface from 3rd party systems.  If this is the case then the appropriate Baud Rate for interfacing with the 3rd party system should be chosen.  For detailed application information on using the RS232 port to control the X200 and allow data transfer to and from a 3rd party system please refer to RS232 External Control sub-section of the Remote Operation section of this manual.

Please note that if this option is used and the GSM CONTROL option is not selected, then the X200 cannot to be used with a GSM modem and RemoteLink PC software. A GPS receiver cannot be connected to the X200 when external RS232 control is utilised as this device makes use of the same port and is not able to run concurrently.

VIEW STATUS - Enters the SMS STATUS sub-menu allowing the user to view statistics on the attached GSM modem.

SEND SMS NOW - Tests the GSM/SMS connection by sending a user defined message to the phone number entered into the SMS MESSAGES sub-menu.

SMS Messages Menu



                   SMS MESSAGES

          
MESSAGE

MSG1

PHONE NUMBER



MSG LINE 1


MSG LINE 2


MSG LINE 3


MSG LINE 4

EMBED GPS LOCATION
NO


EMBED GPS SPEED

NO

The SMS Messages sub-menu allows the user to specify the phone number for the SMS text message to be sent to and the contents of the SMS text messages. 

MESSAGE
Chooses between the 6 different available SMS text messages.

PHONE NUMBER

The number keys on the Reviewer are used to enter the phone number to which the SMS text message will be sent.  Do not leave any spaces in the phone number.

MSG LINE 1 / 2 / 3 / 4

The text to be sent is entered using the number keys 1-9 on the Reviewer; up to four lines of text can be entered.  Use the left and right menu buttons to move to the previous or next character on each line respectively.  Use the up and down menu buttons to move to the previous or next line of text respectively.

Key

Number/Characters

1

A B C 1 
(space)

2

D E F 2 
(space)

3

G H I  3 
(space)

4

J K L  4

(space)

5

M N O 5
(space)

6

P Q R 6

(space)

7

S T U 7 
(space)

8

V W X 8
(space)

9

Y Z 9 

(space)

0

0 

(space)

EMBED GPS LOCATION / SPEED

Allows the current GPS location and speed to be sent as part of the SMS text message if a GPS receiver is used with the X200.
SMS Status Menu


                                   SMS STATUS


LAST SMS SENT  
 :   
UNKNOWN

MODEM NOT AVAILABLE     

          
CALLS  RECV

000


SMS RECV

000


SMS SENT

000


SMS ERRORS

000


RESET MODEM

The SMS Status sub-menu provides information about a connected GSM modem.

· LAST SMS SENT

The date of the last SMS sent from the X200.

· MODEM IN AUTOANSWER MODE / MODEM NOT AVAILABLE

Shows whether a GSM Modem is attached and setup correctly in autoanswer mode.

· CALLS RECV

The number of calls received by the GSM Modem attached to the X200.

· SMS RECV

The number of SMS text messages received by the X200.

· SMS SENT

The number of SMS text messages sent by the X200.

· SMS ERRORS

The number of failures to send an SMS text message at the user defined intervals.

· RESET MODEM

Resends the setup commands to reset a connected GSM Modem.

G Sensor (Accelerometer)

                                   G SENSOR

      BRAKE                G

ACC

     G





LAT

     G

     UP

         G





     RESET ALARM
     GSENSOR SETUP

     RESET READINGS
RESET READINGS -  Clears all current readings within this hour.

RESET ALARM – Clears the alarm condition.

GSENSOR SETUP – Enters the GSensor Setup sub menu.

All captured data cant be reviewed and filtered using Brigade Electronics’s SafteyLink pc application, in conjunction with LANLink (see the SafetyLink section of the manual for further details).
BRAKE is the measurement of decreasing forward motion. 

ACC is the measurement of increasing forward motion.

LAT is the measurement of lateral movement.
UP is the measurement of upwards motion.

All measurements are in terms of G.
G Sensor Setup (Accelerometer)

                                   G SENSOR SETUP

       STATUS: DISCONNECTED

       GPS/GSENSOR BAUD RATE: >4800

       BRAKING: 1.0G

       ACCELERATING: 1.0G

       LATERAL: 1.0G

       UP: 1.0G

       ALARM INPUTS MENU …

       ALARM OUTPUT MENU …

       RESET ALARM CONDITION

BAUD RATE – The GSensor requires 19200bps and if a GPS is connected as well it must be able to support and be programmed to operate at 19200 as well, for example the Garmin GPS16 LVS.
THRESHOLD TRIGGERS – Braking, Accelerating, Lateral and UP. Can be set from 0.1 – 2.0.

ALARM INPUTS MENU – An alarm input can be configured to reset the GSensor alarm.

ALARM OUTPUT MENU – An alarm output can be configured based on the GSensor thresholds.

RESET ALARM – Clears the alarm condition.

Reset System Menu

       RESET SYSTEM

          >
DELETE ALL RECORDING FILES 


SECURE DISK WIPE
RESET MENU TO FACTORY  


DEFAULT STATE

MENU LANGUAGE:
ENGLISH

· DELETE ALL RECORDING FILES – Removes all recordings from the hard disk including write-protected files.  Only do this if you want to completely remove all recordings from the hard drive as there is no undo option.  Press the right menu button to go to a warning screen, pressing the right menu button again will carry out this action whilst pressing the MENU EXIT button will abort this procedure.
· SECURE DISK WIPE – Permanently deletes all recordings on the Hard Disk Cartridge.  This option should only be used if all recording files should be completely destroyed as no files will be able to be recovered.
· RESET MENU TO FACTORY DEFAULT STATE – Pressing the right or left menu button will immediately reset the entire X200 menu system to its default settings.  Please note that there is no undo option.  
· MENU LANGUAGE – Sets the language that the menu is displayed in.  
Brigade Electronics can provide a language template file which the user can translate and return to Brigade Electronics for incorporation into the X200 software.  This will allow all text displayed on the X201 Reviewer to be in the users preferred language. 

When another language is selected in the Reset System Menu the X200 will have to be power cycled before the new language settings will take effect.

Normal Recording Menu


   NORMAL RECORDING

       CAMERAS 
IMAGES / SEC
      RESOLUTION


1   TO    4       >
5


HIGH


2   TO    16
NO RECORDING
LOW

        AUDIO:  OFF

        RECORD ALL SPECIFIED CAMERAS

  COL   B&W     01   02   03   04   05   06   07   08


             09   10   11   12   13   14   15   16
        20 IMAGES / SEC OUT OF 25 MAX

This menu sets the images per second and image resolution recorded by each camera during normal recording.

CAMERAS – Use the up and down menu buttons to move between items in the menu.  Pressing the right and left menu buttons next to a camera group will increase or decrease the number of cameras in that group respectively.

Please note that this applies to the X200-16.  The X200-04 lists each of the 4 cameras separately.

IMAGES / SEC - NO RECORDING / 0.1 / 0.2 / 0.3 / 0.4 / 0.5 / 0.6 / 0.7 / 0.8 / 0.9 / 1.0 / 1.2 / 1.5 / 2.0 / 2.5 / 3.0 / 4.0 / 5.0 / 6.0 / 7.0 / 8.0 / 9.0 / 10 / 12 / 15 / 20 / 25 / MAX RATE- 
This sets the number of images per second to be recorded by a camera during normal recording up to a total of 25 images per second for all cameras added together.  If MAX RATE is selected then the X200 will automatically adjust the images per second for each of the specified cameras so that the total is equal to 25 images per second.

RESOLUTION – This can be set to: 
LOW – This sets the highest level of compression.  Although file sizes will be comparatively 

small, visible blocking artefacts may be seen.

MEDIUM – This sets the medium compression level, images with little loss of quality which 

will be adequate for most applications.

HIGH – This sets a medium-low level of compression with gains in image quality over medium resolution but with larger file sizes.

V.HIGH – This sets a low level of compression with gains in image quality over high resolution but with larger file sizes.

VV.HIGH – This sets the lowest level of compression with the best image quality but the largest file sizes.

AUDIO – Specifies whether audio is enabled (ON) or disabled (OFF) for this mode of recording.
RECORD ALL SPECIFIED CAMERAS

ONLY RECORD CONNECTED CAMERAS

This sets whether the X200 will record on all cameras specified in the recording parameters shown at the top of the menu screen or whether the X200 will only record on connected cameras shown as highlighted on the connected camera list 01 – 16 at the bottom of the menu screen (01 – 04 on the X200-04).

COL B&W 01 02 03 04 05 06 07 08 09 10 11 12 13 14 15 16 - The connected camera list highlights all connected cameras in either red or white to indicate that either a colour (red highlight) or black and white (white highlight) camera is connected to the corresponding input number.

X IMAGES / SEC OUT OF 25 MAX – This displays how many images per second will be recorded during normal recording out of the X200 25 images per second maximum limit.  Although less than 25 images per second can be recorded, the X200 is not able to record more than 25 images per second.
If the maximum of 25 images per second is exceeded by the sum of all the cameras then the X IMAGES / SEC OUT OF 25 MAX text will change to red as a warning.  If this is not corrected then the X200 will still record but it will automatically adjust the images per second for each camera so that the total does not exceed 25.
In the example menu screen shown above cameras 1 – 4 have been set to 5 images per second.  This gives a total sum of 20 images per second out of the available 25.

Timer Recording Menu


     TIMER RECORDING

       CAMERAS 
IMAGES / SEC
      RESOLUTION


1   TO    4       >
5


HIGH


2   TO    16
NO RECORDING
LOW

      START / STOP  TIMES  .  .          AUDIO:  OFF
      WHEN   TIMER   STOPS :           STOP REC.

      20 IMAGES / SEC OUT OF 25 MAX

This menu sets the images per second and image resolution recorded by each camera during timer recording.  Preference for times of recording and dates to be excluded can also be set in the ‘timer recording times’ sub-menu accessible from this menu.

Use the up and down menu buttons to move between images per second and resolution for each camera and the left and right menu buttons to scroll between the options.  Pressing the right menu button next to SET TIMER START / STOP TIMES accesses the timer recording times sub-menu.

CAMERAS – Use the up and down menu buttons to move between items in the menu.  Pressing the right and left menu buttons next to a camera group will increase or decrease the number of cameras in that group respectively.

Please note that this applies to the X200-16.  The X200-04 lists each of the 4 cameras separately.

IMAGES / SEC – These settings are the same as described in the normal recording menu, except they apply only during timer recording.

RESOLUTION – These settings are the same as described in the normal recording menu, except they apply only during timer recording.

SET TIMER START / STOP TIMES - Pressing the right menu button nest accesses the timer recording times sub-menu described on the next page.

AUDIO – Specifies whether audio is enabled (ON) or disabled (OFF) for this mode of recording.

WHEN TIMER STOPS – Pressing the left or right menu buttons chooses between STOP REC. and NORMAL REC.  This option decides whether the X200 will stop recording when the defined timer recording period has ended (STOP REC.) or whether it will continue recording in normal recording mode (NORMAL REC.).

X IMAGES / SEC OUT OF 25 MAX – This displays how many images per second will be recorded during timer recording out of the X200 25 images per second maximum limit.  This display is the same as found in the normal recording menu, except it applies only during timer recording.

Timer Recording Times Menu


TIMER RECORDING TIMES

          >
IGNORE DAILY TIMES 


MON
08:15
TO
17:00
COPY


TUE
08:15
TO
17:00
DOWN


WED
08:15
TO
17:00


THU
08:15
TO
17:00


FRI
08:15
TO
17:00


SAT
00:00
TO
00:00


SUN
00:00
TO
00:00


IGNORE PERIOD TIMES 


FROM :
00:00

00 / 00 / 00


TO :
00:00

00 / 00 / 00

The timer recording times menu sets the times that will be included or excluded for timer recording.  A period of exemption/inclusion can also be set by date.  This menu is a sub-menu of the timer recording menu and is accessed by pressing the right menu button next to the SET TIMER START / STOP TIMES option in the timer recording menu.

· IGNORE DAILY TIMES 

RECORD BETWEEN DAILY TIMES 

RECORD OUTSIDE DAILY TIMES 

Use the right and left menu buttons to scroll between the available options.  The default setting IGNORE DAILY TIMES disables timer recording, the setting RECORD BETWEEN DAILY TIMES will mean that timer recording will automatically take place between the start (left hand time column) and end times (right hand time column).  The setting RECORD OUTSIDE DAILY TIMES does exactly the opposite with timer recording automatically taking place outside of the specified times.

Setting the daily times and using the COPY DOWN function.

Use the up and down menu buttons to move the arrow cursor up and down the list of start and end times for each day.  When the cursor is next to a particular start / end time use the numbered keys on the X201 reviewer to enter a time in 24hr clock format.  Please note that 4 digits must always be entered so single digit hour times such as 8am must be entered as 08:00 as per the normal 24hr clock.  To exclude any particular day from timer recording simply type in 00:00 for both times as per SAT and SUN in the example above.

The COPY DOWN function allows the current times set for MON to be copied to all other days on the list.  This avoids unnecessary repetition when entering timing periods where daily recording times are the same.  Once the times for MON have been copied to all other days they may be individually changed as per normal.  For instance in the above example the times for MON - 08:15 TO 17:00 – were copied to all other days using the COPY DOWN function and then SAT and SUN were individually set to 00:00 to exclude them from timer recording.

· IGNORE PERIOD TIMES
RECORD INSIDE PERIOD

RECORD OUTSIDE PERIOD 

This enables the user to set a period of time, by time and date which is to be excluded/included from the daily timer recording parameters.  Use the menu up and down buttons to move between the times and dates and enter the time or date using the number keys.  The time is in 24hr clock format and the date is in the format DD/MM/YY.

Examples of Timer Recording
The daily times and period times are able to work together or independently to record as and when required.  For example - 
Recording Monday to Friday from 9am to 5pm.

Select RECORD BETWEEN DAILY TIMES and set the daily times on Monday to Friday from 

09:00 TO 17:00 and Saturday and Sunday to 00:00 TO 00:00.  Select IGNORE PERIOD 

TIMES to disable the calendar period function.

Recording Monday to Friday from 9am to 5pm but not in the month of June in 2004.

Select RECORD BETWEEN DAILY TIMES and set the daily times on Monday to Friday from 

09:00 TO 17:00 and Saturday and Sunday to 00:00 TO 00:00.  Select RECORD OUTSIDE PERIOD  in the calendar period function and set the FROM and TO as 00:00 01/06/04 and 00:00 30/06/04 respectively.  This will prevent recoding from midnight on the first of June to midnight on the 30th of June 2004.

Recording continuously for 3 weeks starting at 7am on the 21st of August 2004.

Select IGNORE DAILY TIMES to disable the daily recording times (this is necessary as recording is to take place for 24hours a day during the calendar period).  Select RECORD INSIDE PERIOD and set the FROM and TO as 07:00 21/08/04 and 07:00 11/09/04 respectively.
Shot Recording Menu


     SHOT RECORDING

          
CAMERAS :

          >
ALARM IN MENU


RESOLUTION :


LOW


NUMBER OF SHOTS :

1


IMAGES / SEC :

1.0

Shot recording allows a defined number of shots (images) to be recorded from an alarm input trigger.

· CAMERAS – This takes the user to the alarm inputs menu in which they can which alarm inputs will be used as a trigger for shot recording and from which cameras to record images.  Please see the section on the alarm inputs menu for a detailed description of the available settings.

RESOLUTION - These settings are the same as described in the normal recording menu, except they apply only during shot recording.
NUMBER OF SHOTS 
1 / 2 / 3 / 4 / 5 / 8 / 10  / 15 / 20 / 25 / 30 / 50 / 100 / 150 / 250 / 500 – This sets the number of shots to be taken from each camera during shot recording.  Use the left and right menu buttons to scroll from between 1 to 500 shots.

· IMAGES / SEC – These settings are the same as described in the normal recording menu, except they apply only during shot recording.
Audio Recording Menu


     AUDIO RECORDING


AUDIO WITH NORMAL RECORD:  OFF


AUDIO WITH TIMER RECORD:
  OFF


AUDIO WITH ALARM RECORD:  OFF


CHANNELS:
          >
STEREO

SAMPLING RATE :

16 kHz 

SAMPLING RESOLUTION : 
16 BITS

RECORD INPUT RANGE :
1.00 Vrms

INPUT 1 LEVEL :
NOT RECORDING

INPUT 2 LEVEL :
NOT RECORDING
PLAYBACK VOLUME :

HIGH

CHANNELS – Selects whether the X200 records audio from a single MONO – left channel (input 1) only, or both STEREO audio inputs.
SAMPLING RATE – Selects an audio sampling rate of 16 kHz or 8kHz
SAMPLING RESOLUTION – Selects a sampling resolution of 16 bits or 8 bits.

RECORD INPUT RANGE

0.12 Vrms / 0.25 Vrms / 0.50 Vrms / 1.00 Vrms / 2.00 Vrms – This defines the maximum signal that can be accommodated before clipping occurs.  If distortion due to clipping is experienced, increase the audio input range.  For good noise performance reduce the audio input range until clipping is experienced and then increase the range by one increment.
INPUT 1 LEVEL

INPUT 2 LEVEL

This gives an indication of current audio input level for each channel whilst recording and will be of use when setting the record input range.  The level is given in both dB and as a percentage of the maximum input level before clipping.  NOT RECORDING will be shown if the X200 is not currently recording.
PLAYBACK VOLUME

LOW / MEDIUM / HIGH / FULL / MUTE – Select the volume level for audio play back via 

the X201 Reviewer and the line-level output on the rear of the X200.
Motion Detection Menu


  MOTION DETECTION
CAMERA SETUP   .  .  .

MASK VIEW / EDIT   .  .  .

ARMING DELAY


OFF

POST – TRIGGER RECORDING:
5 SEC
NORMAL RECORDING:

NO

TIMER RECORDING:


NO

SHOT RECORDING:


NO

ALARM RECORDING:


NO

LINKED NORMAL/ALARM:                   NO
SMS MESSAGE:


NONE
The motion detection menu allows the user to define areas of each camera view to be included or excluded from motion detection.  A threshold and event count can be set for each camera view in order to control which types of events trigger motion detection recording.

Motion detection can be used to trigger all modes of recording (normal, timer, alarm and shot).

CAMERA SETUP – Enters the camera setup menu, please refer to the camera setup menu section of this manual for detailed information on this menu.

MASK VIEW / EDIT – Displays the currently selected camera view and allows the user to define areas that are to be included or excluded from motion detection.

To select the camera view in question press the relevant camera number key to select that camera.  The currently selected camera number key will be lit.

DEFINE THE AREA OF MOTION
Stop key is used to toggle between;

· inclusive (green box)

· exclusive (red box)

· bar graph view/set the current threshold and count levels
Rewind key shrinks the selected area vertically

Fast forward key expands vertically

Play backwards key shrinks horizontally 
Play forwards key expands horizontally.  
Once the selection area is of the correct size. Pressing the 0 key will activate the selection area for inclusive/exclusive detection. **This must be done if you are including areas**
Multiple areas can be defined. 

Excluded areas are greyed out.  By default when the camera view is first selected for masking the entire view is greyed out and is therefore not included in motion detection.

The bar graph displayed by pressing the stop key sets the amount of the included area which needs to change before motion detection recording is activated.  This ranges from 0 -25 and is set by using the up and down menu arrow keys.  The bar graph is divided into two vertical columns.  The left hand column shows a green marker which is the selected threshold level for the current camera view.  The right column is the current level of detected motion and can be used as a guide for setting the threshold level.

Some experimentation may be required to determine the optimum threshold level for any given camera view and situation.  For example it may be necessary to raise the threshold level in instances where small objects such as cats are triggering motion detection recording and the user is only interested in human sized objects.

ARMING DELAY – This can be set from instantaneous (OFF) to up to 5 minutes in order to allow the user to vacate the detected area before the system becomes active.  This may help to avoid unwanted footage of the user being recorded whilst they are vacating the detected area.

POST – TRIGGER RECORDING – This can be set from 5 seconds to up to 2 hours and will determine the amount of time that recording will take place for after a motion event has ceased.

NORMAL RECORDING:

TIMER RECORDING:
SHOT RECORDING:
ALARM RECORDING:

If set to NO then the detection of motion will not trigger that mode of recording.  If set to YES then motion detection will commence the specified mode of recording when motion is detected.

Motion detection will not interfere with the normal operation of any recording mode as specified in the other X200 menus if set to NO.

To activate motion detection once setup is complete, press the record button on the reviewer.  If no other recording is taking place and motion has not yet been detected, the record light will flash to indicate that motion detection is active, but not currently recording.

LINKED NORMAL/ALARM – This allows the X200 motion to change the recording type. For example you could be recording using Normal record on 1 cam @ 2 IPS, then when motion is detected the X200 can change to Alarm recording on 4 cameras  @ MAX RATE. An Alarm input must be set when using this mode. 

SMS MESSAGE – On a motion detection, trigger and SMS to be sent.

Camera Setup Menu


  MOTION DETECTION
CAM
DETECT
THRESHOLD
COUNT

1
   OFF

        0

       1

2
   OFF

        0

       1

3
   OFF

        0                       1

4
   OFF                        0                       1

CAM – Lists the camera number in question.

DETECT – If set to OFF this camera will not be subject to motion detection control.  If set to ON the camera will be subject to motion detection control.

If for example normal recording is set to record on cameras 1 – 4 and is selected as ON in the motion detection menu, but cameras 3 and 4 are set to OFF and 1 and 2 set to ON in the DETECT setting, then normal recording will be constant on cameras 3 and 4 when normal recording is activated.  Cameras 1 and 2 will only record when motion detection is triggered and will record for the duration of the motion event or for a set time afterwards if a post-trigger recording time has been set.

If any individual camera is set to OFF then even if the recording mode is set to ON in the motion detection menu it will not be controlled by motion detection and will record as per normal and as specified in the relevant X200 menu settings.

THRESHOLD – Sets the level of image change for the selected camera area which will trigger motion detection recording.  The range is from 0 (very little change) to 25 (major image change).

COUNT – Sets the concurrent number of frames for which the threshold of image change must have been exceeded before motion detection will be activated.  If the count is set to 1 then only one frame will have to have exceeded the threshold for image change before motion detection is activated.  If set to 10 (maximum) then 10 concurrent frames will have had to have exceeded the set threshold before motion detection is activated.

This allows short duration events to be filtered out and not trigger motion detection recording if required.
Alarm Recording Menu


     ALARM RECORDING

  CAMERAS
IMAGES / SEC

RESOLUTION

   1   TO   3     >
3


MEDIUM

   4   TO   16
NO RECORDING
LOW

  ALARM INPUTS MENU   . . . 

  AUDIO:   OFF

  PRE – TRIG WRITE PROTECT:
OFF

  POST – TRIGGER RECORDING : 
OFF

Camera groups for alarm recording can be created, the number of images per second and resolution of recording can be set for each group.

CAMERAS – Use the up and down menu buttons to move between items in the menu.  Pressing the right and left menu buttons next to a camera group will increase or decrease the number of cameras in that group respectively.

Please note that this applies to the X200-16.  The X200-04 lists each of the 4 cameras separately.

IMAGES / SEC – These settings are the same as described in the normal recording menu, except they apply only during timer recording.

RESOLUTION – These settings are the same as described in the normal recording menu, except they apply only during alarm recording.

ALARM INPUTS MENU – Pressing the right menu button enters the Alarm Inputs sub-menu.

AUDIO – Specifies whether audio is enabled (ON) or disabled (OFF) for this mode of recording.

PRE – TRIG WRITE PROTECT - OFF /  1 MIN / 2 MINS / 5 MINS / 10 MINS / 20 MINS / 30 MINS / 1 HOUR / 2 HOURS – All files recorded in the specified period before the alarm event are write protected (so they will not be overwritten during loop recording).

POST – TRIGGER RECORDING - OFF / 5 SECS / 10 SECS / 20 SECS / 30 SECS / 45 SECS / 1 MIN / 5 MINS / 10 MINS / 20 MINS / 30 MINS / 45 MINS / 1 HOUR / 2 HOURS – Alarm recording can take place only for the duration of an alarm event (OFF) or can continue for a specified period of time after the event has ceased.

Therefore if an alarm input is only likely to be a momentary event but the ten minutes after that event are also important select 10 MINS for post trigger recording.
Alarm Inputs Menu

        ALARM INPUTS

  IN
ACTIVE
FUNCTION

CAMS

  1      >
CLOSED
NONE




  2
CLOSED
NONE

  3
CLOSED
NONE

  4
CLOSED
NONE

  EMBED ALARM STATE MENU
  CURRENT STATE :

CLOSED / OPEN


1

2

3

4

The Alarm Inputs menu defines what the X200 will do when the 4 alarm inputs are either in a closed or open state.  Closed is defined as a connection to the ‘-‘ terminal of the X200 input/output connector, whilst open indicates that no contact is being made.  The 4 inputs are listed in order as shown in the screen shot above, for each of the 4 inputs the following options are available.

ACTIVE – Use the left and right menu buttons to toggle between CLOSED and OPEN.  This sets the state which triggers an alarm event and will cause the defined action to take place.

FUNCTION – This defines the action of the X200 when the selected alarm input is active.

NONE – No action.

NORM REC – Switches normal recording on and off instead of the X201 record button.

ALARM REC – Sets the X200 to do alarm recording with the settings for images per second and resolution as defined in the Alarm Recording Menu.  The cameras to be recorded can be set in the right hand CAMS column by pressing the right and left menu buttons to raise or lower the current number respectively.  In this way an alarm input can trigger recording on a single or a group or cameras.  Multiple alarm input triggers will cause camera ranges to be combined.

SHOT REC – Sets the X200 to do shot recording with the settings defined in the Shot Recording Menu.  As per ALARM REC a single or group of cameras can be specified.

SWITCHER – Sets the X200 video switcher to view the selected camera for the duration of an alarm event (plus post trigger time if selected).  Change the desired camera to be viewed during an alarm event using the right and left menu buttons to change the camera number in the CAMS column. 

SWITCHER 2 (X200-16 Only) – Sets the X200 video switcher2 to view the selected camera for the duration of an alarm event (plus post trigger time if selected).  Change the desired camera to be viewed during an alarm event using the right and left menu buttons to change the camera number in the CAMS column.

TIMER REC – Sets the X200 to timer recording as per the settings in the Timer Recording Menu.

SMS MSG 1, 2, 3, 4, 5, 6 – Sets the X200 to send one of the user defined SMS text messages if a GSM modem is attached.
GSEN RESET – Resets the GSensor alarm condition.

HEALTH PAGE – Displays the X200 health page for the duration of the alarm.

C1: IMG->GSM – Initiate transfer of Camera1 image over GSM using setting in the REMOTE SETTINGS menu. Feature can be used with an LED output, see ALARM OUTPUT/LEDs for details. Alarm inputs 1-4 can be used to identify different events, however the image will be take from Camera1.
EMBED ALARM STATE MENU – Jumps to the EMBED ALARM STATE MENU

CURRENT STATE – Shows the current OPEN / CLOSED state of each of the 4 alarm inputs.  The corresponding number for each alarm input will be highlighted for CLOSED and not highlighted for OPEN.
Embed Alarm State Menu


                     EMBED ALARM INPUT STATE
  ALARM IN

EMBED
TEXT
  
1

YES

LEFT


2

YES

RIGHT


3

YES

BRAKE


4

NO

  POSITION:

TOP

The Embed Alarm State menu allows embedded text to be shown as part of recorded images whilst the corresponding alarm input is active.

The alarm inputs active state (closed or open) is set from the Alarm Inputs menu.  When active the user defined text is shown in the images at the position designated (top or bottom).  The text will be embedded on all camera views simultaneously and will appear on all selected cameras during playback in PCLink200.

The 4 alarm inputs are listed in order as shown in the screen shot above, for each of the 4 inputs the following options are available.

EMBED – Determines whether the text is embedded in the recorded images when the corresponding alarm input is active.

TEXT – Up to 8 characters can be entered in this field to be embedded in the recorded images when the corresponding alarm input is active.  The text is entered using the numbered keys on the X201 Reviewer as per the Camera Text menu.

POSITION - TOP embeds the text across the top edge of the recorded images and BOTTOM embeds the text at the bottom of the recorded images above the timestamp and GPS information if these options are active.

Alarm Output / LEDs Menu


   ALARM OUTPUT / LEDs

  LED1 OUTPUT :                                 >
RECORD

  LED2 OUTPUT :

        
OFF

  ALARM OUTPUT :

          >
CLOSED
  




WHEN  . . .

This menu sets the conditions for the external LED outputs and alarm output.

LED1 OUTPUT 

LED2 OUTPUT

OFF / FAIL / SERVICE / RECORD / ON / FOCUS / LAN ACTIVE / GSENSOR – The LED outputs can be set to be permanently off or on or to duplicate the state or the fail, service or record LED’s on the front panel of the X200.  They can also be used to activate a suitable buzzer circuit during camera focussing.

IMG->GSM – When the Image Transfer feature is triggered, the LED output will turn on during the dialling process, flash during data transmission and turn off when complete/ready for next transmission. The only addition to this is that the Service LED will illuminate on a failed transmission (after the re-try process). See REMOTE SETTINGS and ALARM INPUT for further details.
ALARM OUTPUT – CLOSED/OPEN WHEN…  This determines whether the X200 alarm output goes closed or open when any of the conditions set in the Alarm Output When sub-menu are met.  To access the sub menu press the right menu button next to WHEN…

Alarm Output When Menu


ALARM OUTPUT WHEN….
  FRONT LEDS:



NO

  CAMERA DISCONNECTED:


NO

  HARD DISK WRITE PROTECT:

NO

  HARD DISK FULL:



NO

  ALARM OCCURRED:



NO

  MOTION DETECTED:



NO

  CAMERA FOCUSING:


NO

  LAN TRANSFER ACTIVE:


NO

  G SENSOR THRESHOLD TRIG

NO

This menu sets the condition for the alarm output. 
FRONT LEDS – Can be set to NO / SERVICE / RECORD to make the alarm output active if either the service or record LED’s are lit on the X200 front panel.

CAMERA DISCONNECTED – When set to YES the alarm output is activated when a camera is disconnected from the X200 whilst recording on that camera.  The alarm output will become inactive 5 seconds after the camera is reconnected.

HARD DISK WRITE PROTECT – If all the disk is write protected then recording will stop.  To give the user warning the alarm output can be used to signal when the disk is either 25% / 50% / 60% / 70% / 80% / 90% / 100% write protected.

HARD DISK FULL – If all of the disk is full and single pass recording has been enabled then recording will stop.  To give the user warning the alarm output can be used to signal when the disk is either 25% / 50% / 60% / 70% / 80% / 90% / 100% full.

ALARM OCCURRED – When set to YES the alarm output is activated when an alarm event has occurred.  A battery and sounder may be connected to the alarm output terminals so that the user is audibly informed of any new alarm event.  The alarm condition is cleared when the triggering condition has cleared.

MOTION DETECTED – When set to YES the alarm output is activated when motion is detected and motion recording has started.

CAMERA FOCUSING – When set to YES activates the alarm output for a short duration when the focus improves whilst camera focusing is activated in the CAMERA OPTIONS menu.  Please refer to this menu for more detailed information on this process.

LAN TRANSFER ACTIVE – Allows the X200 alarm output to be open or closed whilst files are being transferred via the LAN interface.  This may be useful in order to latch a timed power supply in order to prevent power loss to the X200 during transfer.

GSENSOR THRESHOLD TRIG – Alarm OUT is activated when the G Sensor threshold trigger level is reached.
Video Switcher 1 Menu


      VIDEO SWITCHER 1
  CAMERA


DWELL TIME

  
1   TO   4
         >
1  SEC




  
5   TO   16

SKIP
  MULTI CAMERA

SKIP

  TIME POSITION

NO TIMESTAMP

  MULTI CAMERA SETUP . . . 

  MULTI CAMERA VIEW . . .
The video switcher 1 menu controls the automatic switching of cameras on the main video output when the unit is in AUTO mode (selected by pressing the AUTO key on the X201 Reviewer).  On the X201 the number key LED is illuminated for the camera shown (1-8 number keys for cameras 1-8 with the addition of the 9-16 LED lit for cameras 9 – 16) and the live picture is viewable on the monitor.

Multi Camera view allows the simultaneous viewing of a number of camera views on the same image and can be included in the switching sequence as per any single camera view.

CAMERAS – Use the up and down menu buttons to move between items in the menu.  Pressing the right and left menu buttons next to a camera group will increase or decrease the number of cameras in that group respectively.

Please note that this applies to the X200-16.  The X200-04 lists each of the 4 cameras separately.

DWELL TIME – The dwell time can be set from 1 – 30 seconds by using the right and left menu buttons to scroll through the options.  Dwell time is how long the switcher will stay on a camera before moving to the next camera.  If a camera or group of cameras does not need to be included in the switcher set this option to SKIP.

MULTI CAMERA SETUP – This enters a sub-menu allowing the user to select which cameras are to be displayed simultaneously.  Use the up and down menu keys to select the portion of the multi camera screen and the left and right menu buttons to select the required camera number.  The Menu Exit key will exit the sub-menu and return the user to the Video Switcher menu.  If the timestamp is selected in the TIME POSITION option then it must be noted that this will take up the space of one of the camera views in multi camera view.

MULTI CAMERA VIEW – Displays the multi camera view as per the current settings.  Press the Menu Exit key to return to the Video Switcher menu.

*NOTE – Configure the TIME POSITION for your specific output device. The view on the reviewer may not necessarily be the same as the output device. 

Video Switcher 2 Menu (X200-16 Only)


      VIDEO SWITCHER 2
  CAMERA


DWELL TIME

  
1   TO   4
         >
1  SEC




  
5   TO   16

SKIP

The video switcher 2 menu controls the automatic switching of cameras on the switcher video output (X200-16 Only) when the unit is in AUTO mode (selected by pressing the AUTO key on the X201 Reviewer).  On the X201 the number key LED is illuminated for the camera shown (1-8 number keys for cameras 1-8 with the addition of the 9-16 LED lit for cameras 9 – 16) and the live picture is viewable on the monitor.

CAMERAS – Use the up and down menu buttons to move between items in the menu.  Pressing the right and left menu buttons next to a camera group will increase or decrease the number of cameras in that group respectively.

DWELL TIME – The dwell time can be set from 1 – 30 seconds by using the right and left menu buttons to scroll through the options.  Dwell time is how long the switcher will stay on a camera before moving to the next camera.  If a camera or group of cameras does not need to be included in the switcher set this option to SKIP.

Hard Disk Cartridge

The use of Hard Disk Cartridges other than those supplied by Brigade Electronics will invalidate the warranty of the X200 recorder, and will constitute a breach of the X200 operating software copyright.
The X200 records onto a 2.5" IDE hard disk contained in a cartridge.  This cartridge is removable and can be swapped between X200’s.

The cartridge contains custom electronics.  Only T401-series Hard Disk Cartridges can be used with the X200.

The cartridge is connected to a PC for accessing and archiving files using the USB Interface Kit.  Please refer to the section on the USB Interface Kit for detailed instructions.

WARNING: Hard Disk Cartridges are sensitive to shock, vibration and humidity and must be used within operating temperature range as detailed in X200 specification.
X201 Reviewer


Function

The X201 Reviewer is used to program the menu settings on X200 and to review recordings on the installed Hard Disk Cartridge.

Connect Data Link Cable (supplied with X201 Reviewer) from socket marked "Reviewer" on X200 to socket marked "Recorder" on X201. This connection provides power, video and audio from X200 to X201.

When power (12V ±1.2V) is applied to the X200 and fed to the reviewer via the Data Link Cable the red LED on the bottom panel of the reviewer is illuminated.

The X200 display will be shown on the X201 monitor.

Press the buttons on the X201 to control the X200.

WARNING: When X201 is connected to X200 the power supplied to the X200 must be 12V+/-1.2V.

The X201 has 5 picture adjustment pots situated at the bottom of the left-hand side of the reviewer; these should not under most circumstances need adjusting from the factory settings.  If however an adjustment is necessary then please ensure that an appropriate plastic trimmer tool is used in a gentle manner.

These 5 picture adjustment pots are classified as follows.

i)

NTSC Tint (colour balance when using an NTSC feed)

ii)
Colour

iii)
Brightness

iv)
Contrast

v)
Sharpness (image pixel sharpness/smoothness adjustment)


Controls

The keys on the X201 can be grouped into Menu Navigation, Playback & Recording, Camera Switcher and Search & Help.

Menu Navigation


Press any of the 4 menu buttons to enter the main menu.  Once in the menu system, their function is as follows:

Move arrow cursor to the previous item.

Move arrow cursor to the next item.

If the arrow cursor is currently at a menu selection,

(e.g.  RESOLUTION: > HIGH), 
pressing the left button will cycle the value backwards, 


    (e.g. to  RESOLUTION: > MEDIUM), 

If the arrow cursor is currently at a menu selection 

(e.g.  RESOLUTION: > LOW), 

pressing the right button will cycle the value forwards,

(e.g. to  RESOLUTION: > MEDIUM).

If the arrow cursor is currently at a sub-menu title

(e.g.  > OTHER OPTIONS).

pressing the right button will enter this sub-menu.

The MENU EXIT Key on the X201 reviewer will exit the current menu and move back up 1 level in the menu system when pressed.  If already at the top level of the menu pressing this key will exit the menu system completely and return to the video switcher.

Once in the menu system the numbered keys are used for inputting data into fields which require a user entry such as times and dates.


Playback & Recording 


Rewind through recorded footage.  Repeated presses increase the rewind speed in multiples of 1 second, up to a maximum of 20.
Reverse-play through recordings. 

Stop playback. If playback is already stopped, pressing this button again lights the LED above and the unit is in Jog mode, allowing image-by-image playback. Whilst in jog mode, the Rewind and Fast Forward buttons will skip to next/previous file.
Play recorded footage. 

Fast-forward through recorded footage. Similarly to rewind, repeated presses of the fast forward enable rapid scan.
Record start or stop. If not currently recording (red LED off), pressing this button will begin recording from the end of the most recent footage. If the unit is currently recording (red LED on), this button will stop recording. 

When pressing the control keys above, an on-screen display (OSD) will show each action. The OSD times out after 5 seconds. It will also display when switching between files, indicating which mode is being used. Modes displayed are;

Play – normal play
Replay – play backwards

Stop

Pause

Jog

Rewind

Wind – fast forward

Camera Switcher 


1-8
Switch the view to camera 1 to 8.  When playing back recorded footage, pressing buttons 1 to 8 changes playback to that camera.  If the AUTO LED is lit, buttons 1 to 8 change the live camera being viewed.  This camera is held on the main monitor.

9-16
Press this button before pressing the number buttons 1-8 to access cameras 9-16 on the X200-16.

AUTO
Activate the auto switcher mode. In this mode, the monitor will show a live view and the cameras are cycled as specified in the "Video Switcher" menu.  Press the AUTO button again to deactivate the auto switcher mode. If any of the buttons numbered 1-8 (or 9-16) are pressed while in auto switcher mode, the camera switching is stopped, and the selected camera view is held on screen.

Control of the auto switcher does not affect any recording in progress.

Search & Help 


HELP
Applies when using any menu. Pressing this button will produce a help screen. Continue pressing any key to cycle through help screens until menu returns.

SEARCH
Go to a specific time and date in the recorded footage. Pressing this button will enter the PLAYBACK SEARCH screen as seen below. If the footage on a given camera cannot be found (it may not have been recorded), a "NO FOOTAGE FOR SELECTED CAMERA" message will be displayed.  


     PLAYBACK SEARCH

          
TIME :  

00 : 00


DATE :

00 / 00 / 00


PLAY FROM SET TIME DATE


PLAY OLDEST


PLAY NEWEST


PRESS MENU EXIT TO EXIT MENU

TIME – Use the number keys to enter a time in 24hr format.
DATE – Use the number keys to enter a date in the format DD/MM/YY.
· PLAY FROM SET TIME DATE – Plays the footage beginning from the time and date entered. If there is no footage at the time specified a jump is made to the nearest footage to the time given.

PLAY OLDEST – Plays the oldest available footage on the Hard Disk Cartridge.

PLAY NEWEST – Plays the most recent footage available on the Hard Disk Cartridge.

Audio

The X201 Reviewer can also be used for audio playback through its built in speaker.  It must be noted that at present playback via the X201 is in mono via channel 1 only.  

The audio signal from the X200 is transferred along with the video signal via the reviewer cable to the X201.  No other cabling is required.

The speaker is located on the rear panel of the X201 reviewer and a headphone output jack is located on the bottom panel.  Volume can be controlled via a trimmer pot located next to the headphone output jack.  Very little force and the correct trimmer tool must be used with the volume control to avoid possible damage to the trimmer pot.

USB INTERFACE KIT

The purchase of USB Kit T503/505-USB includes the necessary licence for use of PCLink Suite software including free of charge updates.  Brigade Electronics does not authorise the unlicensed usage of PCLink Suite software.

Transferring Files to PC

The USB Interface Kit provides all hardware and software necessary to review and archive recordings on a PC from a Hard Disk Cartridge when it has been removed from the X200 Digital Recorder.

No additional device drivers are required for the USB Interface Kit when using Windows 2000, XP or Vista.  Additional device drivers which can be obtained separately from Brigade Electronics will need to be installed if using Windows 98 or Millennium.  The USB interface is not compatible with Windows 95 or NT.
Kit Contents
1x USB / IDE Interface Lead

1x T401-PSU Mains to 5VDC Power Adaptor

1x PCLink200 Software CD
1x X200 Manual CD (Word document)
Connecting to a PC using the USB Interface Kit

To connect a T401-series Hard Disk Cartridge to a PC via USB you will require a USB Interface Kit which is supplied with the necessary lead, external cartridge power supply, PCLink200 software and Windows drivers.

1) Remove the Hard Disk Cartridge from the X200.

2) Use the T401-PSU to supply power from a mains outlet to the 5V DC input on the rear of the cartridge and slide the power switch on the front of the cartridge to the on position.

3) Wait for approximately 5 seconds until the LED on the front of the cartridge settles to a steady green colour.

4) Plug the multi-pin D shaped IDE USB lead into the rear of the cartridge and then plug the smaller USB connector into an available USB port on the PC.

Once the disk has been connected, the PC should take a few seconds to detect the disk and will then automatically assign a drive letter to it.  Recording files can now be viewed by accessing the new drive letter using Windows Explorer or loaded directly from PCLink200 by using the ‘Load XBA file’, ‘Load XBA folder’ or ‘Cartridge Autoload’ options.  It is also possible to drag .xba files or folders from a Windows Explorer window and drop them onto the main area of the PCLink200 window.

Installing USB Interface Kit Drivers (Windows 98 and ME Only)

USB / IDE Interface Drivers only need to be installed when running Windows 98 and ME.  They are not included as standard in the USB Interface Kit and can be obtained from Brigade Electronics if required.  
It is strongly advised that the drivers are not installed when running Windows 2000, XP or Vista as they already have appropriate drivers as part of the original Operating System installation.  Windows 95 and NT are not compatible with the USB Interface Kit.

1
Plug the T401-PSU Mains to 5VDC Power Adaptor into an available mains socket and connect the DC output jack to the ‘DC5V’ socket on the rear of the Hard Disk Cartridge.  Switch the cartridge power switch to the ‘ON’ position.  The Power LED will flash amber and then turn green.  

2
Connect the IDE end of the USB / IDE Interface Lead to the Hard Disk Cartridge and the USB end to an available USB port on the PC.

3
Windows should automatically detect the new hardware.  Select ‘Cancel’.

4
Insert the USB / IDE Driver CDROM version CD50.4.  Use Windows explorer to open the directory ‘USBIDE(ISD)’  and then open the directory ‘98&ME’.  Select and run the file ‘TPPINST_5_04’.  Follow the onscreen instructions to install the drivers.

5
Select and run the file ‘setup.exe’ from the CDROM and follow the onscreen instructions.

PCLink200 software can now be installed from its installation CDROM and used to review and archive footage from a Hard Disk Cartridge.  Once PCLink200 has been installed a Hard Disk Cartridge can be connected to the PC by following steps 1 and 2 as described above.  

Windows automatically detects and assigns the connected cartridge a drive letter and the drive can be accessed as per normal in Windows Explorer.  If Windows has a problem locating a driver or accessing the drive then please refer to the relevant Windows update site and check that all the necessary components for USB compatibility are installed.  Windows XP in particular requires at least Service Pack 1 to have been installed and may require further updates for USB compatibility.

PCLink Suite 

The purchase of USB Kit T503/505-USB includes the necessary licence for use of PCLink Suite software including free of charge updates.  Brigade Electronics does not authorise the unlicensed usage of PCLink Suite software.
*Note –Cartridges 160GB or greater must be used with T505.
PCLink Suite contains all of the PC software for use with Brigade Electronics products.

When the installation CD is placed into the PC the following introductory screen should appear.
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To install the software required to view and archive footage recorded by the X200 select the option ‘Install Software and Manuals’.

Once the appropriate option is chosen the installation will start and the user should follow any on-screen instructions to complete the installation. Note installation may take several minutes, specifically for the .NET configuration.
It is also possible to view both the K200 and X200 manuals from this screen.  The relevant manual(s) will also be copied to the PC for future reference during PCLink Suite installation.

PCLINK200 Reviewing and Archiving Software

Quick Reference
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Mapping

PCLink supports two methods of mapping; real-time and static. Both methods are relient upon GPS data within the Brigade XBA file format. GPS data is embedded into the XBA file during recording. PCLink will read this GPS data and can either display a real-time map or a link to a static map on the internet.
Real-time
To utilise the real-time mapping functionality, Microsoft Mappoint must be installed. Current supported versions are 2006 Europe and 2006 North America (later versions should work also). These are separate applications that must be licensed and sourced aside of PCLink Suite. 
RaptorX mapping is also supported and PCLink serves GPS data to a RaptorX client. RaptorX is a 3rd party mapping application used by the American military. Textual GPS RMC lines are sent via a socket. The option defaults to ‘off’, and there is a setting in the options, preferences dialog for the port number. The default is 7017, but any can be used. Connecting RaptorX and PCLink is currently done by adding a connection within the RaptorX client.

Static
An Open Web Map button is provided on the GPS dial side panel. If the footage you are reviewing contains GPS data but PCLink will connect to a map via the internet and provide you a single point on the map at the instant you press the button.  To update the location, you have to repeat this step. 

Within the options, preferences dialog, there are several web map providers to choose from. You may also choose the style of the dials and the units in which they are displayed (MPH / KPH).
Accessing / Storing Images
Introduction

PCLink200 is a Windows based application included in the USB Interface Kit that allows .xba files to be viewed on a PC.  These files are automatically created by the X200 recorder on its removable disk cartridge.  The cartridge must be connected to the PC to access the files on the cartridge.

Playback options include play, forward-wind, rewind, jog control, jump to markers, time line jumping and stop.

Screen shots can be written to the Windows clipboard and pasted into most art packages in the BMP (Windows standard) image file format or saved directly to a BMP format disk file.

Sections of video footage can be selected and exported directly to an independent .avi file

Minimum Hardware Requirements

PCLink200 runs on Windows 2000, XP and Vista (latest service pack, IE level and updates should be applied). It is recommended that the minimum hardware requirement is a 2GHz Pentium processor, 512MByte RAM, USB2 for optimum playback speed. 

Note - some on-board graphics cards may need windows ‘hardware acceleration’ turning down. To do this goto the display properties of the pc, click on the settings tab, click on the advanced button, click on the trouble shoot button. Move the hardware acceleration slider down one notch.
Installation

PCLink200 is a utility allowing the user to review and export .xba video footage created using the X200 digital video recorder.

To install the software insert the PCLink Suite CD ROM into your computers CD ROM drive.  In most cases the installation program will run automatically.  If this does not happen use Windows explorer to select the CD ROM drive and the installer will start.

Starting

To start running PCLink200 click Start on the bottom left of the Windows screen and then follow Start>Programs>PCLink Suite 6.1 >PCLink200. Note that this location is only valid if the default settings were used during installation.

Installing Cartridge

To access recordings on cartridge, take to PC with PCLink200 already installed on PC.  Connect cartridge to PC using USB Interface Kit and provide power to the cartridge with the supplied 5V dc power supply.  Switch the cartridge power switch to the on position.

Windows should list the Hard Disk Cartridge as a new drive and automatically assign it with a drive letter. Please refer to the USB Interface Kit section of this manual for detailed instructions on installing and using the USB Interface Kit.

Removing Cartridge

WARNING: Cartridges should be safely removed from Windows operating system environment prior to removing power/usb cable. Data loss or corruption may occur if this is not followed.

To safely remove the cartridge from a Windows pc;
· Double-click on the “Safely Remove Hardware” icon in your system tray (right-click and selecting “Safely Remove Hardware” does the same)

· Select the device (drive letter assigned) to be removed from service

· Select “Stop”

· Select “OK”

· Select “Close” to complete the process

Alternatively, single-click on the “Safely Remove Hardware” icon in your system tray and select the appropriate device from the pop-up dialogue

· Wait for the drive activity light to stabilize

· Power-off and/or disconnect the drive.

Operating

Loading .xba files can be accomplished in a number of ways.

1.
If “Cartridge Autoload” has been selected in the Options menu the user will be asked 
if they want to load all footage from a Hard Disk Cartridge which is attached to the PC 
before or after PCLink200 is started.  If this option is checked when PCLink200 is 
running it will look for an attached cartridge and ask the user if they want to load all of 
the .xba files on the cartridge.

2.
“Load File” from the file menu.  This will display a file selection box and allow a single .xba file to be selected and loaded.

3.
“Load Folder” from the file menu.  This will display a file selection box and allow the selection of a folder containing multiple .xba files.  If the entire contents of a cartridge is to be loaded then the drive letter of the cartridge should be selected.  Pressing ‘OK’ will then load the entire contents of the folder or cartridge into PCLink200.

3.
“Load Remote Unit” from the file menu.  This allows access to files from an X200 which is connected to the network via its LAN interface.

4.
.xba files or folders containing .xba files can be dragged from a Windows Explorer window and dropped onto the main area of the PCLink200 window.

User Interface in Detail
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Play Controls


Rewind – click once to rewind the footage by a few seconds whilst playing or stopped.  Hold down to fast rewind the footage. The size and speed of this rewind is relative to the amount you are zoomed in.
Stop – Click once to stop the footage at any time.

Play – Click once to play footage.  If clicked whilst footage is playing the play button will stop the footage.

Jog back – Click once to rewind the footage by 1 second (to the nearest available keyframe) whilst playing or stopped.

Jog forwards – Click once to advance the footage by 2 images whilst stopped.

Fast forward – Click once to advance the footage by 5 seconds whilst stopped.  Hold down to fast forward the footage whilst playing or stopped.

Additionally the space bar on the keyboard may be used to toggle the footage between playing and stopped.
Playback Speed Selector

Just above the play controls is the Playback speed selector.  This allows the footage to be played back from between 0.1 and 10 times its normal playback speed.  Please note that at higher playback speeds than 1 times the smoothness of playback will be affected by the size of the footage window and the host PC’s processing capability. In PCLink’s non-DirectShow playback mode there is a ‘Max’ speed setting in the rate drop-down. This plays video back as fast as possible. 

In order to optimise the PC’s ability to play back footage at faster than 1x, it is advisable to shut down any other programs that are currently running and which may be utilising some of the system resources.  If there is no audio present on the recording then it is also advisable to disable audio playback (selected in the Audio Menu) so that playback speed is maximised.

Volume Control

To the left of the Playback Speed Selector is the volume control.  Slide to the right and left to increase and decrease playback volume respectively.  Please note that when audio is disabled in the Audio Menu the volume control will be hidden.
Timeline

To the right of the play controls is the Timeline.  This can be used to select and view the footage at a particular point in time.  Click once on this bar and the footage will jump to this time, the playback position indicator can also be dragged by holding down the left mouse button.  The two yellow triangles at the beginning and end of the timeline are the start and end markers.  By default these will appear at the start and end of the available footage when it is loaded, but they can be dragged by holding down the left mouse button to other points of the footage if desired.  This is useful when using the ‘Export video’ option on the File menu, which exports section of footage between these two markers.

Below the timeline and motion graph are a series of buttons used to select the scale of the timeline.  This can be selected to cover from 15 minutes to 1 year; the ‘Fit’ option scales the timeline to cover all of the currently loaded footage from beginning to end.

Motion Graph

The motion graph bar is shown below the timeline bar in the PCLink200 window.  This bar indicates the relative level of motion (change) in the recording.  The level of motion is indicated by the height and intensity of colour of the bar, higher and darker indicates higher motion and lower and lighter indicates lower motion.

The motion graph bar will show the level of motion for the currently highlighted camera.  If a number of cameras are highlighted then the graph will display the data for the camera which has the highest level of motion and not the average level across all cameras.  If no cameras are highlighted then the graph will display the data for the camera which has the highest level of motion from all of the recorded cameras.

The motion graph feature will only be active with recordings made on X200 operating software V1.2.0 and later.
Time and Date - The current time and date of the footage shown on the screen is displayed directly above the play controls.
Main menu and Toolbar - There are a number of menus available in the main menu bar across the top of the PCLink200 window.  There are also a number of icons on the Toolbar below the menus.
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File Menu.

Load File – Opens a single .xba file from a user specified location.  Select the file and press open.

If an .oba (X100) file is selected then PCLink100 will automatically start in a new window and the file can be opened from there.

Load Folder – Opens a group of .xba files from a user specified folder.  Select the file and press open.  This can also be used to load all the files from a cartridge connected to the PC.  To do this select the drive letter in My Computer assigned to the cartridge and press open.  All of the available footage from the cartridge will then be loaded.

If a folder containing both .xba (X200) and .oba (X100) files is selected then PCLink200 will ask which type of files are to be viewed.  If XBA is selected then PCLink200 will load all of the available .xba files.  IF OBA is selected then PCLink100 will automatically start in a new window and the .oba files can be opened from there.

If a folder containing only .oba (X100) files is selected then PCLink100 will automatically start in a new window and the files can be opened from there.

Load Remote Unit – Opens a window which allows the user to specify a network connected X200 to play currently stored footage from.

To access the recorded footage the X200 must first be added to the remote unit list.  To add a new unit enter a name for the unit and its unique IP address (please note that when shipped all X200’s have the default IP address 10.0.0.200).  The IP address must not be the same as any other component or X200 attached to the network.  Once the details have been entered click the ‘Add’ button to add the unit to the remote unit list.

If the host PC is running the LANLink system then selecting the ‘Load List’ option will allow the user to load the unit name and IP address for all of the units managed by the LANLink system in the form of an XML file.

To delete a unit already on the list select it by clicking on the unit name and then click ‘Delete’.
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The IP address and current status is shown for each unit on the list.  Only units which show ‘Ok’ in the ‘Accessible’ column can be currently selected for playback *See note below for Windows Vista Users
The Windows Vista firewall may block the X200 responses in PCLink and therefore show as “no reply”. To add a specific rule which fixes PCLink's ping reply problems in Vista:

Open the Windows Firewall with Advanced Security within Windows Vista.

1. Click Inbound Rules on the left tree then and click New Rule in the Actions Pane on the right.

2. Click Custom and click Next.

3. Click All programs and click Next.

4. For Protocol type, select ICMPv4.

5. Click Customize button.

6. Click Specific ICMP types, then for 'Type 0', 'code Any', click Add at the bottom. Click OK, and then click Next.

7. Under Which local IP address does this rule match? and for Which remote IP address does this rule match click either Any IP address or These IP Addresses. If you click These IP addresses, specify the IP addresses and click Add, then click Next.

8. Click Allow the connection, and then click Next.

9. Under When does this rule apply?, click the active profile, any or all profiles (Domain, Private, Public) to which you want this rule to apply, and then click Next.

10. For Name type a name for this rule and for Description an optional description. Click Finish.

To play footage directly from a unit on the list first select the unit name by left clicking it, which will highlight it in blue, and then click ‘Open’.  PCLink200 will then start playing footage stored on the unit.  The play controls can be used as normal although greater than 1x speed is not possible due to bandwidth limitations.

Please note that playing back footage in this way is not the same as downloading the recorded files and footage viewed in this way cannot be saved.  The footage is streamed directly from the recorder and is not stored locally on the host PC.

Once the remote unit is connected a button marked ‘Launch RemoteLink’ will appear at the right hand side of the camera toolbar.  This allows the user to automatically launch RemoteLink in order to configure the X200 menu system or view live camera images.  Please note that PCLink200 will temporarily disconnect from the remote unit at this point in order to allow RemoteLink access.  When RemoteLink is closed PCLink200 will reload the remote unit.

For more information on RemoteLink software please refer to the RemoteLink section in this manual.

It is important that in order to use this feature the recorder must be currently connected to the host PC’s network and that the user has permission to access the recorder.  Security measures on the network such as encryption and MAC address filtering may need to be adjusted in order to achieve this.

PCLink200 uses UDP port 69.  Any installed network or local PC firewalls may have to be instructed to allow the use of this port to prevent communication problems between the PC and the X200.

Close Files – Closes currently opened .xba files.  Use this option before switching Cartridges if PCLink200 is not to be closed and restarted.

Print – Prints the currently selected camera view.

Copy Image – Copies the currently selected camera view to the clipboard in Windows Bitmap format.

Export Image – Exports the currently selected camera view as a Windows Bitmap or JPEG to a location specified by the user.  Please note that JPEG produces file sizes approximately 20 times smaller than bitmap with no discernable loss in image quality.

Export AVI – Please note that the maximum supported file size for an AVI file is 2GB, if this is exceeded the AVI export will abort with an error message shown.  This limits exported sections of uncompressed AVI footage to approximately 64 seconds if the original XBA footage was recorded at 25ips.  Therefore it is advised that a compression codec is used in order to extend the length of footage able to be exported as AVI.  

DivX Version 6.7 is currently a good codec to use when exporting to AVI. It uses good compression to keep file sizes small and the quality is comparable to XBA. Support for WMV9, 3ivx, ffdshow and ffvfw are also included.
The section of footage between the start and end markers can be exported as either a compressed or uncompressed AVI file.  A dialogue box will appear allowing the user to select the codec for compression (or uncompressed) and manually set the footage start and end times if desired.  The camera selected for export and the option to include audio can also be chosen from this dialogue.

The recommended codecs for maximum performance are currently XVID or DIVX.  As these are not included with Windows as standard it may be necessary to obtain them from the relevant companies so that PCLink200 can make use of these codecs.  If this is not possible the use of standard Windows codecs such as Microsoft Video1 will still offer substantial reductions in exported AVI file sizes when compared to uncompressed AVI.

Export WAV - Exports the section of footage between the start and end markers as a WAV file.  This is an audio only file and will not contain any video images. Choose the output file name/destination and the period of footage required. 

Export XBA – Exports the section of footage between the start and end markers as an XBA file.  A dialogue box will appear allowing the user to select which cameras, audio channels and data (GPS and motion) is included in the exported XBA.  

The maximum file size can also be limited in order to fit the resultant parts to certain media (CD, Zip disk etc.).  In this case if the total size of the exported footage exceeds the maximum file size selected then a number of files will be created all with the same name as entered in the ‘File Name’ box, but having a suffix to the file name ( -part2, -part3 etc.) so that the correct order of the parts can be easily determined from the file name.  For example – If a 50MB section of XBA footage is exported and the maximum file size is set to 20MB then three files will be created, two 20MB in size and one 10MB.  If the user entered the name ‘Export’ into the ‘File Name’ box then the resulting files would be Export.xba, Export-part2.xba and Export-part3.xba.

The user can select one of the standard maximum file size limits or alternatively select ‘Custom’ from the drop down menu.  If custom is selected then the user inputs the required maximum file size in the ‘Mb’ window next to the drop down menu.

It is also possible to set the start and end times of the exported XBA using the ‘Start Time’ and ‘End Time’ options at the bottom of the export dialogue, to do this press the ‘…’ button next to the relevant option and manually enter the date and time.  This will override the start and end markers on the timeline.  

If the PCPlayer box is checked then PCPlayer200 software will be copied along with an autorun file at the same time and to the same folder as the exported .xba file.  The .xba file (or files), PCPlayer.exe and Autorun.inf files can then be copied to a CD.  When this is inserted into a PC, PCPlayer200 will automatically start and load the available .xba files on the CD.  This allows playback of .xba files without the need to install PCLink200 software.

For more information on PCPlayer200 please refer to the PCPlayer200 section in this manual.

Export Cameras to Folder (Print Screen Key on Keyboard) – At any time during play back it is possible to save all of the current camera views to a folder as separate JPEGs (one for each camera view) by pressing the Print Screen key on the PC keyboard.

The JPEGs will be saved to a folder as specified in the preferences dialog.  The Preferences dialog is accessed by going to Options > Preferences.  

Please note that if the user does not specify a location for the exported images, then by default the images will be stored in the same place as the original XBA file was loaded from.  This may cause problems if the XBA file was loaded directly from a Hard Disk Cartridge which may have limited free space available.

The format for the file names is of the form:

19th Oct 2004 14.10:00 [cam 01] .jpg

19th Oct 2004 14:10:00 [cam 02] .jpg

If multiple images exist for the same time (when using a record rate over 1ips per camera) then PCLink200 will not overwrite previously exported images but will instead append the file names with a bracketed number so that the correct sequence of images can be determined.

For example:

19th Oct 2004 14:10:00 [cam 01] (1) .jpg

19th Oct 2004 14:10:00 [cam 01] (2) .jpg

Reports - Check loaded files – This feature checks the watermark for every image in the footage between the start and end timeline markers (these are set at the beginning and end of all the currently loaded footage by default). Check Catridge/Folder does the same as check loaded files, but on an X200 cartridge or a folder containing XBA files.
When the check is complete, an HTML log file is produced and automatically opened.  This log file lists all of the checked files and has a summary section at the bottom.  Each file has a ‘+’ symbol next to it for further information about that file.  This extra information will automatically be shown if there were problems with the watermark for this file. Information includes; Unit serial numbers, start/stop times, sequence numbers and also a file CRC and SHA1 checksums (which are also written to a separate file, with a link added to the html report).

File checks are categorised into three states:

· Passed check (green)

· Passed check with issues (blue)

· Failed check (red)

Files fail if:

· Any video/audio frame (other than the last in a non-closed file) had an invalid watermark 

· Video frames were missing or out of sequence (in newly generated files)

· Files passed to the checker were not in sequence (in newly generated files)

· Files are missing their sequence frame (in newly generated files) in properly closed files.

Files pass with issues if:

· File was not closed properly (power off during record)

· File was not closed properly (power off during record) and the last video/audio frame failed the watermark check

· Files are missing their sequence frame (in newly generated files) in non-properly closed files (power off during recording)
Recent Files – Displays a drop-down list of recently opened .xba files, click on an item to load the file.  Please note that this will not work if the file has been moved since it was last opened.

Properties – Brings up a summary of the current .xba file properties such as start/end times and file size.

Exit – Exits the PCLink200 program.

View menu.

Toolbar / Status Bar – These can be checked or unchecked to either view or hide the Toolbar and Status Bar in the PCLink200 window.

Cameras – This will display a drop-down list of cameras.  Either check or un-check each camera to determine whether it is currently displayed or not displayed in the PCLink200 window.  Cameras with available footage will have their number displayed in black, all others will be displayed in grey and are not accessible.  

Additionally double left-clicking on any displayed camera window in a multiple camera view will display it full screen.  Left-clicking again will revert back to a multiple camera view.  Multiple camera views can be selected by holding down the Ctrl key whilst left clicking on the desired camera windows.  If multiple camera windows are selected then double left clicking whilst holding down the Ctrl key will display only the selected cameras, left clicking any part of the grey area of the PCLink200 window will revert to all camera windows being displayed.

Show Selected Cameras – This will display all of the currently checked cameras in the Camera list.

Show All Cameras – This will display all cameras for which there is available footage.

Full Screen – This will display the selected camera window full screen without the PCLink200 menu bar or playback controls.  Press Esc to return to normal viewing mode.  Full screen view can also be toggled by pressing the F11 key on the keyboard.

Controls menu.

Play / Stop – This will toggle the footage from playing to stopped and vice-versa.  Also controlled directly by the Space Bar on the keyboard.

Jog Forwards – Causes the footage to jog forwards.  Also controlled directly by the L key on the keyboard.

Jog Backwards – Causes the footage to jog backwards.  Also controlled directly by the J key on the keyboard.

Jump to Start Marker – Causes the footage to jump to the start marker.  Also directly controlled by the I key on the keyboard.

Jump to End Marker – Causes the footage to jump to the end marker.  Also directly controlled by the O key on the keyboard.

Jump to – Brings up a dialogue box allowing the user to input a time and date to jump to.  If no footage is present at the selected time and date then the nearest footage will be selected.  

Confine Markers to Displayed Footage – Sets the start and end markers to the beginning and end of the currently displayed Timeline.  This is useful if only a portion of the total footage Timeline is currently being displayed. Also directly controlled by the M key on the keyboard.

Set Left Marker To Play Position – Sets the left (start) marker to the current play position on the Timeline. Also directly controlled by the [ key on the keyboard.

Set Right Marker To Play Position – Sets the right (end) marker to the current play position on the Timeline. Also directly controlled by the ] key on the keyboard.

Audio menu.

Audio Enabled – Enables audio playback on both channels.

Left Channel Only – Enables audio playback on the left channel (channel 1) only.

Right Channel Only – Enables audio playback on the right channel (channel 2) only.

Audio Disabled – Disables audio playback (Mute).

Options menu.

Cartridge Autoload – Check this option to autoload all footage from a Hard Disk Cartridge which is attached to the PC before or after PCLink200 is started.  

If a Cartridge containing both .xba (X200) and .oba (X100) files is connected then PCLink200 will ask which type of files are to be viewed.  If XBA is selected then PCLink200 will load all of the available XBA files.  IF OBA is selected then PCLink100 will automatically start in a new window and the OBA files can be opened from there. If a Cartridge containing only .oba (X100) files is connected then PCLink100 will automatically start in a new window and the files can be opened from there.

Passwords – Allows the user to set passwords for operation of PCLink200 or just the export function.  The password is blank spaces by default and setting it back to this will remove any password protection. 

Preferences – This brings up a menu allowing the user to specify a number of display and export preferences.
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Scale clipboard image & Scale exported bitmaps – To provide high quality video from single field sources, it is recorded at a resolution of 720 x 288. This means that the image pixels are effectively rectangular. During playback these are displayed perfectly on the screen. However, when the image is copied to the clipboard, it can be left in the original format or optionally scaled to the proper aspect ratio. The user may have a better algorithm available to stretch these images, in which case they should disable this option. Default: enabled

Multiple camera export folder – Choose the default location for exporting.

Weeks start on Sunday - By default weeks are assumed to start on Monday. If the user considers weeks to start on Sunday they should enable this option. Default: disabled

Keep playing on seek - If the user drags the play head cursor or clicks in the timeline window during video playback, the system will seek to the new time thus selected. This option determines how the system behaves after this seek. If enabled, the playback will resume from the new time. If disabled, playback will not resume and the system will wait for either another seek or a click on the Play Button – this may give the user a better sense of control over the system. Default: enabled

Auto update timeline - As the user drags the play head cursor left and right in the timeline window, the images in the video windows will automatically update. If this puts too much load on the user’s PC, the response can become sluggish. In this event it may be preferable to disable this feature, so that the images only update when the mouse button is released. Default: enabled
Clear old frames on seek - When the user performs a seek in video that has infrequently updated channels it is perfectly normal for there to be no frame available on some slower channels. The user has the option at his point of having the previous frame stay in the video windows when no more up to date image is available, or if this option is enabled these out of date frames will be removed and the user notified. Either way, once playback is resumed the video windows will be refreshed next time an appropriate image is read from the file. Default: enabled

Display load meter - When this option is enabled a small bar graph meter is displayed at the bottom right of the main screen. This will normally show 4 green bars. If during playback, the system is unable to keep up with decoding and playing video and audio at the requested rate, these bars will progressively turn red to show this overload. If this is happening there are a few ways to stop it. If audio playback is not required, then it is advisable to disable it from the Audio Menu. Otherwise, the user may choose a slower speed in the Playback Controls near the bottom left of the main window. If the user’s PC has older graphics hardware, then simply reducing the size of the main window can improve system performance. Default: enabled

Centre video - This option centres the video windows in the main window which may be more pleasing than having them appear on the left of the screen. Default: enabled

Display frame rate - This option displays the frame rate audio rate for each channel in the information bar underneath it’s video window. This technical information is sometimes useful, but can clutter the display. Default: disabled

Watermark - Each image is watermarked as it is recorded, providing a guarantee of authenticity. As PCLink200 plays back the image, it checks the watermark to ensure that the image has not been tampered or altered. The water mark is then displayed in the corner of the image as a green W logo. A broken watermark is shown with a red line through it. The user may specify which corner of the image to show the watermark in, and indeed whether to show it at all, by choosing from the drop down list. Default: disabled

GPS / Dials - Open Web Map, if the footage you are reviewing contains GPS data but you do not have Microsoft Mappoint installed, PCLink will connect to a map via the internet and provide you a single point on the map at the instant you press the "Open Web Map" bar.  To update the location, you have to repeat this. There are several web map providers to choose from. You may also choose the style of the dials and the units in which they are displayed (MPH / KPH). RaptorX mapping is also support, refer to your RaptorX installation for the specific port connector number, this will be configured in the RaptorX client. See Mapping section for further details.
Cartridge autoload - When enabled, Cartridge Autoload monitors your PC’s hardware so that when a cartridge is attached, PCLink200 will automatically prompt you whether you want to load the files on it. Default: enabled

Show diagnostic messages - Displays detailed information about errors encountered while loading files. Many of these are minor errors that prove confusing or unhelpful during normal use of PCLink200. If the user is encountering problems with recordings from a suspect unit, then it may be advantageous to enable this option, especially when asked to do so by the technical support team. Default: disabled

Quicker cartridge loading - Enables faster loading of cartridges at the expense of motion data. The green bar representing available video will appear in the timeline much faster if this option is enabled, but the motion data will not be read until the video is played.
Use DirectShow for playback - By default, DirectShow playback is disabled, this is the preferred method for playback however you can turn this back on by ticking the box above. Changing mode only takes effect when PCLink is restarted. PCLink’s buffering technology removes reliance on DirectShow and makes it possible to run without actually being installed. There are still situations where an install will be required to make PCLink run, although all that is required on Vista & XP is the .net 2.0 (or greater) runtimes.

Non-DirectShow buffer mode has a few advantages: Single frame jog fwd + backwards, Faster single-channel playback, PCLink quicker to open/close/load files, Video effects results applied even when paused, 

DirectShow buffer mode has a few advantages as well: Faster on multi-core CPUs for multiple channel playback, Displayed footage resizing filtered, 

Enable Multi-threading - PCLink’s non-DirectShow playback engine has been re-factored to utilize multi-core processors. This feature can be turned on/off in the options window. On older single-core machines, PCLink may run more efficiently with it turned off, but for most machines leaving it on will increase the playback speed.

Help menu - Access to the Help Menu and information about PCLink200.

About menu - This shows the installed/registered components of PCLink. The Tidy Registry button removes 'self-healing' information from the registry for PCLink's various COM components. Normally this is not something a user should do, but in certain situations, support may ask you to click it in order to help diagnose problems, or before applying a patch.
Toolbar - There are a number of icons on the toolbar which mirror functions from the menu.
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	Open XBA file
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	Open XBA folder
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	Displays properties for all the currently loaded .xba files. It also highlights the file currently playing and allows the user to double-click files to jump to their start times
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	Copy current image to clipboard
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	Export current image
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	Export video between start and end markers
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	Print current image
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	About PCLink200
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	These three buttons toggle between Single Camera View, Priority Camera View with Thumbnail Multiview or Multiview (all cameras).
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	Individual Camera Buttons – All shows all of the available camera views, clicking on the numbered buttons displays that individual camera view.  Hold down CTRL to select multiple camera buttons.
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	The Map button toggles on/off the map window within PCLink.
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	Opens the RemoteLink application. If you are already connected to an X200 remotely, PCLink will automatically connect to that unit when this button is pressed. The PCLink connection will terminate.
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	Opens the SafteyLink application (driver education program).
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	Information Side Panel - Switch between GPS (as shown) FX & G-Force views. FX View includes; Gamma, Brightness, Contrast, Greyscale and Negative adjustments. G-Force includes; Lateral, Forward and Upwards measurements in terms of G.


Export XBA footage from PCLink200
1. Open the .XBA file/files in PCLink200. 

2. Move the yellow markers in the timeline to the start & end points of the footage required.
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3. Goto the File menu and select Export XBA.

[image: image43.jpg]& LoadFile.. Crl+0
& Load Folder..
2 Load Remote Unit

Close Files
& pnt Curlep
By Copylmage Culec

@ EportImage..

Export Cameras to Folder prisc
Check Watermarks
Recent Fles ,
[y Propertis... At Enter

Exit





4. Select the destination folder that you wish to export to. By default the exported footage will be named merged.xba
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5. Pull down the Include menu and select the detail you wish to export.
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6. An alternative to setting the markers in step 1 is to manually select the date/time from/to that you wish to export. If you followed step 1 then this step can be skipped.
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7. Check the “Copy Stand-Alone Player Files to Export Directory” box. This will provide the necessary files for a 3rd party to play the footage on a pc that doesn’t have the full licensed PCLink Suite installed.
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8. Click the Save button to start the export.

9. You will see the progress bar popup, followed by a confirmation dialog;
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10. The destination folder chosen in step 4 should now contain the following files and folder;
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11. The files/folder can then be burned to CD/DVD. All 5 items above must be included.
Writing the CD/DVD will depend upon what operating system the PC is running and what software applications are installed. Any standard CD/DVD writing software will be capable of burning the files, including for example, the built in Windows XP burning software. Other common applications for example are Nero and Roxio.

A 3rd party can then play the CD/DVD on any PC without needing to install any software. The CD/DVD should auto-play when inserted and PCLaunch will determine whether the full PCLink application, or the cut down PCPlayer can be used to review the footage.
Export AVI / WAV

PCLink can also export footage video to AVI format or audio to WAV format. From the File menu, select the export method, choose the output file name/destination and the period of footage required. 
AVI Export dialog has an ‘Include Watermark’ checkbox. When ticked, the frames in the exported AVI file will have the PCLink Watermarking symbol burned into them:

· If a frame passes the watermark test, it gets a green ‘W’ symbol

· If a frame fails the watermark test, it gets a green ‘W’ symbol with a red line through it.

The symbol’s position is the same as in PCLink, and can be changed via the options.
For specific codec information, see the PCLink User Interface in Detail section above.

PCPlayer200 Reviewing Software

Introduction

PCPlayer is a cut down stand-alone Windows version of PCLink200. It allows .xba files to be viewed on a PC which does not have PCLink200 installed.  

PCPlayer200 is run directly from a CD containing XBA files, PCPlayer.
Playback options include play, forward-wind, rewind, jog control, jump to markers, time line jumping and stop.

Screen shots can be written to the Windows clipboard and pasted into most art packages in the BMP (Windows standard) image file format or saved directly to a BMP format disk file.

Minimum Hardware Requirements

PCPlayer200 runs on Windows 2000, XP and Vista (latest service pack, I.E. level and updates should be applied)
It is recommended that the minimum hardware requirement is a 2GHz Pentium processor, 

256MByte RAM, USB2 for optimum playback speed.

Starting

With a CD containing the PCPlayer.exe file and .xba files use Windows Explorer to view the contents of the CD and then double click the PCPlayer.exe file to start PCPlayer200. It will automatically load any .xba files in the same folder.
IMAGELINK

ImageLink is a PC client application that can view received camera images from an X200 over a GSM modem connection. The image is triggered locally on the X200 via an alarm input. 

Requirements; X200 fitted with a GSM modem, optional GPS unit, push button that can send a trigger to the X200. PC running ImageLink (server component), connected to a phone line/modem. 
Example; A camera connected to the X200 is used to take a snap shot of an incident. As the image is taken, an alarm trigger will initiate the X200 to transfer information and image data to a preconfigured remote modem. The X200 dials out to the remote modem, which is connected to a PC running ImageLink and transfers the data. 
Data is presented in the ImageLink client application as below and also written to an xml file. A bmp file is used to store the image data.
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Selecting an ImageLink event will display the image and additional data;

Unit ID – Text data held on the X200 in the CAMERA OPTIONS menu.

Serial Number – X200 Serial number

Date/Time of the ImageLink event.

GPS/Speed information – Requires the X200 to have a GPS unit connected.

Camera Type – PAL/NTSC

Trigger – The X200 has 4 alarm input connections that could be used for different event types.

Open Map – Opens a custom Google map with ImageLink data pin pointed. It includes thumbnail image and data on the map point and links to the full data underneath the map.
Open Bing Map – Opens a standard Bing Map with the location pin pointed.
Open Google Map – Opens a standard Google Map with the location pin pointed.

Selecting multiple ImageLink events will plot all points on the custom Google or Bing maps. All map pin points are reliant on the X200 having GPS connected.
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Open Map – Example, clicking on an individual map marker will display a thumbnail image and details.
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Open Google map – Example, opens the coordinates of the selected image in Google maps. Note this does not show the image or details of the selected image transfer.
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Open Folder – Pressing the open folder button on the main ImageLink interface will open the configured folder (Tools>Preferences) where the decoded data is stored. Data can be moved/archived from this folder and subsequently will no longer appear in the ImageLink event list.
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Filter by – When checked, this enables pull down menus to sort the ImageLink events.
Save Image – Save the currently displayed image to another location.
ImageLink Server

The above information relates to the ImageLink client frontend application. The ImageLink Server application is a separate app that receives the data and decodes it ready to be served to the client app. The server must be running on a PC with a modem. 

Server Preferences dialog is shown when first run. This includes the destination folder for the received data, an option to launch the server when windows starts, number of rings before pickup and logging information. 

From the View menu, you can see which modems are available for use.
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There is also a section for adding license key information. This relates to the number of units an ImageLink server can support. Please contact Brigade Electronics for further information.

Main Server view is shown below and includes a received call event history;
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Safetylink

SafetyLink is a driver education program aimed at training and improving transport fleet drivers. Events are based on G-Force data, recorded using Timespace’s Accelerometer hardware – XP200.
SafetyLink is a stand alone application that can be launched via the PCLink Suite program group or from within PCLink200. It currently MUST BE USED WITH LANLink and provides access to short clips of footage.

XP200 is used to record G-Force data and embed it into the X200 footage. This data is then analysed by LANLink and if any period meets or breaks a configurable threshold level then an event is automatically downloaded (via suitable LAN/WLAN infrastructure) for review in SafetyLink. 
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Event information recorded includes Date/Time, G-Force movement and severity. It is displayed in a tabular format and can be sorted using the column headers. 

Events can also be filtered/searched based upon its detail e.g. by date, driver, 
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The G-Force movement recorded is indicated by an icon, plus the actual numerical G value;
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  BRAKE is the measurement of decreasing forward motion. 
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  ACC is the measurement of increasing forward motion.
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  LAT is the measurement of lateral movement.
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  UP is the measurement of upwards motion.

Optional user information can be inputted such as Driver, Reviewer, Status and Notes.
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Double clicking on any event will open the footage in PCLink200 for reviewing. Footage can be played with graphical data of the event.
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Using XP200 / GSensor data without SafetyLink

The X200 can still be used to record the GSensor data and trigger an alarm to prompt an operator to review the footage manually. 

The alarm could be for example an LED, which would indicate an event that requires reviewing. The X200 Cartridge could then be removed and the footage played back on PCLink, using the graphs on the timeline to find the events easily.

Kstation

The Kstation application included with PCLink Suite is for use with the K series Brigade products. 

It is used for easily downloading footage from a K series unit onto a PC via a USB connection. Attached units can be configured as shown below and files automatic transferred when connected.
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Remote Operation (review, confIGure and download)
The X200 system provides a number of ways of remotely controlling/configuring the recorder, reviewing recorded footage and displaying live camera views.

The X200 includes Ethernet Local Area Network (LAN) technology.  It also incorporates a TFTP (trivial file transfer protocol) server which allows the video files to be downloaded using either a hard-wired or wireless network connection.  The X200 also includes a serial port allowing direct connection to a PC or system control using a series of RS232 commands.  Please refer to the RS232 Control section of this manual for details on RS232 external control of the X200.

There are a number of software applications provided by Brigade Electronics in order to achieve these tasks.  In addition to these there is a stand-alone TFTP client application (X-Communicate) which is able to download individual recording files via the X200 LAN interface.

Remote Configuration and Live Camera Views


RemoteLink

RemoteLink software is provided for this purpose and takes the form of a virtual X201 Reviewer displayed on the users PC.  RemoteLink allows the user to configure the X200 menu system, control the recorder functions and look at the current live camera views.  Playback of recorded files is possible but is better served by PCLink200.

RemoteLink can connect to the X200 via serial, LAN and GSM modem interfaces.  All three of these interfaces provide the same functionality at varying speeds.  Direct serial connection is the fastest, LAN is slightly slower and GSM connection is relatively slow compared to the other two due to the bandwidth limitations of the GSM network.

Please refer to the RemoteLink section of this manual for further information.

Remote Streaming of Recorded Footage


PCLink200

PCLink200 is able to remotely play back recorded footage from the X200 via the LAN interface without downloading it to the host PC.  This allows remote ‘streaming’ of recordings that may not need to be permanently archived.

Please refer to the PCLink Suite section of this manual for further information.

Automated Recording Download and System Health Check


LANLink

LANLink software allows multiple X200 systems to be entered and monitored in terms of recording files and system health.  LANLink requires a more complex IT infrastructure and systems than the other software but does provide the benefits of remote and automatic download of footage and system health checks.

LANLink works via the X200 LAN interface in conjunction with a dedicated network infrastructure.

Please refer to the LANLink section of this manual for further information.

LAN

Introduction

This document is intended to provide an introduction to the networking facilities provided by the X200 Digital Video Recorder and to assist with the configuration and interoperation between it and other networked computers.

Connection to the X200 built-in 10Mb/s (later units are 100Mb/s) Ethernet network adapter is via a standard RJ45 socket and from this a connection can be hardwired or via a wireless bridge device such as the Netgear ME101.
*Note – For best performance, LAN activity should be kept to a minimum during recording.
Configuration

Configuration of the X200 networking parameters is done via the menu system accessed using a X201 reviewer.  The LAN (local area network) menu option presents the user with fields which allow the IP address, the subnet mask and the default gateway values to be set.  It also allows the user to interrogate the unit’s unique MAC address.

The X200 LAN menu page is similar to that shown below:

        
     LAN   


LAN STATUS :
  DISCONNECTED
IP ADDRESS : 
       >
10.
0.
0 . 200
SUBNET MASK :
255 . 255 . 255 .        0

GATEWAY :

10.
0.
0 . 255

   PING TEST   .  .  .

RECORD DURING TRANSFER:      NO
LAN IDLE TIMEOUT:

1 MIN

TIME ADJUST PORT:

8463

MAC :

    0 0 : 0 F : B 4 : 0 0 : 0 0 : 0 0

Unit MAC Address

All network devices include a unique media access control (MAC) address used to identify it on a network.  The address is a 48 bit number, usually represented as 6 bytes – each byte written in hexadecimal notation.

[On the menu, each hexadecimal byte value is separated by a colon.]

All Brigade Electronics devices have a MAC address which begins 00 0F B4 followed by another three bytes.

e.g.  00 0F B4 00 0A 48
The X200 LAN menu option allows the user to display its MAC address which may be useful in configuring access control with wireless networks.
IP Address

For devices communicating on a network, messages must identify the source and destination with an address.  The IP (internet protocol) address is a 32-bit number that uniquely identifies a device connected to the network and is usually represented in a dotted decimal form.

e.g.  10.0.0.28
[The IP addressing scheme is defined by the Internet Engineering Task Force (IETF) document RFC 791]

Subnet Mask

The subnet mask is used to determine what subnet an IP address belongs to. An IP address has two components, the network address and the host address.  Subnetting enables a network administrator to further divide the host part of the address into two or more subnets. In this case, a part of the host address is reserved to identify the particular subnet. 

The subnet mask is the network address plus the bits reserved for identifying the subnetwork. (By convention, the bits for the network address are all set to 1.)  As a mask, it can be used to identify the subnet to which an IP address belongs by performing a bitwise AND operation the mask and the IP address. The result is the subnetwork address. 

Default Gateway

This is the address of the ‘gateway’ in a network that a computer will use to access another network if a gateway is not specified for use.  In a network using subnets, it is the address of the router that forwards data traffic to a destination outside of the subnet of the transmitting device. 

Ping Test ...

Selecting this option will bring up the ‘ping test’ menu which is similar to that shown below. 

          |  PING TEST  |     
   PING ADDRESS:   10.  0.  0.  1

   >DO PING TEST  |REPLY RECEIVED|
   BYTES SENT:               3988

   BYTES RECEIVED:           5304

Enter the destination IP address of the unit you want to test communication with on the ping address line and then select ‘DO PING TEST ...’.  If the destination receives the ping message and replies within 10 seconds then ‘REPLY RECEIVED’ is displayed; otherwise ‘NO REPLY’ is displayed.

[See the troubleshooting section for further details about ‘ping’ and instructions on how to initiate a communications test from a computer attached to the network.]

The ‘BYTES SENT’ and ‘BYTES RECEIVED’ fields update in real-time to show how many bytes are being transferred to and from the X200 and can provide further indication of data transfer.
WLAN

Wireless Ethernet Bridge

Connection

The X200 Digital Video Recorder is connected to a network via a standard RJ45 network socket.  For a wireless LAN, a direct connection can be made from this port to a wireless bridge device, for example Netgear ME101 or WGE101. 

Configuration

Because wireless devices from different manufacturers provide different facilities, configuration is usually performed using a proprietary utility supplied with the device.  The configuration process usually involves connecting the device to a network equipped PC and running the utility to set up the security and encryption settings.  It will also be necessary to select the correct SSID (service set identifier) which is a 32 character string used to identify one wireless network from another.  Refer to the installation guide included with the network bridge for more specific details.

Wireless Router

Configuration

Two standards are typically in use for the encryption of data transferred over a wireless network WPA (wireless protected access) and the older legacy system; WEP (wired equivalent privacy).  The use of either necessitates the configuration of all wireless devices employed on the network. Where problems are being experienced establishing connection between wireless network devices, it is recommended, where possible, to first establish reliable communication with encryption turned off.
WEP (Wired Equivalent Privacy)

The WEP security standard uses a key (64 or 128 bits long) to encrypt and decrypt data sent over the wireless connection.  All devices on the same network must be configured with the same key.
WPA (Wireless Protected Access)

The WPA security standard uses a pass-phrase key to encrypt and decrypt data sent over the wireless connection to ensure privacy.  All devices on the same network must be configured with the same key and encryption technique (TKIP or AES).
MAC Address Filtering

MAC address filtering is a security feature which allows you to specify which computers are allowed on your network.  Any computer attempting to access the network that is not specified in the filter list will be denied access.  When using this feature, the MAC address of each client must be added to the list in the router. It may be necessary to add both the MAC address of the X200 and the wireless bridge to which it is connected.
Typical X200 Wireless LAN Configuration
 



Troubleshooting

Hardwired Connection

If it is suspected that the wireless connection is causing problems, the X200 standard RJ45 socket allows connection to the network using a standard UTP network cable. If a hardwired cable connection is made directly to a single computer then a cross-over cable may be necessary.
Ping

The ‘ping’ utility is a software tool used to see if a network device is operating and also to see if connections to it are intact. A small packet of data is sent through the network to a particular IP address and the computer that sent the packet then waits (or 'listens') for a return packet. If the connections are good and the target is working, a good return packet will be received.

[Ping uses the Internet Control Message Protocol (ICMP) Echo function which is detailed in RFC 792.]
The ‘ping’ utility is provided in versions of the Microsoft® Windows® operating system.  It can be run by following the instructions below:

· Press the ‘Start’ button.

· From the menu, select ‘Run...’

· In the dialogue window type command where it says Open.

· When the command window opens, at the prompt type ping followed by the IP address of the device to be tested.  In the example below the IP address of the unit being tested is 10.0.0.3 and the unit is replying.  If no response is received the ping application will display ‘Request timed out.’
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Operation

Single Client

The X200 Digital Video Recorder will allow file download to one client at a time.  During file transfer, any attempt by another client to download a file will be rejected or ignored.  A transfer can be explicitly aborted with a Brigade extension to the TFTP protocol and implicitly aborted if no acknowledgement is received in response to a data packet within 20 seconds.

TFTP

TFTP (trivial file transfer protocol) is a simple protocol used to transfer files.  The X200 Digital Video Recorder includes a TFTP server which follows the protocol as described in the following documents:

· The basic TFTP protocol 

RFC 1350
· TFTP option extension 


RFC 2347 (1782 ) 

· Block size option 


RFC 2348 (1783 ) 

· Time-out and transfer size options 
RFC 2349 (1784) 
Brigade Extensions

While the X200 implementation of the trivial file transfer protocol follows the standards closely, it extends upon it to allow the client to interrogate the files stored locally in the recorder.  These extensions are:

Explicit transfer abort

Directory listing request

Explicit Transfer Abort

Since the X200 Digital Video Recorder only supports transfers to one client at a time, provision has been made to abort a transfer should either client or source become unable to continue.

The X200 will assume that a data transfer has been aborted if no acknowledgement is received in response to a data packet within 20 seconds.

The X200 will abort a transfer currently in progress if it receives an ABORT command (op code 7).  This will allow the same (or another) client to initiate a new transfer.

Directory Listing Request

The standard TFTP read request (RRQ) packet takes the following form:

	2 bytes
	string
	1 byte
	string
	1 byte

	Op Code (1)
	Filename
	0
	Mode
	0


The Brigade Electronics implementation of TFTP on the X200 responds to read request packets where the Filename is either dir or dir,n (where n is an integer used to identify the index into the directory listing).  The response to such a request is a packet containing information about the requested directory entry in the following form:

iii/nnn→lllllllllllllllllllllllll→sssssssssss→cccccccc→mmmmmmmm→zzzzzzzz

where the fields are separated by tab characters (→) and they represent:

i - the index number of the file in the X200 directory

n - the total number of files in the X200 directory

l - the long filename

s - the short filename

c - the creation time and date

m - the modification time and date

z - the file size in bytes.

Data Transfer

Transfer Rate

The X200 Digital Video Recorder is equipped with a 10Mb/s network interface controller and this could be a limiting factor when using with a wireless LAN connection.  Current wireless standards include:

IEEE 802.11g – provides networking with speeds up to 54Mb/s

IEEE 802.11b – provides networking with speeds up to 11Mb/s

where these are maximum rates.  In practice, the rate adapts according to the S/N (signal to noise ratio) and the signal strength – the further apart the two communicating wireless devices, the lower the transfer data rate.
Transfer Range

The IEEE 802.11b standard limits the radiated power to 0.5W and in general a range of up to 100m is considered possible when there are no obstructions.  Besides distance, performance can be degraded by radio interference, humidity, air temperature, resource contention (if many devices are accessing the wireless network simultaneously) and objects that block the signal.

Antenna

Antennas direct Radio Frequency (RF) power into a coverage area. Antennas are available which produce differing coverage patterns and to maximize the transmission range, the design of the antenna connected to your card is crucial. The majority of supplied antennas are omni-directional - that is, they radiate energy more or less equally in all directions. The correct antenna for a site is chosen by determining the antenna that provides the coverage pattern best matched to the site coverage requirements.  If the supplied antenna is replaced with a directional antenna then a range of up to 3km or more may be possible although this will be limited again by any obstructions.

The increase in coverage within the RF beam width is called the antenna gain, and is measured in dB (decibels). Antenna gain improves the range of the signal for better communications (for both transmission and reception). As a general rule of thumb, each 1 dB increase in antenna gain can result in a range increase of 2.5% indoors or 5% outdoors. Actual results will vary depending on the amount and type of obstructions at the site.

Channels

The 802.11 standard defines a number of channels which operate at different frequencies in the 2.4GHz spectrum.  However, the spectrum allocation means that many of these channels overlap.  Additionally, interference from other devices in the 2.4GHz spectrum, such as wireless phones, bluetooth devices and microwave ovens, can make that part of the airwaves quite crowded.

	Channel
	Lower Frequency (GHz)
	Central Frequency (GHz)
	Upper Frequency (GHz)

	1
	2.401
	2.412
	2.423

	2
	2.404
	2.417
	2.428

	3
	2.411
	2.422
	2.433

	4
	2.416
	2.427
	2.438

	5
	2.421
	2.432
	2.443

	6
	2.426
	2.437
	2.448

	7
	2.431
	2.442
	2.453

	8
	2.436
	2.447
	2.458

	9
	2.441
	2.452
	2.463

	10
	2.446
	2.457
	2.468

	11
	2.451
	2.462
	2.473

	12
	2.456
	2.467
	2.478

	13
	2.461
	2.472
	2.483

	14
	2.473
	2.484
	2.495


Improving Transfer Range

The following tips may help in increasing the transfer range or the signal strength and signal to noise ratio which can help improve the transfer rate.

· Put the router or access point close to the centre of the area to cover. 

· Reduce the distance between the wireless devices. 

· Keep wireless devices in line of sight, as much as possible. 

· Place routers and access points high, and as clear of obstructions as practical. Try to keep antennas at least a metre away from metal fixtures.  Note that antennas on roofs do not necessarily give the best results. 

· Keep routers, access points, and antennas away from large amounts of water such as fish tanks and water coolers. 

· Put routers and access points near windows only if you want to communicate between buildings. 

· Avoid the weaker signals heading downward from routers and access points. 

· If there is a removable antenna, make sure it is fastened securely. 

· For outdoor mounting of antennas note that the coax RF cable should be kept as short as possible to minimize RF loss.  Note that the length of cable that comes with the antenna is often optimized.

· Put antennas as close to vertical as practical. 

· If there are possible interfering devices nearby (such as mobile phones or microwave ovens) try changing the equipment to use another channel. 

· If there are more than one wireless routers in range of each other, space the channels out as much as possible. E.g., for two routers, choose channels 1 and 11. For three routers choose 1, 6, and 11. 

· Use access points in areas without coverage. 

· In highly critical situations professional installers may be able to help by doing a site survey and following professional installation processes.

Glossary

	Bridge
	A device which forwards traffic between network segments based on data link layer information.

	ICMP
	Internet Control Message Protocol

	IP
	Internet Protocol

	LAN
	Local Area Network

	MAC
	Media Access Control

	Ping
	A software application used to determine whether two network devices are capable of communication.

	RF
	Radio Frequency

	Router
	A device in a network that handles message transfer between computers.

	SSID
	Service Set Identifier

	S/N
	Signal to Noise Ratio

	TCP
	Transmission Control Protocol

	TFTP
	Trivial File Transfer Protocol

	UTP
	Unshielded Twisted Pair

	WEP
	Wired Equivalent Privacy

	WPA
	Wireless Protected Access

	WLAN
	Wireless Local Area Network


LAN/WLAN File Transfer Software (X-Communicate)  

Introduction
The X200 Digital Video Recorder includes Ethernet local area networking (LAN) technology.  It also incorporates a TFTP (trivial file transfer protocol) server which allows the stored video files to be downloaded using either a hard-wired, or wireless, network connection.  The files can be accessed and downloaded using any TFTP client application.

X-Communicate is a simple TFTP client application which runs under the Windows operating system to allow the listing and transfer of files from the X200.  The screenshot below shows how the application appears during file download.
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Quick Start

To download a video file from an X200 follow the steps below:

· Start the X-Communicate application

· Enter the X200 IP address in the host IP address field.

· Click Connect, wait until communication has been established (files displayed).

· Select the required file (scrolling through the pages if necessary)

· From the menu, select File and then Download.

· Select a local name for the transferred file.

· Wait as the file is transferred, the flashing down arrow indicates file transfer activity, there is also a progress bar and a percentage complete figure.
Menus (File, Option, View, Help)
The menu allows the user to configure and control the X-Communicate application.  Each of the menus and options are detailed below:

File

Download - This menu selection is enabled when a file has been selected (highlighted) in the File Listing Area.  When selected, a dialogue is displayed which prompts the user to select the name of the file to be used locally.  By default, the same filename as on the X200 is displayed.
If the file with the same already exists then the user is prompted to confirm that it is their intention to overwrite that file.  Note that it is also possible to initiate a file download by double clicking the required file in the File Listing Area.
Exit - Selecting this option closes the X-Communicate application.
Options

Multiple Acknowledgments - File download from the X200 using TFTP is accomplished by the transfer of a number of blocks, each of which is acknowledged before the next is sent.  To speed up transfer, the protocol permits a number of blocks to be in transit which have not been explicitly acknowledged.  This approach can improve transfer rates and so the default is for it to be selected.
1024byte Blocks - The X200 implementation of the file transfer protocol supports different size blocks.  If this option is selected then blocks of 1024 bytes will be transferred; if it is deselected then the files will be transferred in blocks of 512 bytes.  In general, the larger block size will incur less overhead if the transfer of data is reliable and so will give better transfer rates; hence, this is the default.

View

Small Icons - Selecting this option displays the files on the X200 as small icons.
Icons - Selecting this option displays the files on the X200 as large icons.
List - Selecting this option displays the files on the X200 as a list.
Details - This view option is the default.  Selecting it displays the files on the X200 with details including:

· Filename

· Creation Date and Time

· Modification Date and Time

· Size (in bytes)
Refresh - The X-Communicate application interrogates the number of files on an X200 when it firsts connects.  To update the file listing, or to re-establish connection with an X200 which may have been temporarily disconnected, select this menu option.
Help

About - Selecting this option display a dialogue window displaying the application name.  The version of the application also appears in the dialogue.  In the example below, the version number is 1.2.

X-Communicate Window

File Listing Area

The file listing area displays the files stored on the remote X200 that are available for download.  Using the menu View options, the files can be displayed as small icons, large icons, in a list or with details including creation and modification time and file size.

A file must be selected in the file listing area before it can be downloaded.  Double-clicking a file will initiate the file transfer process.

Where more files are available than can be displayed in the file listing area, the vertical scrollbar to the right can be used to move between pages.
File Indicator

This field shows the number of files available for download on the remote X200 specified by the entered IP address.
Page Indicator

This field shows the current and total page numbers.  Use the vertical scrollbar to the right of the File Listing Area to move between pages.
Host IP Address

Each device connected to a network must be configured with a unique IP address.  Enter the IP address of the X200 you wish to connect to in order to download video files. Click the Connect button to connect to the unit specified.
Status Line

Displays any status messages should the X-Communicate application be unable to connect to the specified X200 and also the transfer rate and time remaining during file download.
Transfer Progress

A progress bar and a percentage indicator update as a file is downloaded.
Cancel Button

During file transfer, the download can be aborted at any point by selecting the cancel button.
Glossary

	IP
	Internet Protocol

	LAN
	Local Area Network

	TCP
	Transmission Control Protocol

	TFTP
	Trivial File Transfer Protocol
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LAN/WLAN Automatic Download System (LANLink V2.1)

AVAILABLE ONLY FROM BRIGADE AUTHORISED SYSTEMS INTEGRATORS. READ INSTRUCTIONS BEFORE INSTALLING SOFTWARE
The LANLink system is designed to provide automatic download from a number of X200 Digital Video Recorders which are connected either permanently or intermittently to a dedicated LAN/WLAN infrastructure.

A suitable network infrastructure must be in place to utilise LANLink, the details of which will depend on the application in question.  It is recommended that such a system is only specified, installed and configured by a specialist in this field. For large installations, consideration of download time should be given and suitable hardware/software put in place to ensure the X200 is available e.g. a power timer to keep a unit on when a vehicle returns to base.

LANLink requires a dedicated server PC connected to the network which will act as a control point and storage device for downloaded files.  

Installing LANLink
1. LANLink will currently only run on Windows XP Professional (IE6 or later)

2. LANLink requires the Windows Internet Information Services (IIS) component to be installed before installing LANLink.  
3. LANLink runs on the Microsoft.net framework and this will be installed during the LANLink installation if not already present on the host PC.
4. After successful installation of LANLink, the following folder structures must be created and shared (read only) on the local hard drive of the LANLink server; C:\Lanlink\jobs & C:\Lanlink\safetylink. 

5. Give the ASPNET user on the local machine FULL READ/WRITE access to c:\program files\LANLink2\Database.
To check whether IIS is currently installed on the PC

· Open Control Panel and go to Administrative Tools.  If IIS is currently installed there should be an IIS shortcut present.  If there is no IIS shortcut present then IIS will need to be installed before LANLink is installed.
To install IIS

· Open Control Panel and go to Add or Remove Programs.  

· Select the ‘Add/Remove Windows Components’ button. 
· Check the box next to ‘Information Services (IIS)’ and then select ‘Next’. 
· IIS installation should start.  Please note that the Windows XP Professional or Vista Installation CD may be required during this process.

To install LANLink

· The setup program should auto-run when the LANLink CD in inserted into the PC.  If it does not, locate the contents of the CD and double-click the file ‘Setup.exe’.

· If Microsoft.net is not installed on the PC LANLink will install it. This may take some time to finalise and configure, and the PC may need to restart during this process.  Installation will automatically continue after the restart. 

Note - Previously installed LANLink engine may need removing before upgrading: Start > Run > cmd. Type command:   sc delete "LANLink Engine"
Running LANLink
The user interface of LANLink is presented as a series of web pages served directly by the host PC.  A shortcut to the main page is accessed via Start > Programs > LANLink2 > LANLink2.  Shortcuts to this or any of the other pages can be created and placed on the Desktop for ease of use.

The LANLink Engine Service runs in the background to provide communication between the various parts of the LANLink system.  This must be started in order to view units and download files.  The only time the Engine Service needs to be stopped is before adding new units to the LANLink database.

Before any X200’s can be accessed with LANLink they need to be entered into the LANLink Database.  This stores and links the unit ID, serial number and IP address of the recorder so that the user can identify which unit is to be contacted.

It is therefore imperative that each X200 to be used with the LANLink system has a unique IP address (configured via the X200 menu system) and user ID and that a clear record is kept of which IP addresses correspond to which installations.

By default the X200 menu settings stop the X200 from recording (if it was already doing so) whilst LAN file transfer is taking place.  Recording will resume after file transfer has ceased.

It is possible to enable recording whilst LAN file transfer is taking place but this will have a negative impact on the file transfer speed.  To enable simultaneous recording and LAN file transfer the ‘RECORD DURING TRANSFER’ option in the LAN menu must be set to ‘YES’ in the X200 menu system.

Viewing the current status of units managed by LANLink

To view all of the X200 recorders currently listed in the LANLink database, press the ‘View Units’ button on any of the LANLink pages to go to the List Units page.  On the List Units page all of the recorders will be listed by their unit name, with their current status shown.
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Status’s: Home means that the X200 is currently connected to the LANlink system and not currently downloading any files.  Away means that the X200 is currently not connected to the LANLink system.  The following mean that the X200 is currently connected to the LANLink system and is downloading files to the server PC; Downloading files, Downloading alarm files, Downloading ext files, Getting health log, Getting file list.
Each time a unit comes into range of the LANLink system the service log is interrogated to determine its health.  A traffic light system is used to display the current status of each unit.  See the above image for different health status.

It may be helpful to view the service log to determine what the likely fault may be and assess its seriousness.  To view the service log for a unit simply click on the round traffic light indicator and it will be displayed.

Entering Units into the LANLink Database
Each X200 Recorder that is to be used with the LANLink system first needs to be entered into the LANLink Database.

Before any units are entered the LANLink Engine Service must be stopped if it is already started.  To do this go to Start > Programs > LANLink > Stop LANLink Engine Service.

It is then necessary to open the main LANLink web page.  To do this go to Start > Programs > LANLink > LANLink.  The default ‘List Units’ page should open.  Click on the Add/elete Units in the Administration links section at the bottom of the main View Uints page.

This will open the following browser window.

[image: image72.jpg](2 Units Admin - Windows Internet Explorer

&) hitp:/flacalhastLANLnkServer adminunt v | | 9| K | |Lve Search

Fle Edt View Favortes Took Help

Y | @uns adnin

1P Address

10.0.0.222 Delete Unit

| & Local ntranet. | ®100%





To add a new unit left click the Add New Unit button on the left hand side of the window.  

The details for the recorder can now be entered in the three text fields shown.

· Unit Name – This is the user defined name for the X200 in question.  It can be any combination of letters and numbers such as the vehicle number or a site reference.

· Unit Serial Number – The serial number of the recorder. (optional)

· Unit IP Address – This is the address which identifies the recorder to the system and must match with the IP address set on the recorder in question.  The IP address must be unique for each recorder.

Once the details for the unit have been entered left click the Add New Unit button at the bottom left hand side of the browser window.  The original browser window will then appear with the recently added unit now shown in the list of units on the system.

To delete a unit from the list left click the Delete Unit button next to the unit in question.  The following window will appear.
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Left click the ‘OK’ button in order to permanently delete the unit from the system or click the ‘Cancel’ button if you do not wish to delete the unit.

Configure LANLink

Automatic downloading of Alarm files can be enabled through the LanLink Configuration screen. 

Once an alarm file has been successfully downloaded, its write protection is removed on the cartridge. This allows the alarm files to be overwritten and therefore does not reduce the storage capacity of the cartridge.
Other user configurable options can be seen below;
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Ext and External options are only relevant if you are using them through the RS232 interface..
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Target Folder Location

The target folder is where downloaded files end up. The
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« alarms
« extemal

SafetyLink Target Folder Location

The Safetylink target folder is where LANLink stores the
downloaded file regions created for footage which exceeds
the g-force thresholds.

SafetyLink Breaking Threshold

™ Maximum allowed g-force for breaking before LANLink
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automatically downloads the footage into SafetyLink.
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safetylink.
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10.

Update Settings
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button. You vill be prompted to confirm your changss

To avoid making any changas, just dlick on the Cancel button. You vill rsturn to the main Admin pags.
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SafetyLink threshold details can be entered here (for use with SafetyLink application and XP200 hardware, see SafetyLink section for further details.
Listing the files on an unit

To view the file list of a particular X200 open the main LANLink window (View Units) and left click the ‘View Unit’ button to the right of the recorder ID, the file list of the X200 will then be shown.

Please note, by clicking 'Filename' header text in the file list pages, will reverse the default sort of old -> new, it brings the newer files on page 1. This can be also done to sort by size and status
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If the X200 is currently home or downloading then the file list will match exactly with the files that are currently stored on the installed Hard Disk Cartridge.

If the X200 is currently away then the list shown will consist of the files that were present on the X200 the last time it was home.  Please be aware that some files may have been overwritten by the time it is next home, and new files may have been added.
Downloading Files with LANLink

LANLink downloads files from the X200 using a job system.  Each job is given a name and specifies the files to be downloaded with a priority level. The priority level ranges from 1 to 3, with 1 being the least important.  This allows the LANLink system to decide which jobs to process first if multiple jobs exist for a unit.

Files to be downloaded can either be individually selected from the file list of a particular recorder or by specifying a start date and time and end date and time for the footage required.

To download files directly from the file list, view the file list of the X200 in question and then place a check next to any files that should be downloaded then click the ‘Download Files’ button at the bottom of the file list.

Enter the job name and select a priority level in the job window that appears and then left click the ‘Confirm Job’ button at the bottom of the window.  If the details are incorrect then the job can be cancelled by left clicking the ‘Cancel Job’ button.
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To download files from a specified period go to the List Units page and place a check next to the X200’s in question then click ‘Add New Job’ button at the bottom of the window. 

Enter a job name, priority level and select the start and end times and dates required. Calendar buttons can be found on a right side. Then left click the ‘Confirm Job’ button to activate the job.

To view the status of current jobs left click the ‘View Jobs’ button in any of the LANLink windows then select the unit/job you wish to view. The following will then appear;
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Downloading % changes dynamically as job progresses

Retrieving downloaded files

By default all downloaded files are stored in the folder C:\lanlink\jobs
Sub folders inside the jobs folder will be created for each job and again for each unit which has been used in that job.  The downloaded files will be contained in these folders and once located the files can be moved and copied as required.

Once completed the ‘View Job’ window should indicate that all of the files specified in the job are 100% downloaded.

Alarm and EXT files are downloaded to c:\lanlink\alarms & c:\lanlink\external.

To view the files for any completed job click the ‘Open Folder’ button next to one of the downloaded files from that job.

It is important that the main jobs folder has sharing enabled so that it is possible to view and retrieve the downloaded files from the LANLink window once the job has been completed.  

If the jobs folder is not shared or the user lacks the necessary permissions then certain tasks may not be allowed by Windows. Such is a ‘Open Folder’ link

Older LANLink installations may have used the c:\jobs folder as opposed to the current c:\Lanlink\jobs. If this is the case the previously downloaded job files may still be in the old folder. If required, these can be copied into the new location. 
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LANLink Security
The Security system can be accessed from the main View Units page by clicking the Configure Security link under Administration. 

From this page security can be enable or disabled and multiple users can be added or deleted. Once enabled, access to the system is only allowed by entering a valid username and password.

When adding a new user you are required to enter a username and a password. 

It is possible to assign different users with different access rights. For example the Admin user can use all functions, however you may want to add an operator who can only view jobs but not change them. The following page shows the rights that can be assigned;
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GSM / 3G - Mobile Access 
(RemoteLink)
Introduction

RemoteLink is a PC facsimile of the hand-held X201 Reviewer which allows the user to connect to a remote X200 unit via serial (RS232), LAN and GSM modem interfaces  (including UMTS, EDGE, 3G, GPRS and GSM wireless routers), and control it as if using an X201 Reviewer. 

All features of the X201 Reviewer are supported (except Motion Detection edit/view Mask).  Menus can be accessed and modified, live video displayed (please note that via GSM the X200 video switcher dwell times will be multiplied by 10 in order to take into account the inherent time delay in the GSM connection) and recorded footage viewed.

The user can connect to any number of X200’s in turn from a single remote location allowing checks and menu changes to be done when recorders are in operation and not currently accessible to an operator equipped with a Reviewer.

The X200 can be contacted whenever it is powered and wherever a connection is available.  


RemoteLink Quick Start

1. Go to the File menu and select Connect To Unit
2. Add a new unit using either an IP Address, Phone number or Com port.
3. Highlight the unit you wish to connect to and click the Connect button (alternatively you can double click the unit.
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The units can be ordered by each of the column headings, Name, Number or Type. The last unit connected to will be highlighted.
The Options button will open a dialog for you to select which modem you wish to use (if connecting via dial-up/GSM). This list is populated from the operating system, Windows. You can add new modems through Windows control panel.
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A character set option is included for switching between eastern and western European character sets (used in conjunction with an X200 language file).

RemoteLink in Detail
If the user is familiar with setting up the X200 using an X201 Reviewer there is little further to learn - you have the same functionality but remotely.  The software allows the PC to remotely connect to an X200 unit and once the connection is made the control is as the Reviewer.

Keyboard controls;

· Arrow keys can be used  to navigate the menu system. 

· Esc key mimics the Exit button on the review/RemoteLink. 

· Number keys 0-9 can be used to select cameras and input data. 

· F1 is used for displaying help and switching to cameras 9-16 (T516 only). 

· R = record

· K = play

· J = reverse play

· L = fast forward

· H = rewind

· Space = Stop/Jog
· F5 = refresh

It is important to bear in mind that when using GSM the data rate is 920 bytes per second (a typical full image is 50,000 bytes) so playing back images, or displaying a live view takes time.

For a direct serial connection the X200 serial connector on the rear of the recorder will need to be connected to an available serial port on the PC.

Please note that as the GSM modem and GPS receiver (if used) require the use of the serial port on the rear of the X200, neither of these devices can be used whilst a direct serial connection is made to a PC.

Connecting to the X200 via a Direct Serial Connection

To connect to the X200 simply use a null-modem serial cable from the X200 serial (RS232) port on the rear of the recorder to an available serial port on the PC.  As the direct serial connection mimics the GSM modem connection (also available using RemoteLink) the ‘RS232’ option must be set to ‘GSM CONTROL’ in the X200 ‘REMOTE SETTINGS’ menu.

Start RemoteLink and go to File > Connect to unit and select the appropriate COM port for the serial connection to be made from.

The X200 menu system should then appear on the virtual reviewer in the RemoteLink window.  

Connecting to the X200 via a LAN Connection

To connect to the X200 via the LAN connection a suitable wired or wireless network must be present in order to allow communication between the X200 and the host PC running RemoteLink.

RemoteLink uses UDP port 5465.  Any installed network or local PC firewalls may have to be instructed to allow the use of this port to prevent communication problems between the PC and the X200.

Before a connection can be made a new unit name and IP address must be entered.  To add a new remote X200 unit to the system go to File > Connect to Unit > Add New.  The X200’s IP address can then be entered into the system (this is shown in the X200 recorder ‘LAN’ menu) and a name can be assigned to the unit for future reference.

To connect to the X200 Via the LAN interface go to File > Connect to Unit, select the X200 required from the list and press the Connect button.  

X200 LAN connections via 3G connection
The X200 provides standard network connectivity over an RJ45 10/100 Ethernet card. Many devices can be plugged into this to provide communication between the X200 and a host. For example, we have proved a 3G connection across a mobile network using Sarian devices. 
Hardware Used

HR4110

The Sarian HR4110 is a router with support for HSDPA (3.5G), UMTS (3G), GPRS and EDGE mobile data access. It has a single 10/100Mbit UTP Ethernet port that allows connection to either a single device such as the X200 or a switch/hub to allow connection of multiple remote devices. The HR4110 runs SarOS, a highly configurable embedded routing OS which allows for the configuration of VPN tunnels using IPSec encryption and very importantly NAT Traversal.

DR4410i

The Sarian DR4410i is a router with support for ADSL and ISDN data access. It has four 10/100Mbit UTP Ethernet ports that allow connection to one or more PCs or other network infrastructure. The DR4410i also runs SarOS, enabling configuration of VPN tunnels. 

If greater than 40 remote VPN tunnels are required then there is the Sarian VC5100 VPN Concentrator which can support up to 1500 VPN tunnels.
The Sarian HR4110 3G wireless bridge connects to the X200 and communicates via a secure VPN to a host Sarian DR4410 device back at base. 
Brigade software products can then be used to contact the X200 via IP as you would in a local network environment. 
Speed and connection consistency are reliant on the mobile network and the subscribers quality of service with their own service provider.

Example setup;
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Connecting to the X200 via a GSM Connection

GSM connection to the X200 requires the use of a GSM modem attached to the X200 via a serial connection.  The PC dials the GSM modem using the analogue data number of the installed SIM card which may differ from the SIM cards normal phone number as used in a mobile phone.  Please contact the SIM card supplier in order to obtain the analogue data number required (this may not be available with all SIM cards and networks).

Before connection can be made using a GSM connection the X200 in question must first be entered into the RemoteLink system.

To add a new GSM connection go to ‘Tools’ > ‘Manage Connections’ and select ‘Add New’.  In the box that appears enter the analogue data number of the SIM card in the GSM modem attached to the X200.  A name describing the connection is also added for future reference.

To connect to the X200 via the GSM connection go to ‘File’ > ‘Connect to Unit’, select the unit in question from the list and press the ‘Connect’ button.  The unit will be listed by name and phone number.

The PC’s modem should then dial the remote unit and make a connection, the X200 menu system should then appear on the virtual reviewer in the RemoteLink window.  Use the mouse to click on the appropriate keys as if as per normal operation of an X201 Reviewer.

If the PC has more than one dial-up modem installed the appropriate one can be selected by going to ‘Tools’ > ‘Options’ and selecting the modem from the list marked ‘Modem Connection Using’.

Ensure that the modem connection speed is set to 9600 or 19200. Please refer to the manufactures manual for your particular model or modem.
Hardware Required for GSM Connection

GSM modem (See recommended modems below, dual-band model suitable for UK and European use)
SIM card (pre-inserted into GSM modem above)

Antenna for GSM modem

Serial cable (see specification below)

Power supply for GSM Modem

X200 with latest software

PC with dial-up modem connected to phone line able to make outgoing calls. 

Making a GSM-to-GSM connection
It is also possible to use another GSM modem to dial out from a laptop computer. For example, connect a 2nd Siemens modem (and SIM) to a com port on the laptop, add the modem into Windows modem device manager, then within RemoteLink select the modem from the Tools, Options menu, then connect as per the section above. To add the device in Windows;

· Goto Start>Run, type telephon.cpl
· Click the Modems tab
· Click the Add button
· Check the box "Don't automatically detect, I will pick from a list"
· Select "Standard modem" on the left, then 9600/192,000 on the right
· Click Next
· Pick your com port that the modem is connected to
· Click Finish.
This connection method can also be achieved using a mobile phone, attached to the laptop via a Bluetooth connection (subject to mobile phone/laptop capabilities).
Specification of Cabling

RJ12 Power Cable

Pins

Connect to


Function on modem

1

12V



+V

2

12V



free

3

GND



PD_IN (reset input active high)

4

12V



IGT_In (Ignition input active high)

5

GND



free

6

GND



GND

RS232 Serial Cable

Female DType9


Male DType9

Connected to X200

Connected to GSM modem

Pin



Pin



Function

1



1 



DCD

2



2



RX

3



3



TX

4



4



DTR

5



5



GND

6



6



DSR

7



7



RTS

8



8



CTS

9



9



RI

Installation

1 Configure the SIM card

A SIM card needs to be plugged into the GSM modem for it to work.  The SIM card provides the GSM modem its identity i.e. its phone number and any account information that may be needed.  You may need a mobile phone to configure the SIM card.  

RemoteLink requires the user to obtain the analogue data number for the SIM card. The analogue data number is what Remote Link dials to access the GSM unit.  Remote Link cannot use the normal mobile phone number that comes with the SIM, but needs a specifically assigned data number obtained from the SIM card provider.
Brigade have only used Vodafone SIMs for which an analogue data number is obtainable from Vodafone (correct as of May 2005).  Some SIM card providers may not offer this service and it should be determined whether this is possible before purchasing a SIM card.

To obtain the analogue data number for a SIM card, contact the provider directly.  You may need to register with them and you will need to provide them with the SIM card telephone number.

You cannot use the normal mobile phone number of the SIM for GSM modem use.  You may also be given a fax number and a digital data number (ISDN number). Neither can be used for the RemoteLink application.  

To activate the SIM you will usually need to put it into the mobile phone and make a call to any phone number.  Someone should pick up the call.  This initiates the SIM into activity.  

If you are dealing with multiple modems it is recommended that you keep a list for each SIM of the SIM number (written on the SIM,  24 - digit) and analogue data number and normal phone number.  If a modem doesn't answer, the SIM provider may be at fault - to fix it they will need this information.

Some SIM cards may expire after 3 months or 6 months if no outward calls have been made.  It is essential that either the SIM you are using does not expire or the X200 is set to send an SMS message at an appropriate interval.  This is set in the SMS OPTIONS sub menu accessed via the REMOTE SETTINGS menu in X200 software V1.3.0 or later.

Sending an SMS message from the X200 in order to keep the SIM card from expiring will be a chargeable event.  Please ensure that there is sufficient credit on the SIM to send an SMS message at the determined intervals.

2 Insert SIM card into GSM modem

Press in the little button on the side of the SIM tray using a pen.  This pushes the SIM tray out.  Remove the SIM from the mobile phone and place it into the SIM tray and slide the tray back into the GSM modem.

3 Connect modem equipment

Connect the modem equipment as shown in the diagram below:


The X200 system can now be switched on, it is ready for dial up.

Ensure that the modem connection speed is set to 9600 or 19200. Please refer to the manufactures manual for your particular model or modem.
Recommended Modems

These are modems that we’ve tested here:

· Siemens TC35 & TC35i (TC35i requires 19200 baud rate)

· Siemens MC35 & MC35i (MC35i requires 19200 baud rate)
· Fargo Maestro 20
RS232 External Control

The X200 software includes external control via RS232 (rear connector) and provides two enhanced features. 
The first is File via RS232, which allows files to be created on the X200 hard drive, and read back using the RS232 port on the back of the X200.  
The second is Control Commands via RS232. This allows many playback and recording functional commands to be carried out by an external device via the RS232 port.
These two features are enabled under the REMOTE SETTINGS menu, by selecting either GSM CONTROL or EXTERNAL CONTROL, for example:

RS232: >GSM CONTROL

(default)

RS232: >EXT CONTROL 9600 BAUD
external control at 9600 baud 

Baud rates of 2400, 4800, 9600, 14400, 19200, 38400, 56000, 115200 can be selected.  The external commands operate over RS232 port 1 on the rear of the unit.  This port is also used for GSM modem control.  GSM control cannot be performed at the same time as external control.  

Some modern PCs do not come with a serial port, you can however use a USB Serial Adaptor.

Two adaptors that we have tested here are: 

· NEWLink – www.newlinkproducts.co.uk
· FTDI - FT232R – www.ftdichip.com 
The COM port number will vary depending on your PC and which cable you have 

For example: on a laptop tested here the NEWLink cable was assigned COM10. 

A simple test to check connectivity between PC and X200 you can try following within Windows HyperTerminal;

Connect the cables from PC to X200

Make sure that X200 is powered up, installed and switched on

Create a new connection

Connect using COM10 (replace 10 with your own COM number) 

Bits per Second – 115200 

Date bits – 8 

Parity – None 

Stop bits – 1 

Flow control – Hardware 

Clicked File > Properties 

Select the Settings tab 

Click ASCII Setup > Tick the “Echo type characters locally” check box 

Then in the main window type #HANDSHAKE – you should receive OK.

Introduction
Handshaking
To check communication with the X200, send #HANDSHAKE<R> and the unit should return OK<R> back. This is a good idea before starting any other commands.  It is not a requirement for operation.

The protocol that follows can be operated handshake free, that is commands issued and no response monitored.  Alternatively the remote device can monitor the OK<R> messages that are returned.

Tokens
The X200 is always looking for tokens to perform actions.  It is usually looking for all the tokens apart from when writing file data.  In this case only the “#ENDFILE<R>” is searched for.
Definitions

_

- A space

<>

- Parameter, don’t include brackets
<R>

- return (char 13)

FAIL1

- File system failed to create file, aborted

FAIL2

- File name is illegal

OK

- Acknowledgement, Command carried out
CLIENT
- The external equipment that is connected to the X200 via RS232

BAUD Rate 
- This shall be selectable from within a menu
<TEXT>
- Textual data
X200 File Via RS232
Writing files

Write File command: 
#WRITEFILE,<FILENAME><R>

Close File command: 
#ENDFILE<R>
A return <R> character at then end of the “#WRITEFILE” command will signify the beginning of the writing process. All data from this point onwards will be written into the file specified.  

If the file system fails to create the file for any reason, FAIL1<R> will be returned to the client. 

A check is done on the file name length, if the user overruns (number of characters in total is greater than 60), FAIL2<R> will be transmitted to the client, and the write command is aborted.  The user should only use uppercase letters and numbers in the filename and the space character.  The extension “.EXT” is automatically applied by the X200, for example

Command





Created file

#WRITEFILE,REPORT<R>



REPORT.EXT

#WRITEFILE,TICKET DATA 3 OCT 2005<R>

TICKET DATA 3 OCT 2005.EXT
If the file has been created effectively, OK<R> will be sent to the client. The client may now proceed to send the file data.

When the token #ENDFILE<R> is received, the file is closed, and the client will be sent OK<R>. A new file may now be opened if required. In the example below, all the text in BOLD is written to the file “TICKETS.EXT”
#WRITEFILE,TICKETS<R>

DATE: 7/09/2005

TIME: 11:48:00

LOCATION: KINGS CROSS

#ENDFILE<R>
Reading files

Read File command:
 #READFILE,<FILENAME><R>
A return <R> character at then end of the #READFILE<R> command will signify the beginning of the reading process. Data will now be transmitted from the X200 to the client.  The handshaking line CTS on port 1 may be used if required to pause the data flow.  If the file system fails to open the file for any reason, FAIL1<R> will be returned to the client. A check is done on the file name length, if the user overruns, FAIL2<R> will be transmitted to the client, and the read command is aborted. If all is good, OK1<R> is sent followed by the file data followed the token #ENDFILE<R>.  The following example reads the file “TICKETS.EXT”.

Sent to X200


Received from X200
#READFILE,TICKETS<R>
DATE: 7/09/2005




TIME: 11:48:00





LOCATION: KINGS CROSS




#ENDFILE<R>

X200 Control Commands Via RS232
Handshaking
All commands sent to the X200 are acknowledged, for example if the client sends #RECSTART<R>, OK<R> will be returned to the client to signify that the command was successfully carried out. In the case of commands like GETTIME and GETDATE, OK<R> will not be returned, but the data requested, followed by a <R>. In the case of PREVIOUSFILE and NEXTFILE, OK<R> will be replaced with either LAST<R> or FIRST<R> if there are no more files to play next or previous, respectively. When sending commands, the sender to the X200 can wait for an OK before sending another command, or one of the other variants listed above.

Delay between commands
There may be a need for a hold off time between certain commands (e.g 10 mS), as the X200 may take a finite time to do certain tasks.  To add delay you could simply put spaces between one command and the next and these are ignored. The X200 does have a FIFO queue of 2048 bytes so can buffer data.  Certain commands can be followed immediately with other commands for example:

#CAMERA_<1-16><R>#PLAY<R>



-play a given camera

#SETTIME_<12:23:45><R>#SETDATE_<23/09/05><R>

-set time and date
Recording
If for any reason recording stops, even if instructed to, the X200 will return #RECSTOP<R>
#DISKREMOVED<R> will be sent under two conditions.

1) The disk is removed from the X200 at anytime post X200 initialization.

2) Live view always has been enabled and the X200 boots without a disk.

#DISKIN<R> will be sent under two conditions.
1) The disk is inserted into the X200 at anytime post X200 initialization.

2) Live view always has been enabled and the X200 boots with a disk.

Control Commands
#RECSTART<R>


- start recording

#RECSTOP<R>


- stop recording

#STOP<R>



- stop playback

#PLAY<R>



- start playback (standard)

#REPLAY<R>



- play backwards (standard)

#WIND<R>



- fast forwards (standard)

#REWIND<R>



- rewind (standard)

#XPLAY_<FACTOR><R>

- plays at the specified factor speed (-/+)

#CAMERA_<1-16><R>


- camera to control

#LIVEVIEW<R>



- switch to live view

#AUTOLIVEVIEW<R>


- switch to live view automatic mode

#JOGFORWARD<R>


- one frame backwards

#JOGBACKWARD<R>


- one frame forwards

#GOTONEWESET<R>


- go to the newest recording

#GOTOOLDEST<R>


- go to the oldest recording

#GOTO_<DD/MM/YY_HH:MM><R>
- go to time DD:MM:YY_HH:MM
#GOTO_<DD/MM/YY_HH:MM:SS><R>
- go to time DD:MM:YY_HH:MM:SS

#SETTIME_<HH:MM:SS><R>

- sets the time


#SETDATE_<DD/MM/YY><R>

- sets the date

#GETTIME<R>



- gets the time


#GETDATE<R>



- gets the date

#NEXTFILE<R>


- when playing, skips to the beginning of the 







next file


#PREVIOUSFILE<R>


- when playing, starts at the beginning of the 




currently playing file. When stopped and 




#PREVIOUSFILE is issued twice, followed by 




a play, the previous file will begin playing from 




the beginning.

#GETFILETIMEDATE
- gets the current playing position of the currently play file.
#GETSTATS



- returns statistics

#DELETEALLREC


- removes all recording files from disk
#LED1_0/1



- Turns LED 1 output ON (1) or OFF (0)

#LED2_0/1



- Turns LED 2 output ON (1) or OFF (0)

#ALARMOUT_0/1


- Turns ALARMOUT LED Output ON (1) or 





OFF (0)
#ALARMIN1_0/1


- Sets the state of the Digital input 1 ON(1) or 





OFF(0)

#ALARMIN2_0/1


- Sets the state of the Digital input 2 ON(1) or 





OFF(0)

#ALARMIN3_0/1


- Sets the state of the Digital input 3 ON(1) or 





OFF(0)

#ALARMIN4_0/1


- Sets the state of the Digital input 4 ON(1) or 





OFF(0)

#CAMTEXT_<1-16>_<TEXT><R>
- Writes text to the console at record time, Char 255  moves to the beginning of a new line. Maximum 49 characters per camera.

#DISKSTATUS
- Returns #DISKREMOVED or #DISKIN to signify the disk status.
#MODESTATUS
- Returns #RECORD, #PLAY or #IDLE to signify the status of the X200.

#SETCAMTEXT_<1-16>_<TEXT><R>
- sets the camera text as via the Camera Options menu on the x200. 1-16 is the camera selection followed by the actual text. This is fixed to 12 characters per camera.

#SETFILETEXT_<TEXT><R>
- sets the filename text for the x200 file system to use. Max 12 characters.

#LOGRESET<R>
Resets the service log

#LOGREAD<R>
Reads the service log and returns up to the 10 latest entries

The following are variants of existing commands and are for reading their values.

#LED1<R>



- Returns the status of LED1, Returns 0 or 1

#LED2<R>



- Returns the status of LED2, Returns 0 or 1

#ALARMOUT<R>


- Returns the status of ALARMOUT, 0 or 1
#ALARMIN1<R>


- Returns the status of ALARM Input1, 0 or 1
#ALARMIN2<R>


- Returns the status of ALARM Input2, 0 or 1
#ALARMIN3<R>


- Returns the status of ALARM Input3, 0 or 1
#ALARMIN4<R>


- Returns the status of ALARM Input4, 0 or 1 

#MULTIVON<R>


- Turns Multiview On
#MULTIVOFF<R>


- Turns Multiview Off
#LOG_<TEXT><R>
- Logs a text message to the X200’s service log (does not light service LED). Sending RESET LOG  as the text marks off there LanLink should read the messages up to. OK<R> is returned if the daily quota of 10 has not been reached, other wise 10/DAY<R> is returned
Command in Detail

#GETFILETIMEDATE
Gets the current playing position of the currently playing file. Please use #MODESTATUS to tell if the time you are reading is live play or if in idle mode, as the time you receive will ways be the current/last position played.
#GETSTATS 

Will return the following stats in the same format. #END<R> signifies end of file. The stats may possibly grow in the future, but will be append to this list. Scanning for #END after the data has been retrieved. Data may be scanned for by capturing just after the colon (:) and just before the end of line <R>

Capacity: 30.01GB

Used: 0%

Write Protected: 0%

First File: DD/MM/YY_HH:MM:SS

Last File: DD/MM/YY_HH:MM:SS
 
Model Number: model number
Serial Number: serial number
#END<R>

#DELETEALLREC
The #DELETEALLREC command will stop the current recording and delete all recording files. When complete, OK<R> will be returned

#LED1, #LED2, #ALARMOUT 

The following 3 commands control the 2 digital outputs and the Alarm output. These settings will be OR’d with the current hardware states of the X200.

#LED1_0/1<R> – Turns LED1 ON or OFF

#LED2_0/1<R> – Turns LED2 ON or OFF

#ALARMOUT_0/1<R> – Sets the active state for the alarm output CLOSE/OPEN.

The following commands will READ the status of the LED and ALARM out ports:

#LED1<R> - Returns the status of the LED1 port, 0 = off, 1 = on

#LED2<R> - Returns the status of the LED2 port, 0 = off, 1 = on
#ALARMOUT<R> - Returns the status of the ALARMOUT port, 0 = off, 1 = on
#ALARMIN1, #ALARMIN2, #ALARMIN3, #ALARMIN4

Each one of the alarm inputs can be virtually activated by using the following commands, which control each alarm input independently. These settings will be OR’d the current hardware states of the X200.

#ALARMIN1_0/1<R>
#ALARMIN2_0/1<R>
#ALARMIN3_0/1<R>
#ALARMIN4_0/1<R>
By using these commands, a camera may be assigned to each alarm input, thereby allowing recording on each channel to be selective and/or allow for a different set of recording rates between Normal and Alarm recording

The following commands will READ the status of the ALARMIN pots:

#ALARMIN1<R> - Returns the status of the ALARMIN1, 0 = off, 1 = on

#ALARMIN2<R> - Returns the status of the ALARMIN2, 0 = off, 1 = on

#ALARMIN3<R> - Returns the status of the ALARMIN3, 0 = off, 1 = on

#ALARMIN4<R> - Returns the status of the ALARMIN4, 0 = off, 1 = on

#CAMTEXT

#CAMTEXT_1_HELLO WORLD<R>

- “Hello world” will be written at the top left 





hand corner

#CAMTEXT_3_<255><255><255>HELLO<R>
- “Hello” will be written on the 4 line on camera 





3

If text has been assigned to a camera, simply issuing blank text will clear all RS232 overlay text from that camera. A maximum of 49 characters may be sent to the screen including new line control codes. E.G #CAMTEXT_3_<R> will clear the text (please note the space after 3)
#SETCAMTEXT_<1-16>_<TEXT><R>
Sets the camera text as via the Camera Options menu on the x200. 1-16 is the camera selection followed by the actual text. This is fixed to 12 characters per camera.

#SETFILETEXT_<TEXT><R>
sets the filename text for the x200 file system to use. Max 12 characters.

#LOGRESET<R>
Resets the service log

#LOGREAD<R>
Reads the service log and returns up to the 10 latest entries

Examples
CAMERA_1<R>

switch to camera 1 (either in live/auto view or during playback)

XPLAY_0.5<R>


plays forward at half speed

XPLAY_-3.2<R>

plays in reverse at 3.2 times real time rate

XPLAY_10<R>


plays forwards at 10x speed

SETTIME_12:23:23<R>

sets the time in the format HH:MM:SS

SETDATE_23/09/05<R>
sets the date in the format DD:MM:YY

#GETTIME<R>


to which 12:23:23<R> is returned

#GETDATE<R>


to which 23/09/05<R> is returned

#LED1_1<R>


turn LED1 on

#CAMTEXT_1_Hello><R>
writes “Hello” to the console at record time in the top left 




corner.
Note: The windows demonstration tool “Shuttle command tester” is available with source code.
XP200 Accelerometer
The Brigade XP200 Accelerometer is designed  to integrate seamlessly with the X200 Digital Video Recorder. 
Acceleration in X, Y and Z axes is stored and displayed with each recorded image and GPS position. High G events can be quickly identified and reviewed. 
All Brigade products are designed for easy integration and simple, reliable operation. In addition, the XP200 can be used to power the X200 DVR on/off when movement is sensed.
Specification

1 GND

2 12V In
12V at 50mA relay on, 12V at 10mA relay off, 6V to 18V max input, 

3 12V Out
Relay output.  Maximum switching current 8A (12V out connected to 12V in)

4 Ignition
Voltage above 4V turns relay 12V Out on.  Voltage below 4V initiates duration settable timer after which 12V Out is off (open circuit)

5 Serial Out
Connect to X200 RS232 input pin 9 (Serial Rx) 19,200 baud.

6 GPS In
Wire GPS serial output to this pin.  GPS data merged with Acceleration data and output on Serial Out.  GPS needs to output at 19,200 baud.

Connector 
3.81mm 6 way block. Farnell part no. 370-5031 (supplied with XP200).
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Operation

Minimal Accelerometer

Wire 12V in, GND and serial out.  Acceleration data sent to X200 via serial port

Accelerometer with Power Switching on vibration

Wire 12V in, GND, serial out and connect 12V out to X200 and cameras.  On any small force (e.g. vehicle motion) unit turns on relay to power system (e.g. when vehicle leaves depot).  Unit will power off after 3 hours (duration configurable) of no motion (when vehicle is stationary).  Force level to cause turn on is 0.05G on any axis.

Accelerometer with Power Switching on vibration and ignition

Wire 12V in , GND, serial out, connect 12V out to X200 / cameras and also wire vehicle ignition signal to ignition input.  Relay will power on if ignition is on or vehicle is experiencing motion.  Relay will power off after 3 hours (duration configurable) of no motion and ignition off.

Power Switching on relay input (as X100)

This may be used to turn main power on using an alarm input while consuming 10mA in standby.  The provides the low power mode similar to that built into legacy X100 units but not available on X200 units.  Wire 12V in, GND and 12V out to X200 / cameras.  Wire the relay alarm input between 12V in and IGNITION pins.

Calibration

Once the unit has powered up (noted by running LEDs from left to right, and right to left)
 

PROGRAMMING
Phase 1 - Calibrating X,Y,Z axes
1. Place the unit flat on the desk (text facing up) 

2. Holding unit steady, Press and hold the CALIBRATE button for 5 seconds until all 3 LEDs flash once (PHASE 1) momentarily, followed by a steady Z LED. 

3. Release the button, Z axis has now calibrated. Y LED will light. 

4. Place unit on its Y Axis - Y Arrow pointing downwards. 

5. Holding unit steady, Press and Release CALIBRATE button,  Y axis has now calibrated X LED will light. 

6. Place unit on its X Axis - X Arrow pointing downwards. 

7. Holding unit steady, Press and Release CALIBRATE button,  X axis has now calibrated X LED will light.

N.B. When calibrating on side, balance on main body not flange
Phase 2 - Selecting Post Motion Power on Timer
1. All 3 LEDs will flash twice. (PHASE 2) 

2. Press the button as many times as you require the units to Post Motion Trigger measured in HOURS. (1 to 10 times representing 1 through 10 hours). 

3. Once the desired hours has been selected, leave the unit alone for 5 seconds, and it will replay your selection by flashing all the LEDs the same amount of times you selected.The default count if no button(s) pressed during this time is 3 (i.e. 3 Hours) 

4. The units has now programmed - after programming no LEDs should light while on a level surface.

On all axes, if a force of greater than 0.25G is measured, the appropriate axes LED will light until less than 0.25G again. The XP200 runs at 19200 baud In-Line with GPS. GPS is NOT required, but will operate together. Select 19200 bps on the X200 GPS menu. 
Specifications
X200 DIGITAL RECORDER
Video Recording

Max Rate

25ips PAL, 30ips NTSC, shared; selectable by camera

Resolution


Low, Medium, High, V.High

TVL 



540

Pixels



720 x 288 PAL; 720 x 240 NTSC

Format                                        
MPEG - full image update or optional conditional refresh

Input Signal

4 or 16 inputs; composite video 1V p/p; colour/mono; 
PAL/NTSC 
auto-switching

Simultaneous Functions

Record, Playback, Live views, Ethernet

Recording Medium

2.5" IDE PC-compatible hard disk in customised cartridge

Recording Modes


Normal, timer, alarm, single/multi shot, loop or single pass

Alarm recordings

Post-trigger recording; show alarmed cameras live on video 
switcher, pre-trigger write protection of existing recordings

Timer recording


Weekly timer (7 day programmable) or interval timer, or both

Motion Activation


User configurable for cameras, areas and sensitivity

Embedded Text                          
Camera number, date and time plus 12 user characters for each camera; GPS* speed and position

Camera Focus Mode                 
 External indication of relative camera focus

Audio recording

Type



Mono or Stereo

Connections


2 line inputs; 2 line outputs

Sampling Rate


16kHz/8kHz

Sampling Res.


16 bits/8 bits

Max Level


Selectable: 0.12V to 2V RMS (0.35V to 5.6V pk-pk)

Configuration

Entry



Menu system with help screens; accessed (with password) by 



X201 Reviewer

Password


4 user-definable levels

Date Options


dd/mm/yy; mm/dd/yy

Summertime Correction

UK; Europe; USA; Off

File System

File Type


Proprietary ".xba", convertible (with password) to AVI

File Name


Optional file text plus date/time, for example:"Bus0034 2004 




month 08 day 16  12_30_00. xba"

File Size



10 min or 1 hour

File Protection

Write-protection via file menu; optional automatic write-
protection of alarm/shot recordings

Playback

Functions


Rewind, Replay, Stop, Play, Fast Forward, Jog mode

Image Search


Time/date or by file

Remote Operation*



Systems



Ethernet (LAN/WLAN*) GSM*, RS232

Functions


File transfer to PC (LAN/WLAN*)





Configuration of X200 (GSM*, RS232)





Shuttle commands (GSM*, RS232)





Live camera views (GSM*, RS232)





Automatic file download (LAN/WLAN*)

GPS*

Embedded Text


Position (coordinates) and speed (kph or mph)

GPS Data


Files contain GPS position/speed/time for mapping

Clock Lock


Locks X200 clock to world GPS clock

Connections/Controls
Connector Type


Cable harness (X200-16) Individual connectors (X200-04)

Video Inputs


16 on 25-way "D" connectors (X200-16) 4 x BNC (X200-04)

Video Out


1 on 25-way "D" connector (X200-16) 1 x BNC (X200-04)

Video Switcher Out

2 on 25-way "D" connector (X200-16)1 on BNC connector (X200-04)

Audio In 



2 line on 25-way "D" connector (X200-16) 2 line on DIN 5 way audio 



socket (X200-04)

Audio Out 


2 line on 25-way "D" connector (X200-16) 2 line on DIN 5 way audio 



socket (X200-04)

Alarm Inputs


4 on screw terminals

Alarm Output


1 on screw terminals

Power Inputs


2.5mm DC socket for PSU, 1 x pair screw terminals, 12V 

GSM*/GPS*/RS232 Control
9-way "D" connector (RS232 serial)

LAN/WLAN*


RJ45 (rear panel)

Reviewer [X201]


RJ45 (front panel)

Record On/Off


Push button (menu disable)

Indicators LED


Power, Recording, Service, Fail

LED Out



2 x screw terminals to duplicate Recording, Service,Fail and 





Power LED

General
Security



Proprietary files; password protection; fragile watermark every image 



(MD5+DES); embedded camera text 

Power [DC]

12V DC nominal 

External PSU Specification

Output: 12V DC Regulated, 2A (Continuous) 3A (Peak)

Power Recording


0.60A, 12V (7.2W)

Power Not Recording

0.48A, 12V (5.8W) 

Peak Current


2.8A peak start-up current @ 12V (X201 connected)

Power on until Recording

< 5 seconds

Clock



TCXO (+/- 1 min/year); optional GPS locked clock*

Case



Mild steel, grey painted

Dimensions [mm]


210 x 112 x 47 (case)

Dimensions [mm]


220 x 116 x 52 (overall)

Weight



965g (without cartridge)

Environment


Indoor use

Operating Temp. Range

+5C to + 40C, 20% to 80% RHStorage Temp. Range -40C to +65C

Mounting


Free-standing or screw-mounted

Warranty


36 months

Approvals

EMC



89/336/EEC Generic




95/54/EC Commercial Vehicles




Specification 5 UK Home Office 

Electrical Safety


72/23/EEC   

* Additional hardware required - not supplied by Brigade Electronics
REMOVABLE HARD DISK CARTRIDGE

Access                                        
X201 Reviewer/LAN/WLAN* while in X200, PC using Interface Kit (see below)

Hard Disk


2.5" IDE

Power Requirement

5V 1A (PSU supplied with USB Interface Kit)

Dimensions [mm max.]

143 x 84 x 23

Weight



~ 200g depending on type

Warranty


30 months

X201 REVIEWER

Functions


Program menus, check camera views, review live or recorded images

Operation


22 tactile keys with LED indicators

Power



Powered by X200

Power Consumption

0.35A, 12V (4.2W)

Display



4" (102mm) LCD monitor, TFT, 960(H)]x234(V) pixels

Format



PAL/NTSC

Audio



Single channel via built-in speaker

Connectors


X200 interface: 8-way RJ45 (serial data; video; audio; DC supply); 



headphone jack

Case



Aluminium, grey painted

Dimensions [mm]


218 x 148 x 52

Supplied Accessory

Data link cable (X200 to X201)

Warranty


36 months (monitor 12 months)

PCLINK200 REVIEWING/ARCHIVING SOFTWARE

Availability


Supplied in Interface Kits; software available to law 





enforcement agencies

Compatibility


Recordings made by X200

Access                                       
 Cartridge or recordings on CD/DVD, PC hard disk (copied or LAN/WLAN* uploaded files).  Direct LAN/WLAN* access of recordings on HardDisk Cartridge installed in X200.  Automatic LAN/WLAN* file download software (LANLink)  

Operating Systems

Windows 98, ME, 2000, XP, Vista.
Hardware Requirements

2GHz Pentium, 256MByte RAM, USB2

Security



Optional password on PCLink software and on export video to 



AVI function

Playback Controls     
 
Rewind, jog back, stop, play and fast forward, jump to time, 


rapid shuttle via timeline.

Playback Speed                          
Variable x0.1, x0.2, x0.5, x1, x2, x3, x4, x6, x8, x10 realtime for rapid playback.

Functions


Realtime playback with audio 


Review archive files on single/ Multi-screen


Full screen playback view


Copy 10 min or 1 hour files from cartridge to PC


Copy images into Microsoft Word etc.


Activate and verify watermarks


Export video in multiple CD/DVD sized files


Stand-alone (no install reqd.) playback software


Export video to AVI file 

OTHER ACCESSORIES
USB INTERFACE KIT

For access to X200 recordings via USB2 socket of PC; includes software, cables, instructions, PCLink200 software.

VEHICLE MOUNTING KIT

Shock and vibration protection in mobile and portable applications.

Troubleshooting

Text Messages

The following messages may be displayed on the X200 reviewer under the circumstances described:
      MANUAL OVERRIDE ENABLED

 You have chosen to override ALARM

 recording and turn recording off.

 To disable this manual override,

 press the record key again, after

 leaving this screen. 

     PRESS ANY KEY TO CONTINUE     

The above is displayed when the unit is configured for alarm recording and the record button is pressed which will override the configured mode.  Press any key on the reviewer to clear the message.

      MANUAL OVERRIDE ENABLED

 You have chosen to override TIMER

 recording and turn recording off.

 To disable this manual override,

 press the record key again, after

 leaving this screen. 

     PRESS ANY KEY TO CONTINUE     

The above is displayed when the unit is configured for timer recording and the record button is pressed which will override the configured mode.  Press any key on the reviewer to clear the message.

     MANUAL OVERRIDE DISABLED

 Manual override is now OFF.

     PRESS ANY KEY TO CONTINUE     

The above is displayed when manual override has been enabled and then subsequently disabled again.  Press any key on the reviewer to clear the message.

            NO SIGNAL.

       CAMERA DISCONNECTED?

The above message is embedded within the recording file when the X200 video recorder detects that there is no video signal on an input selected for recording.  Check that the camera is working and properly connected to the X200 should this message be seen unexpectedly in recordings.

Fail LED

Illuminated when the X200 video recorder is unable to make recordings.  Check that the hard drive cartridge is properly inserted and locked in.
Service LED

If the Service LED is lit then the system will most likely be functional but may not be performing as intended.  The system should be checked and any remedial action taken as soon as possible.

The problems in question will be listed in the service log which can be viewed in the statistics menu by selecting ‘View Service Log’.  The Service LED will remain lit and the problem which caused the Service LED to light will be listed in the log until the log is reset by selecting ‘Reset Service Log’.

The service log should only be reset once the cause of the problem has been verified and rectified.

FAQ’s

X200

"Does not record on power up"
Enter menu system; go to OTHER MENU, ADVANCED MENU; set to "RECORD AT POWER UP".

"Recording at varying times"
Check that the TIMER RECORDING MENU settings are correct or Timer Recording is disabled. 

"The recorded picture is grainy"
Improve the light level to the camera, or increase the exposure level; use a camera which works to a lower lux level.

"X200 has all front panel LED’s
Ensure cartridge is pushed home and

illuminated and fails to operate"
switched on. 

"Cameras connected but no live views"
Press "Auto" on the X201 Reviewer.


"No picture on X201 monitor"
Ensure that correct power supply to X200 

(12V +/- 1.2V, 2A (continuous) 3A (peak).

"PC can't see disk but recordings
The hard disk boot / partition / FAT sectors 

viewable on X200"
may have become corrupted.  Go to OTHER MENU, FILE SYTEM, FILE SYSTEM CHECK MENU and select PERFORM CHECK AND CORRECT NOW.  This checks and rewrites the boot, partition and FAT sectors of the hard disk and removes any corrupted recording files.  
Please also check the shock and vibration damping of the X200 as shock and vibration reduce disk life and can also lead to corruptions on the hard disk.

USB Interface Kit

“PC fails to start if USB Interface Kit and
On some PC’s Windows may not start
cartridge is attached but switched off

correctly if an X200 cartridge is left attached
during start up”
to the PC via the USB Interface Kit during start up.  This may be the case even if the cartridge is switched off.

“Hard Disk Cartridge appears to be full
If the hard disk cartridge has V1.51 of the
When trying to save X200 software from
X100 operating system installed on it then
a PC Running Windows 98”
 

although it may have enough free space 





available to save the X200 .xos file Windows 





98 shows the disk as full.

· Connect the cartridge to the PC via the USB Interface Kit.
· Go to My Computer and right click on the Cartridges drive letter.
· Select ‘Properties’.
· Select ‘Tools’.
· Select error-checking status ‘check now’.
· Select type of test as ‘Standard’.
· Select ‘Start’.
The scan disk process will detect the following errors: - ‘System_b’ and ‘System’ with the option to ‘repair the error’

· Select ‘OK’

The scandisk will then detect that the information on the disk can be damaged with the option to repair the error.

· Select ‘OK’

Scandisk will then show the results from scanning the cartridge.

· Select ‘Close’







The cartridge will now allow the user to 






transfer X200 software onto the cartridge.

USB Interface Kit compatibility
Early versions of Windows XP may have 

with Windows XP 
some compatibility problems when used with USB2 interfaces such as the USB Interface Kit supplied to connect an X200 Hard Disk Cartridge to a PC.  This situation has been resolved with the issue of service pack 1 for Windows XP.
If you are having trouble installing and using the USB Interface Kit with Windows XP then check to see if service pack 1 has been installed (My Computer > View System Information > General Tab).  If it is not listed under the System heading, then it may not have been installed and can be downloaded from Microsoft.
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Show all cameras





Height 36mm (48mm inc. connector)





Depth 50mm





Length 72mm
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Menu Bar and Shortcut Buttons
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Zoom to selected camera





Print Frame(s)





Export AVI





Export Frame





Copy Frame





File Properties





Load XBA folder





Load XBA file
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File Menu





Load single or multiple XBA files


Load remote files using IP network.


Close currently open XBA files


Print the currently selected camera screen


Copy current camera screen to clipboard as a Windows bitmap


Export current camera screen as a Windows bitmap or JPEG


Export video between start and end markers as either XBA or AVI


Export Audio between start and end markers as WAV file.


Export all Camera views to folder


Reports - Check watermark is valid for all currently loaded files OR Cartridge / Folder.


Bring up a list of recently viewed XBA files


View the properties of the current XBA file


Exit PCLink200





Selecting cameras to view





Use the View, Cameras sub-menu to select which cameras are to be viewed


Select the camera number from the drop down list


Ticked cameras are displayed


Camera numbers in grey indicate that no footage is available for that camera


Map – Select on/off the map window (only available on footage with GPS data).








Opens SafetlyLink application (driver education program)








PC system resources indicator.





Timeline Information





Shows areas of available footage in green.  This can be scaled to show footage over appropriate periods of time. 





Area’s highlighted in red indicate Alarm events.





Motion and G-Force graphs drawn under the timeline when selecting right hand tabs.





Playback Controls





Playback speed and Volume. Note Volume does not appear unless enabled in the Audio Menu (default is off, as shown).





The date and time of the currently displayed footage.





Play, Stop, Jog Forward/Back, FastForward, Rewind.





Menu bar





Camera number.





GPS position 


and speed data.








Yellow footage position markers can be used to mark the start and end of selected footage (useful for exporting clips)





The playback position marker can be moved to a specific date and.








Map information, linked with GPS data.





Time and date 


information.





GPS position data.





Static map link will open a web browser for location (useful when not using integrated Mapping).








Information Side Panel





Switch between GPS (as shown) FX & G-Force views. 





FX View includes; Gamma, Brightness, Contrast, Greyscale and Negative adjustments.





G-Force includes; Lateral, Forward and Upwards measurements in terms of G.























GPS speed  and motion data, displayed graphically.
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Please note that when using the T407


Cartridge Lock an extra 20mm of


Clearance must be allowed at the front of the X200 making a total of 266mm (35mm front and 15mm back).
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The removable Hard Disk Cartridge


is connected to a PC (via USB Kit) to


analyse, copy or archive video/audio


recordings and to download new


operating software.





�





PC REVIEWING / ARCHIVING





REMOTE OPERATION





A Wireless Local Area Network


(WLAN) system can be used to


download recordings from the 


X200 in a vehicle to a PC.





A GSM modem can be used in conjunction with the X200 and RemoteLink software to configure the X200 remotely.





The X201 Reviewer is used for on-site


reviewing of video/audio recordings and


to configure the optional menu settings 


of the X200 Digital Video Recorder.





This can also be done via serial connection to a PC.
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REVIEWING / CONFIGURING





The X200 Digital Video Recorder is used


With a removable Hard Disk Cartridge to


Record from multiple video and audio sources.
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RECORDING





Include menu
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X201 REVIEWER & PROGRAMMER
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